Table of Contents

Chapter 1: Getting Started with Mutation Surveyor ................................. 19
Mutation Surveyor System Requirements .......................................................... 21
Installing Mutation Surveyor............................................................................... 22
   To install Mutation Surveyor ......................................................................... 22
Starting Mutation Surveyor ............................................................................... 23
Mutation Surveyor Conventions......................................................................... 24
   Genomic terms ............................................................................................... 24
   Mutation terms .............................................................................................. 24
   Reports and graphical output ......................................................................... 25
The Mutation Surveyor Main Window ............................................................... 26
   Title bar ......................................................................................................... 26
   Main menu ..................................................................................................... 26
   Main window toolbar ..................................................................................... 27
   Browser pane ................................................................................................. 27
      To navigate the Browser pane .................................................................. 28
   Viewing and Reporting pane ....................................................................... 30
Configuring User Management........................................................................... 31
   To configure user management .................................................................... 31
      To turn on user management .................................................................. 34
      To turn off user management ................................................................. 36
Managing Groups in Mutation Surveyor............................................................ 38
   To manage groups in Mutation Surveyor.................................................... 38
      To add a new group .................................................................................. 40
      To edit a group ......................................................................................... 40
      To delete a group ..................................................................................... 41
Managing Users in Mutation Surveyor............................................................... 43
   To manage users in Mutation Surveyor ...................................................... 43
To add a user ............................................................................................................. 45
To edit a user ............................................................................................................. 46
To delete a user ......................................................................................................... 47

**Chapter 2: Project Setup** .................................................................................. 49

Project File Types ........................................................................................................ 50
Sample file.................................................................................................................... 50
Reference file .............................................................................................................. 50
GenBank file ................................................................................................................ 50
Automatic GenBank download ................................................................................. 51

Modifying the Default Mutation Surveyor Project Settings ........................................ 52
To modify the default Mutation Surveyor project settings ....................................... 53
Input tab ...................................................................................................................... 54
Contig tab .................................................................................................................. 55
Mutation tab ............................................................................................................... 59
Output tab .................................................................................................................. 62
Display tab ................................................................................................................. 64
2 Directions tab ....................................................................................................... 65
Others tab .................................................................................................................. 67
Database tab ............................................................................................................. 69

Setting up a Single Mutation Surveyor Project ....................................................... 70
To set up a Mutation Surveyor project ................................................................. 70
Contig directory for a Mutation Surveyor project ................................................. 72

**Chapter 3: Graphical Analysis Display** ............................................................... 75

Graphical Analysis Display Layout ........................................................................ 77
Nucleotide Sequence frame .................................................................................... 78
Amino Acid frame .................................................................................................. 79
Tracks frame .......................................................................................................... 79
Clinical Report.......................................................................................................................... 116
Nucleotide Text Display Report................................................................................................ 120
Nucleotide Text Display report layout ................................................................................. 121
Nucleotide Text Display report toolbar ................................................................................ 122

Chapter 5: Mutation Surveyor Standard Reports ......................................................... 125
Mutation Report.................................................................................................................... 127
Mutation Surveyor toolbar ................................................................................................. 127
Mutation report fields........................................................................................................... 128
Mutation report codes ........................................................................................................ 129
  Substitution mutation code............................................................................................... 129
  Color codes ..................................................................................................................... 130
  Insertion, duplication, and deletion mutation codes ...................................................... 131
Mutation report viewing and analysis options ................................................................. 132
Two Direction Report........................................................................................................ 134
Two Direction report layout ............................................................................................... 134
Two Direction report toolbar ............................................................................................. 135
Two Direction report mutation codes ............................................................................... 136
Two Direction report viewing and analysis options ......................................................... 136
  Two Direction report settings ......................................................................................... 136
  Two Direction report context menu ................................................................................. 137
Advanced Two Direction Report....................................................................................... 140
Advanced Two Direction report toolbar .......................................................................... 142
Advanced Two Direction report viewing and analysis options ...................................... 144
Project Report .................................................................................................................. 146
Project report toolbar........................................................................................................... 148
  Project Sample Assembly subreport ........................................................................... 150
Consensus Sequence Text function .................................................................................. 151
  Consensus Sequence Text window toolbar ................................................................. 151
Chapter 8: GenBank File Editors

Overview of GenBank Files
To download a GenBank file
Advanced GBK File Editor Tool
To load a GenBank file into the Advanced GBK File Editor tool
Advanced GBK File Editor tool toolbar
Advanced GBK File Editor tool GenBank Tree File pane
Advanced GBK File Editor tool Tabs pane
Sequence tab
Basic Information tab
Allele Frequency tab
Modifying and adding variations
Advanced GBK File Editor tool functions
To search the loaded GenBank file for a specific sequence
To download a GenBank file with the same sequence
To adjust the number of the first coding base or the sequence start
To add ROIs that are based on CDSs
To reverse complement the currently loaded GenBank file
SEQ File Editor Tool
To load a SEQ file into the SEQ File Editor tool ......................................................... 246
SEQ File Editor tool layout ......................................................................................... 247
SEQ File Editor tool functions .................................................................................... 250
  To search the loaded SEQ file for a specific sequence ........................................... 250
  To adjust the number of the first coding base or the sequence start ....................... 251

Chapter 9: Mutation Surveyor Tools ......................................................................... 253
Filename Editor Tool .................................................................................................... 257
  To programmatically change filenames ..................................................................... 257
  To manually change filenames .................................................................................. 259
2D Filename Match Editor tool ..................................................................................... 261
  To use the 2D Filename Match Editor tool ................................................................. 261
ND Filename Match Editor Tool ................................................................................... 264
  To use the ND Filename Match Editor ....................................................................... 264
Print Header Editor Tool ............................................................................................... 267
  To use the Print Header Editor tool ............................................................................ 267
Create SCF Tool .......................................................................................................... 271
  Synthetic traces versus pseudo traces ...................................................................... 271
  To use the Create SCF tool ....................................................................................... 272
Convert to SCF tool ...................................................................................................... 274
  To use the Convert to SCF tool .................................................................................. 274
Extract SGP Tool .......................................................................................................... 275
  To use the Extract SGP tool ....................................................................................... 275
SGP Comparison Tool ................................................................................................. 279
  To use the SGP Comparison tool ............................................................................... 279
Mutation Assembly Tool ............................................................................................... 284
  To use the Mutation Assembly tool ............................................................................ 284
Sequence Assembly Tool ............................................................................................. 287
To use the Sequence Assembly tool ................................................................. 287
Mask Vector Sequence Tool ............................................................................ 291
To use the Mask Vector Sequence tool .............................................................. 291
Output Trace Data Tool ..................................................................................... 293
To use the Output Trace Data tool ..................................................................... 293
Signal Factor Intensity and Signal Factor Dev .................................................. 294
BasePatch Tool .................................................................................................. 295
To use the BatchPatch tool .............................................................................. 295
The HLA Tool ..................................................................................................... 297
To use the HLA tool ............................................................................................ 297

Chapter 10: Mutation Surveyor Specialized Applications .......................... 299
Methylation Detection ....................................................................................... 301
Mutation Quantifier Function ............................................................................ 303
To run the Mutation Quantifier function ......................................................... 303
Mutation Quantifier report, Standardized Allele Ratio selected ................. 305
Mutation Quantifier report, Simplified Allele Ratio selected ...................... 307
Mutation Quantifier toolbar ............................................................................ 308
Quantification Group Editor dialog box ......................................................... 309
Mutation Quantifier report settings dialog box ......................................... 310

Chapter 11: Multiple Projects .............................................................. 313
Modifying Mutation Surveyor Projects ......................................................... 315
The Log File Wizard in the Mutation AutoRun Tool .................................... 317
To open the Log File Wizard .......................................................................... 317
To set up a new log file .................................................................................. 318
To modify a log file ......................................................................................... 322
To modify an existing job in the log file ......................................................... 322
To add a new job to a log file .......................................................................... 323
To remove a job from a log file .......................................................................................... 323
The Mutation AutoRun Tool ............................................................................................ 324
To use the Mutation AutoRun tool .................................................................................. 324

Chapter 12: Reviewing and Editing Mutation Projects ............................... 327
Adding Mutation Calls ...................................................................................................... 329
To add a substitution ........................................................................................................ 329
To add a homozygous indel call ..................................................................................... 330
To add or edit a heterozygous indel (The Het-Indel tool) ............................................ 331
Heterozygous Indel Detection window toolbar .............................................................. 334
Editing Mutation Calls ..................................................................................................... 335
To edit substitutions ......................................................................................................... 335
To edit homozygous indels ............................................................................................. 336
To edit heterozygous indels ............................................................................................ 337
To edit Del/Ins .................................................................................................................. 339
To edit a homozygous Del/Ins ...................................................................................... 339
To edit a heterozygous Del/Ins ..................................................................................... 339
Annotating Reported Variations .................................................................................... 341
To annotate a variation ..................................................................................................... 341
Creating a User Knowledge Database for Known Deletions ..................................... 342
To create a custom variant database for known deletions ........................................... 342
Viewing the Edit History (Audit Trail) for a Mutation .................................................. 344

Index .............................................................................................................................. 345
Preface

Welcome to the *Mutation Surveyor User’s Manual*. The purpose of the *Mutation Surveyor User’s Manual* is to answer your questions and guide you through the procedures necessary to use the Mutation Surveyor application efficiently and effectively.

Using the manual

You will find the *Mutation Surveyor User’s Manual* easy to use. You can simply look up the topic that you need in the table of contents or the index. Later, in this Preface, you will find a brief discussion of each chapter to further assist you in locating the information that you need.

Special information about the manual

The *Mutation Surveyor User’s Manual* has a dual purpose design. It can be distributed electronically and then printed on an as-needed basis, or it can be viewed online in its fully interactive capacity. If you print the document, for best results, it is recommended that you print it on a duplex printer; however, single-sided printing will also work. If you view the document online, a standard set of bookmarks appears in a frame on the left side of the document window for navigation through the document. For better viewing, decrease the size of the bookmark frame and use the magnification box to increase the magnification of the document to your viewing preference.

*If you do print the document using a single-sided printer, you might see a single blank page at the end of some chapters. This blank page has been added solely to ensure that the next chapter begins on an odd-numbered page. This blank page in no way indicates that your book is missing information.*

Conventions used in the manual

The *Mutation Surveyor User’s Manual* uses the following conventions:

- Information that can vary in a command—variable information—is indicated by alphanumeric characters enclosed in angle brackets; for example, `<Mutation ID>`. Do not type the angle brackets when you specify the variable information.
- A new term, or term that must be emphasized for clarity of procedures, is *italicized*.
- Mutation Surveyor provides multiple ways of accessing the same Mutation Surveyor functions (for example, a main menu option and a toolbar button). For brevity and ease of
use, this manual references only one method—the main menu—for accessing functions; however, you can use whatever method best suits your working needs.

• Page numbering is “online friendly.” Pages are numbered from 1 to x, starting with the cover and ending on the last page of the index.

Although numbering begins on the cover page, this number is not visible on the cover page or front matter pages. Page numbers are visible starting with the first page of the table of contents.

• This manual is intended for both print and online viewing.
  • If information appears in blue, it is a hyperlink. Table of Contents and Index entries are also hyperlinks. Click the hyperlink to advance to the referenced information.

Assumptions for the manual

The Mutation Surveyor User’s Manual assumes that:

• You are familiar with windows-based applications and basic Windows functions, navigational elements, and icons such as the Printer Setup icon on a Print Preview page.

• References to any third party standards or third party software functions were current during the development and release of this version of Mutation Surveyor.

Organization of the manual

In addition to this Preface, the Mutation Surveyor User’s Manual contains the following chapters and appendices:

• Chapter 1, “Getting Started with Mutation Surveyor,” on page 19 details the Mutation Surveyor installation requirements, and the procedures for installing and upgrading the application. It also describes how to launch Mutation Surveyor and it provides an overview of the major navigational elements in the application.

• Chapter 2, “Project Setup,” on page 49 guides you through the necessary steps for setting up a project in Mutation Surveyor.

• Chapter 3, “Graphical Analysis Display,” on page 75 details the layout and functions of the Graphical Analysis Display, which visually presents mutation project data.

• Chapter 4, “Mutation Surveyor Graphical Reports,” on page 97 details the variety of graphic-based standard reports that are available in Mutation Surveyor for providing detailed information about a mutation project. The chapter contains a summary of descriptions, report field labels, report functions, and report caveats for all the various standard mutation reports.
• Chapter 5, “Mutation Surveyor Standard Reports,” on page 125 details the variety of text-based standard reports that are available in Mutation Surveyor for providing detailed information about a mutation project. The chapter contains a summary of descriptions, report field labels, report functions, and report caveats for all the various standard mutation reports.

• Chapter 6, “Mutation Surveyor Custom Report,” on page 163 details the Custom report, which contain options for building a tailored report that provides detailed information about your mutation projects in a format that best suits your specific working needs.

• Chapter 7, “Mutation Surveyor Customer Reports,” on page 183 details the various customer report templates in Mutation Surveyor. Each report was initially developed as a template to provide custom content that met a specific customer’s needs. All these report templates are now available from the Reports > Customer Reports option on the Mutation Surveyor main menu.

• Chapter 8, “GenBank File Editors,” on page 225 details the tools that are specifically designed for editing GenBank files and Sequence files.

• Chapter 9, “Mutation Surveyor Tools,” on page 253 details the variety of tools that are available in Mutation Surveyor for optimizing input data and analyzing results.

• Chapter 10, “Mutation Surveyor Specialized Applications,” on page 299 details the use of Mutation Surveyor for some specialized applications.

• Chapter 11, “Multiple Projects,” on page 313 details Mutation Surveyor’s capabilities for modifying existing projects and for working with multiple projects.

• Chapter 12, “Reviewing and Editing Mutation Projects,” on page 327 details the functions and the tools that are available in Mutation Surveyor for adding and editing mutation calls in a project.

Related document

In addition to this manual, you may find the following document helpful

• Mutation Surveyor Reference and Track Manager Tool User’s Manual
Preface
Chapter 1
Getting Started with Mutation Surveyor

The Mutation Surveyor software application uses patented anti-correlation technology to provide highly accurate discovery of DNA variants from Sanger sequencing traces. This software is ideal for the analysis of data from Applied Biosystems, Beckman-Coulter and MegaBACE systems. This chapter details the installation requirements, and the procedures for installing and upgrading the application. It also describes how to launch Mutation Surveyor and it provides an overview of the major navigational elements in the application. It also details how to configure user management for your Mutation Surveyor instance.

This chapter covers the following topics:

• “Mutation Surveyor System Requirements” on page 21.
• “Installing Mutation Surveyor” on page 22.
• “Starting Mutation Surveyor” on page 23.
• “Mutation Surveyor Conventions” on page 24.
• “The Mutation Surveyor Main Window” on page 26.
• “Configuring User Management” on page 31.
• “Managing Groups in Mutation Surveyor” on page 38.
• “Managing Users in Mutation Surveyor” on page 43.
Mutation Surveyor System Requirements

Mutation Surveyor is supported only on Windows and Intel-powered Macintosh operating systems. It is not supported on Linux or UNIX-based operating systems. Mutation Surveyor recognizes only PC file formats.

<table>
<thead>
<tr>
<th>System</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Windows PC                  | • Operating System—Mutation Surveyor can function on Windows 32- or 64-bit operating systems that are within Microsoft Extended Support.  
                                • Processor—Dual core with 1.8 GHz                                          
                                • RAM: 2 GB                                                                    
                                • Available hard drive space: 60 GB                                           
                                **Note:** Some optional features require a 64-bit operating system along with additional RAM and hard drive space. |
| Intel Powered Macintosh     | • Operating System—Parallels desktop for Mac (Mac OS/virtual machine dependent) or Apple, Boot Camp or VMware Fusion (Mac OS/virtual machine dependent)  
                                • RAM: 2 GB                                                                  
                                • Available hard drive space: 60 GB                                          |
Installing Mutation Surveyor

Mutation Surveyor is licensed in three different ways, each of which follow slightly different installation procedures—Validation, Local, and Network:

- Validation license—The Validation license is a trial license that provides all the functionality of a purchased license. You can load data, create and save new files, analyze and visualize data, and so on. The Validation license does not require a registered license and you can install this version on an unlimited number of computers. The Validation license expires 35 calendar days from installation.

- Local license—The Local license is for installation on a single computer.

- Network license—The Network license is for installation on multiple client computers that are connected to a license server computer.

To install Mutation Surveyor

The Mutation Surveyor Installation wizard guides you through the steps that are necessary to install a Mutation Surveyor license. The default installation location is

C:\Program Files (x86)\SoftGenetics\Mutation Surveyor

but you can always select a different installation directory.

When you are installing Mutation Surveyor, keep in mind the following:

<table>
<thead>
<tr>
<th>Version</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validation</td>
<td>Accept the default Program Manager Group to ensure that program operability is not negatively affected.</td>
</tr>
<tr>
<td>Local</td>
<td>• A dongle may be supplied with a Local license. Make sure that you follow the specific installation instructions that are included with the key.</td>
</tr>
<tr>
<td></td>
<td>• Accept the default Program Manager Group to ensure that program operability is not negatively affected.</td>
</tr>
<tr>
<td></td>
<td>• At the prompts to enter your registration information, enter the information exactly as SoftGenetics supplied it to you.</td>
</tr>
<tr>
<td>Network</td>
<td>• At the prompts to enter your registration information on the server computer, enter the information exactly as SoftGenetics supplied it to you.</td>
</tr>
</tbody>
</table>
Starting Mutation Surveyor

After Mutation Surveyor has been installed on your computer, a shortcut icon for the application is placed on your desktop. An option for the application is also available from your Start menu. You can double-click the desktop icon to open Mutation Surveyor, or you can select the option from your Start menu.

If your Mutation Surveyor administrator has configured User Management for your Mutation Surveyor instance, then you are prompted to enter a user name and password before Mutation Surveyor opens. Contact your administrator if you need assistance.

Figure 1-1: Mutation Surveyor desktop icon

Figure 1-2: Mutation Surveyor main window
Mutation Surveyor Conventions

Mutation Surveyor uses conventions in both its terminology (genomic terms and mutation terms) and its output to ensure consistency and accuracy when you are manipulating and analyzing mutation project data.

Genomic terms

In genomics, the same term or definition can have multiple meanings or interpretations. As a result, you must know how specific genomic terms are defined for use in Mutation Surveyor. Figure 1-3 shows a sequence region which contains a gene model. Mutation Surveyor uses the following terms to define the different areas of a gene:

- (A)—The sequence, which is the complete order of nucleotides in a gene.
- (B)—mRNA, which is a region in a gene that contains part of the reading frame that codes for a specific portion of the complete protein. mRNA regions can include sequences that code for amino acids (red fill in Figure 1-3) and untranslated sequences (no fill in Figure 1-3).
- (C)—CDS, or the coding sequence, which is a DNA region in a gene that is translated into protein.
- (D)—Intron, which are the regions of the precursor mRNA that are spliced out to make the mature mRNA. These introns might be within the untranslated region of the mRNA or they might be between CDS regions of mRNA.

Figure 1-3: Mutation Surveyor genomic terms

Mutation terms

The following list details how specific types of mutations are defined in Mutation Surveyor:

- Silent—Coding and non-coding mutations that do not affect the amino acid sequence.
- Synonymous—Mutations found only in the coding region that do not affect the amino acid sequence.
• Non-synonymous—Mutations found only in the coding region that affect the amino acid sequence.

• Nonsense—A non-synonymous mutation that results in a stop codon.

• Mosaic—Might be used in place of somatic mutations (2D small peak) or heteroplasmy.

Reports and graphical output

• When analyzing samples from a polyploid organism, Mutation Surveyor displays the results for only the two dominant alleles (the alleles with the two highest frequencies) in any report or graphical display.

• Mutation Surveyor supports both standard and non-standard genetic codes as defined in Version 4.4 of the NCBI Genetic Code table (see ftp://ftp.ncbi.nih.gov/entrez/misc/data/gc.prt). To analyze samples that require translation using a non-standard genetic code, the GenBank file must contain the correct Translation table number. If the GenBank file does not contain this information, Mutation Surveyor defaults to using standard genetic code.
The Mutation Surveyor Main Window

The Mutation Surveyor main window is your starting point for the Mutation Surveyor application. The window provides quick access to all the Mutation Surveyor functions and system tools. The Mutation Surveyor main window has five major components—the title bar, the main menu, the toolbar, the Browser pane, and the Viewing and Reporting pane.

Figure 1-4:  Mutation Surveyor main window

Title bar

The name “Mutation Surveyor” appears in the title bar at the top of the Mutation Surveyor main window. When a saved project is opened, the title bar also shows the version number in which the project was saved.

Figure 1-5:  Title bar

Main menu

The main menu is set up in a standard Windows menu format with menu commands grouped into menus (File, Process, Display, Reports, Tools, and Help) across the menu bar. Some of these menu commands are available in other areas of the application.

Figure 1-6:  Main menu
Main window toolbar

The toolbar provides quick access to all the Mutation Surveyor functions. Figure 1-7 below shows the Mutation Surveyor toolbar after the application first opens. The Mutation Surveyor toolbar is updated dynamically with other toolbar buttons based on the files that you load and/or the post-processing steps that you select. Place your mouse pointer over a toolbar button to open tooltip text for the button.

Figure 1-7: Mutation Surveyor Toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="File" /></td>
<td>Open Files—Opens the Open Files dialog box which you use to load GenBank files, references files, and sample files for a project.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save Project—Saves all the project files to a single file mutation project file with an .sgp extension. You can open an entire project in a single step by opening this .sgp file.</td>
</tr>
<tr>
<td><img src="image" alt="Raw Data to Processed Data" /></td>
<td>Raw Data to Processed Data—Enabled when AB1/ABI files without base call information are uploaded and Load Raw Data is selected for the Mutation Project settings. Converts the raw files so that base call information is displayed.</td>
</tr>
<tr>
<td><img src="image" alt="Run" /></td>
<td>Run—Runs the currently loaded project in Mutation Surveyor.</td>
</tr>
<tr>
<td><img src="image" alt="Restart" /></td>
<td>Restart—Opens the Options dialog box which you use to modify the current project settings. You can then run the project again using these new settings.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Browser" /></td>
<td>Show/Hide Browser—Shows/hides the Browser pane in the Mutation Surveyor main window.</td>
</tr>
</tbody>
</table>

Browser pane

The Browser (left) pane is arranged in a classic Windows Explorer-style folder structure. The top-level folders are the File folder and the Contig folder. The File folder contains up to three sub-level folders—GenBank File, Reference File, and Sample File—which contain the GenBank files, the reference files, and the sample files, respectively. The Contig folder contains subfolders for each of the contigs that were created from the analysis. After you run a project for the first time, an entry also exists for the Mutation Report. (See Figure 1-8 on page 28.)
Chapter 1
Getting Started with Mutation Surveyor

Figure 1-8: Browser pane

For a detailed discussion about contigs and the Browser pane, see “Contig directory for a Mutation Surveyor project” on page 72.

To navigate the Browser pane

• To open a folder, click the Expand icon next to the folder, or double-click the folder.
  To close a folder, click the Collapse icon next to the folder.

• To view the raw trace for a file, double-click anywhere on the file entry. (The icon for the selected file turns green.) The trace opens in the Viewing and Reporting (right) pane.
  To clear the trace for a file, double-click anywhere on the file entry again.

To view corresponding traces at the same time, double-click individual samples.

Figure 1-9: Viewing a trace for a single file
To view the Mutation report, double-click the Mutation Report entry. The Mutation report opens in the Viewing and Reporting pane. (See “Mutation Report” on page 127.)
Viewing and Reporting pane

The Viewing and Reporting (right) pane displays graphics, reports, and other information depending on the post-processing options that you have selected.

*Figure 1-12: Viewing a trace in the Viewing and Reporting pane*

Reports and views are discussed in the appropriate chapters in this manual.
Configuring User Management

After Mutation Surveyor is installed, user management can be configured for it. User management requires that a user be authenticated before logging in and using the applications. You can configure user management independently for each computer (localhost) on which Mutation Surveyor is installed. In this configuration, the SoftGenetics Server service must be installed on each computer on which Mutation Surveyor is installed. Because the same user management configuration is part of the installation process for Geneticist Assistant and NextGENe, the steps that you must follow to install the SoftGenetics Server service depend on whether Geneticist Assistant and/or NextGENe has already been installed on the localhost. Alternatively, a single server can host the SoftGenetics Server service and you can configure each Mutation Surveyor host to connect to this single server to verify user credentials. When you configure user management, you must always configure the Administrator user account first. Only the Administrator user has all the necessary privileges for managing other users. All other users are standard users. After you configure user management, you must turn on user management. You can also always turn off user management at any time without deleting any of the user configuration information.

If you changed the directory for storing the MySQL information that Mutation Surveyor uses from the default directory (C:\ProgramData\MySQL\MySQL Server 5.1\Data), then before configuring user management, you must contact tech_support@softgenetics.com.

To configure user management

The following procedures details the configuration of user management independently for each computer (localhost) on which Mutation Surveyor is installed. To configure user management with a single server hosting the SoftGenetics Server service, contact tech_support@softgenetics.com.

1. If Geneticist Assistant or NextGENe is already installed on the computer on which you are configuring user management for Mutation Surveyor, go to “To turn on user management” on page 34; otherwise, do the following:
   • Log on to the host computer as a Windows user that is a local Administrator.
   • To avoid issues with User Account Control settings, right-click on the Mutation Surveyor desktop shortcut and on the context menu that opens, select Run as administrator.
2. On the Mutation Surveyor main menu, click Help > User Management > Install Local Service.

   The License page for the SoftGenetics Server Setup wizard opens. The page details the license agreement for installing the SoftGenetics Server service.
3. Click I Agree to accept the license agreement.

   The Settings page for the SoftGenetics Server Setup wizard opens. By default, the page is prepped for configuring the Administrator user.

   **Figure 1-14: SoftGenetics Server Setup wizard, Settings page**

4. Do the following:
   - Leave the user name set to Administrator, or modify it as needed.
   - In the Password field, enter the password for the Administrator user.
In the Verify field, enter the Administrator password exactly as you entered it in the Password field.

- In the Email field, enter the email address for the Administrator user.

Note the following about the installation:

- If MySQL has not already been installed on the localhost, then after installation of MySQL is complete, click Close at the prompt; otherwise, the installation begins with the installation of the other server components (Python, Django, and Apache).

- During the installation of the other server components, you might receive Security Alerts. The installation is set up to handle these alerts and with the exception of a Windows Security Alert for Apache (see below), no special action is required.

- After Apache is installed, a Windows Security Alert opens indicating that the Windows Firewall has blocked some features of the installation. Click Allow access to allow the Apache HTTP Server to operate correctly on the localhost.

The only invalid character for the password is a space. There are no other special requirements or restrictions for the Administrator password. It can adhere to your organization’s standards and any other requirements as needed. If you forget or lose this password, it is not recoverable.

The current version of User Management does not support email notifications; however, an email address is still required.

5. Click Install.

After you select the server, the space requirements for installing the SoftGenetics Server service are displayed on the page. Make sure that you have sufficient space on the computer to install this service.
After installation is complete, Completed is displayed at the top of the Installation page.

6. Click Close.


7. Continue to “To turn on user management” below.

To turn on user management


The User Management Settings dialog box opens. The General tab is the open tab.
2. Leave Service host set to localhost.
3. Select Turn on user management.
   Remember last user becomes available.
4. Leave Remember last user, or optionally, clear it.

   If Remember last user is selected, then when a user logs into Mutation Surveyor, the Username field on the Login dialog box is automatically populated with the user name for the user who last logged into Mutation Surveyor.

5. Select Use GA configuration to integrate user accounts between multiple SoftGenetics products.
6. Click OK.

   The Administrator Verification dialog box opens. The dialog box indicates that Administrator verification is required to apply the changes.

Figure 1-18: User Management Settings dialog box, General tab

Figure 1-19: Administrator Verification dialog box
Chapter 1
Getting Started with Mutation Surveyor

7. In the Username field, leave the Administrator username as-is, or optionally, modify the name as needed.
8. In the Password field, enter the password for the Administrator user.
9. Click OK.
   A message opens, indicating that to apply the changes that Mutation Surveyor must be closed and reopened and asking you if you want to close Mutation Surveyor now.
10. Click Yes.
    The message closes.
11. Start Mutation Surveyor.
    The Login dialog box opens.

   ![Mutation Surveyor Login dialog box](image)

12. Enter the Administrator username and password, and then click OK.
    The Login dialog box closes and Mutation Surveyor opens. Now, every time a user opens Mutation Surveyor, they are prompted to enter a username and password before they can use the application.

   **If you are the Administrator user, you should now continue to setting up the needed groups and users for your Mutation Surveyor instance. See “Managing Groups in Mutation Surveyor” on page 38 and “Managing Users in Mutation Surveyor” on page 43.**

To turn off user management

After configuring and turning on user management for your Mutation Surveyor instance, as the Administrator user, you always have the option of turning off user management. This does not delete any user configuration information. It simply means that users are not required to be authenticated before they log in to and use Mutation Surveyor. You can always turn user management back on.

1. Start Mutation Surveyor.
   The Login dialog box opens.
2. Enter the Administrator username and password, and then click OK. Mutation Surveyor opens.


   The User Management dialog box opens. The General tab is the open tab. Turn on user management is selected.

4. Clear Turn on user management.

5. Click OK.

   A message opens, indicating that to apply the changes that Mutation Surveyor must be closed and reopened and asking you if you want to close Mutation Surveyor now.

6. Click Yes.

   The message and Mutation Surveyor close. Now, any user can start Mutation Surveyor without any authentication. The user configuration information, however, is not deleted, so you can always turn user management back on if needed.
Managing Groups in Mutation Surveyor

Users are the people who log into Mutation Surveyor, whether they are adding and reviewing content, or just using the application in a read-only capacity. A group is a collection of users that have the same permissions in Mutation Surveyor. As the Administrator user for Mutation Surveyor, you are responsible for managing all the groups for your Mutation Surveyor instance and managing the users for these groups to ensure that your users have the appropriate permissions available to them in Mutation Surveyor. You can assign users to one of the four default groups that are installed with every instance of Mutation Surveyor, or you can create your own groups with the needed permissions, and then assign users to one of these groups.

<table>
<thead>
<tr>
<th>Assigned Permissions</th>
<th>Mutation Surveyor Default User Group</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Reporter</td>
</tr>
<tr>
<td>View Project</td>
<td>Y</td>
</tr>
<tr>
<td>Export Results</td>
<td>Y</td>
</tr>
<tr>
<td>Create and Run Project</td>
<td>N</td>
</tr>
<tr>
<td>Re-run Project</td>
<td>N</td>
</tr>
<tr>
<td>Edit Variants</td>
<td>N</td>
</tr>
<tr>
<td>Manage Analysis Settings</td>
<td>N</td>
</tr>
<tr>
<td>Manage Report Settings</td>
<td>N</td>
</tr>
<tr>
<td>Manage Knowledge Base</td>
<td>N</td>
</tr>
</tbody>
</table>

Managing groups for Mutation Surveyor consists of adding new groups, editing existing groups, and deleting groups.

To manage groups in Mutation Surveyor

   The User Management Settings dialog box opens. The General tab is the open tab. See Figure 1-22 on page 37.
2. Click the Groups tab to open it.
   The tab lists the four default groups that are installed with every instance of Mutation Surveyor as well as any groups that have been configured for your Mutation Surveyor instance. If applicable, it also lists any groups that have been configured for your Geneticist Assistant and/or NextGENe instances. See Figure 1-23 on page 39.
3. Optionally, to view a list of all users that are currently assigned to a group, select the group.

The users that are assigned to the selected group are displayed alphabetically by username in the User list pane.

4. Continue to one of the following:
   • “To add a new group” on page 40.
   • “To edit a group” on page 40.
   • “To delete a group” on page 41.
To add a new group

1. Click Add Group.

   The Add Group dialog box opens.

   Figure 1-24: Add Group dialog box

2. In the Group name field, enter the name for the new group.
3. On the Permissions list, select the permissions for the new group.
4. Click OK.

   A message opens, indicating that the new group was successfully created.
5. Click OK.

   The message closes. The Groups tab remains open with the newly added group displayed on the tab.
6. Click OK.

   The User Management Settings dialog box closes.

To edit a group

Editing a group from the Groups tab consists of modifying the permissions for the group. If you want to edit a group by adding or deleting users, then you must do so from the Users tab. (See “Managing Users in Mutation Surveyor” on page 43.) Also, you cannot edit a group name. If you need to rename a group, then you must delete the current group, and create a new group with the new name, and then reassign all the users who were associated with the deleted group to this new group.

Although you can edit the permissions that are assigned to the Mutation Surveyor default groups, SoftGenetics strongly recommends that you not do so. Instead, you should create a new group with the appropriate permissions and then assign users to the new group.
1. Select the group for which you are modifying the permissions, and then click Edit Group.

   The Edit Group dialog box opens. The group name is displayed in the Group name field, and you cannot edit it. The permissions that are currently assigned to the group are also displayed.

   **Figure 1-25: Edit Group dialog box**

   ![Edit Group dialog box](image)

2. Modify the permissions for the group as needed.

3. Click OK.

   A message opens, indicating that the group was successfully edited.

4. Click OK.

   The message closes. The Groups tab remain opens.

5. Click OK.

   The User Management Settings dialog box closes.

**To delete a group**

> Although you can delete any of the Mutation Surveyor default groups, SoftGenetics strongly recommends that you not do so. Instead, you should delete only those custom groups that you have added for your Mutation Surveyor installation.

1. Select the group that you are deleting, and then click Delete Group.

   A message opens, indicating that you are deleting the selected group, and prompting you to click OK to confirm the deletion.
2. Click OK.

The message closes, and a second message opens, indicating that you have successfully deleted the selected group.

3. Click OK.

The second message closes. The entry for the group is removed from the Groups tab. The Groups tab remains open.

4. Click OK.

The User Management Settings dialog box closes.
Managing Users in Mutation Surveyor

Users are the people who log into Mutation Surveyor, whether they are adding and reviewing content, or just using the application in a read-only capacity. If you are the Administrator user for Mutation Surveyor, then you are responsible for managing all the other users. Managing users for Mutation Surveyor consists of adding new users, editing existing users, and deleting users. You can also view the activity for your Mutation Surveyor users (logging in to or logging out of Mutation Surveyor) in a log file.

To manage users in Mutation Surveyor

   
   The User Management Settings dialog box opens. The General tab is the open tab. See Figure 1-22 on page 37.

2. Optionally, to view the activity for your Mutation Surveyor users (logging in to or logging out of Mutation Surveyor) in a log file, click View Log.
   
   The User Management Log file opens onscreen. The file lists all the activity for your Mutation Surveyor users, and if applicable, for your Geneticist Assistant and/or NextGENe users as well. You can click Save to File to save the log file with a name and a location of your choosing.

Figure 1-26: User Management Log file
3. Click the Users tab to open it.

The tab lists all the user accounts that have been configured for your Mutation Surveyor instance, and if applicable, any user accounts that have been configured for your Geneticist Assistant and/or NextGENe instances.

*Figure 1-27: User Management Settings dialog box, Users tab*

4. Continue to one of the following:
   - “To add a user” on page 45.
   - “To edit a user” on page 46.
   - “To delete a user” on page 47.
To add a user

1. Click Add User.

   The Add User dialog box opens.

   *Figure 1-28: Add User dialog box*

   ![Add User dialog box]

2. Enter the information for the new user:
   
   • In the Username field, enter the appropriate user name.
   
   • In the Password field, enter the password for the user.

   The only invalid character is a space. There are no other special requirements or restrictions for the user password. It can adhere to your organization’s standards and any other requirements as needed. If you forget or lose this password, it is not recoverable.

   • In the Verify field, enter the user password exactly as you entered it in the Password field.

   • Optionally, in the Email field, enter the email address for the user.

   The current version of User Management does not support email notifications; however, you can still enter an email address.

3. Assign the user to a selected group.

   By assigning a user to a group assigns the user’s permissions for Mutation Surveyor. If the appropriate group is not available, then you must add the group. See “Managing Groups in Mutation Surveyor” on page 38.

4. Optionally, if the user is to be responsible for User Management in Mutation Surveyor (managing groups and users), then select System administrator.
5. Click OK.
   A message opens, indicating that the new user was created successfully.

6. Click OK.
   The message closes. The entry for the new user is displayed on the Users tab. The Users tab remains open.

7. Click OK.
   The User Management Settings dialog box closes.

**To edit a user**

You can edit the password, the email address, and the groups for a user. For any user other than the default Administrator user, you can edit the System administrator status. You cannot edit the username for any user. To edit the username, you must delete the user, and then create a new user with a different username. See “To delete a user” on page 47.

1. Select the user that you are editing, and then click Edit User.
   The Edit User dialog box opens.

   ![Edit User dialog box](image)

2. Edit the information for the user as needed:
   - To edit the password, select New password, and then do the following:
     - In the Password field, enter the password for the user.
     - In the Verify field, enter the user password exactly as you entered it in the Password field.

   *The only invalid character is a space. There are no other special requirements or restrictions for the user password. It can adhere to your organization’s standards and any other requirements as needed. If you forget or lose this password, it is not recoverable.*

   - In the Verify field, enter the user password *exactly* as you entered it in the Password field.
• Enter an email address for the user, or edit the existing address as needed.
• Select a different group for the user.
• Select or clear the System administrator status for the user.

3. Click OK.
   A message opens, indicating that the new user was updated successfully.

4. Click OK.
   The message closes. The entry for the user is updated accordingly on the Users tab.

5. Click OK.
   The User Management Settings dialog box closes.

To delete a user

You cannot delete the default Administrator user. To edit the name for a user, you must delete the user, and then create a new user with a different user name. See “To add a user” on page 45.

1. Select the user that you are deleting, and then click Delete User.
   A message opens, indicating that you are deleting the user and asking you to click OK to continue.

2. Click OK.
   The message closes, and a second message opens indicating that the selected user was successfully deleted.

3. Click OK.
   The second message closes. The entry for the user is removed from the Users tab. The Users tab remains open.

4. Click OK.
   The User Management Settings dialog box closes.
Chapter 2
Project Setup

To set up a project in Mutation Surveyor, you must understand about the different file types, how to modify the default Mutation Surveyor project settings, and then using this information to set up a project that meets your working needs. You can set up single or multiple projects in Mutation Surveyor. This chapter guides you through the necessary steps for setting up a single project in Mutation Surveyor.

For information about working with multiple Mutation Surveyor projects, including processing and displaying results, see Chapter 11, “Multiple Projects,” on page 313.

This chapter covers the following topics:

- “Project File Types” on page 50.
- “Modifying the Default Mutation Surveyor Project Settings” on page 52.
- “Setting up a Single Mutation Surveyor Project” on page 70.
Chapter 2
Project Setup

Project File Types

A project in Mutation Surveyor can have up to three different types of files—sample files, reference files, and GenBank files. Each file serves a different purpose in the project, each file has a different source, and each file type has its own unique requirements.

Sample file

The sample file is always a required file for a Mutation Surveyor project. The Sample file is the file that contains an unknown base sequence that you want to determine. A sample file must be in one of the following formats—SCF, AB1/ABI, GZ, ESD, or RSD. A sample file can be a single one-directional file or it can be two separate files, with one file containing the forward read and the other file containing the overlapping reverse read.

If your sample files are human DNA, then you have the option of loading only sample files. See “Automatic GenBank download” on page 51.

Reference file

The Reference file contains a known base sequence to which your sample files are compared. The Reference file is always a required file in a Mutation Surveyor project; however, the file source can vary. You can manually load a reference file, or you can have Mutation Surveyor create a synthetic reference file. The loaded file must be in one of the following formats—SCF, AB1/ABI, GZ, ESD, or RSD. If you do not load a reference file and your files do not meet the requirements for an Automatic GenBank download (see “Automatic GenBank download” on page 51) then you must have a GenBank file loaded so that Mutation Surveyor can automatically create a synthetic reference file for each contig based on the loaded GenBank file.

GenBank file

A GenBank file is a text-based file that shows the amino acid translation that corresponds to the base coding sequence (CDS). A GenBank file is always an optional file for a Mutation Surveyor project. The required file format is either GBK, GB, or SEQ. If you load a GenBank file, then Mutation Surveyor automatically creates a synthetic reference file for each contig based on the loaded GenBank file. Additionally, FASTA or FA files can be loaded as a GenBank file, but no CDS annotation will be provided.

You can load a GenBank file even you have loaded reference files for a project. This can be useful if you want to determine systematic errors in your amplicons such as PCR artifacts. See “GenBank/Reference Comparison” on page 58.
Automatic GenBank download

If your sample files are human DNA, then you have the option of loading only sample files for a Mutation Surveyor project. When you run the project, by default, Mutation Surveyor automatically accesses a GenBank database on SoftGenetics’s bwt server (this database contains Build 37 of the human genome) and downloads the correct GenBank reference file (gene) to which to match the sample files.

You can change the default location from which to download the GenBank reference file. See “Automatically Download GenBank Files” on the “” on page 66.
Modifying the Default Mutation Surveyor Project Settings

When you run a mutation project, you can use the default values for the mutation project settings, or you can modify any or all the settings as needed. You use the Mutation Project Settings dialog box to modify the settings for a mutation project. You can modify the value for two types of project settings—analysis settings and output/display settings.

- **Analysis settings**—Analysis settings determine how your data is analyzed and therefore, which positions in your sample traces are called as mutations and which are not. Any difference that is found between your sample traces and reference traces must meet all the project analysis settings to be called as a mutation. You must modify the analysis settings before running a project. The Input tab, the Contig tab, and the Database tab contain only analysis settings. Other analysis settings are found on the following tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Project Analysis Settings</th>
</tr>
</thead>
</table>
| Mutation  | • Mutation Detection  
            | • Peak Fronting  
            | • Base Labeling  
            | • Data Processing |
| Display   | • Check 2D Small Peaks (Mosaic) |
| Others    | • Check Gene Direction  
            | • Methylation |

- **Output/display parameters**—Output/display parameters do not affect the analysis of your data. They simply determine how your data is displayed to you in the different frames of the Graphical Analysis Display (GAD) for a project. For example, is an identified mutation displayed in red or blue in the Mutation table of the GAD? You can modify the output/display settings (found on the Mutation tab, the Output tab, the Display tab, the 2 Directions tab, the Others tab, and the Database tab) before or after running a project.

For detailed information about the Graphical Analysis Display for a project, see Chapter 3, “Graphical Analysis Display,” on page 75.
To modify the default Mutation Surveyor project settings

   The Mutation Project Settings dialog box opens. The Contig tab is the active tab.

2. Do one of the following:
   • Click Load Settings to browse to and select a saved Settings file (.ini file) to analyze and display the project results according to the settings in the file.
   • Modify the project values as needed on any of the tabs. See:
     • “Input tab” on page 54.
     • “Contig tab” on page 55.
     • “Mutation tab” on page 59.
     • “Output tab” on page 62.
     • “Display tab” on page 64.
     • “2 Directions tab” on page 65.
     • “” on page 66.
     • “Database tab” on page 69.

3. Optionally, before you process the files, click Save Settings to save the settings that you have specified to a Settings.ini file.

4. Click OK.
   • Unless you modify the values again, all new projects are carried out according to the options that you have loaded/specified.
   • If you load an existing project, the options revert to those set for the project. If you run a new project after loading an existing project, the new project is carried out according to the existing project settings.

5. Continue to “Setting up a Single Mutation Surveyor Project” on page 70.
Chapter 2  
Project Setup  

Input tab  

*Figure 2-1: Mutation Project Settings dialog box, Input tab*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trace File (both Raw and Processed)</td>
<td>These options are applicable only if you loaded AB1/ABI sample files.</td>
</tr>
<tr>
<td></td>
<td>• Load Raw Data—Loads only the raw trace (no baseline subtraction, no smoothing, no mobility shift correction, or no base calling) in the AB1/ABI sample files for analysis.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the project contains only a few traces and some of the traces have heterozygous substitutions close to the start of the traces, then the mobility shift correction that Mutation Surveyor carries out might cause a single heterozygous peak to be corrected into two homozygous peaks, which results in a false positive of a single base insertion.</td>
</tr>
<tr>
<td></td>
<td>• Load Processed Data—The default value. Loads only the processed data in the AB1/ABI sample files for analysis.</td>
</tr>
<tr>
<td>Phred Score (Processed Data)</td>
<td>• Display Processed Trace Phred Scores—Load the Phred scores that are contained within the traces for each base.</td>
</tr>
<tr>
<td></td>
<td>• Display Mobility-corrected Phred Scores—Load the Phred scores that Mutation Surveyor has calculated for each base.</td>
</tr>
</tbody>
</table>
Contig tab

**Figure 2-2:** Mutation Project Settings dialog box, Contig tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fragment Size</strong></td>
<td>The number of sequential bases that are used for base matching. The default value is 12. The allowed range is 10 - 16 bases. Mutation Surveyor evaluates a string of 12 bases in the sample trace and compares this string to the reference trace. If the string matches the reference trace, Mutation Surveyor moves to the next series of 12 bases and makes another comparison. Mutation Surveyor continues with these matching steps until it is able to determine whether the sample trace belongs to an existing contig or whether the sample trace belongs in its own contig.</td>
</tr>
<tr>
<td><strong>Matching Base Number</strong></td>
<td>The minimum number of bases that must match between two sample traces for the traces to be placed in the same contig. The default value is 60. The allowed range is 20 - 100 bases.</td>
</tr>
<tr>
<td><strong>Matching Base Percentage</strong></td>
<td>The minimum percentage of bases that must match between two sample traces for the traces to be placed in the same contig. The default value is 30%. The allowed range is 20 - 90%.</td>
</tr>
</tbody>
</table>
### Chapter 2
**Project Setup**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Force Into One Contig</strong></td>
<td>Place sample traces that meet all the matching base criteria and that differ in the starting base positions by $\leq 300$ bps into one contig.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Selected by default. If the quality of the sequences differs and sequences might be placed into either of two contigs, the samples might be placed into a different contig than expected. If samples that should be grouped into the same contig are not being grouped correctly using the Force Into One Contig option, then select Exclude 1st Base Difference $&gt; [ ]$ and accept the default value of $200$ bps.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you are using a Grouping File to correctly pair your sample files, make sure that this option is <strong>not</strong> selected. See &quot;Pairing&quot; on page 57.</td>
</tr>
</tbody>
</table>

| **Exclude 1st Base Difference $> [ ]$**      | Place sample traces that meet all the matching base criteria but that differ in the starting base positions by more than "n" number of bases into two contigs. The default value is $200$ bps.                                      |
| **Note:**                                   | Force into One Contig and Exclude First Base Difference sort contigs using only base calling (peak quality is not evaluated) and therefore, are carried out before quality trimming. (See "Quality Trim" on page 58.) If neither Force into one Contig nor Exclude 1st Base Difference $> [ ]$ is selected, then: |
|                                             | • Place sample traces with $> 500$ bps that meet all the matching base criteria and that differ in the starting base positions by $\leq 250$ bps into one contig.                                                                 |
|                                             | • Place sample traces with $> 300$ bps and $< 500$ bps that meet all the matching base criteria and that differ in the starting base positions by $< \text{read length}/2$ bps into one contig.                                                                 |
|                                             | • Place sample traces with $< 300$ bps that meet all the matching base criteria and that differ in the starting base positions by $< 150$ bps into one contig.                                                                 |

| **Base Patch**                              | If you are attempting to make mutation calls in the first $50$ bases of sample traces, but the calls are being missed, then select Base Patch to correct the poor mobility shift at the starting of traces. With this option selected, Mutation Surveyor evaluates the spacing between each peak, and based on the results of this evaluation, Mutation Surveyor might make a different base call than what is included in the original trace. |
| **Note:**                                   | If you are analyzing AB1/ABI files and these issues are still not corrected with Base Patch selected, select Load Raw Data on the Options tab. See "Trace File (both Raw and Processed)" on page 54. |

| **Calculate Lane Quality Within the Region of Interest** | Calculate the lane quality for the Region of Interest in the GenBank file, not the entire trace. If the ROI extends beyond the comparison region, then the ROI quality score is adjusted by the percent overlap of the aligned region and the ROI. For example, if the ROI length is $63$ bp and the length of the overlap between the aligned region and the ROI is $8$, then the percent overlap is $8/63 = 0.127$. The currently calculated quality score, which in this example is $88$, is then adjusted by this percentage to give the new quality score or $(0.127)(88) = 11$. |
| **Note:**                                     | To define a Region of Interest (ROI) in a GenBank file, see "Advanced GBK File Editor Tool" on page 231. |
## Use Amplicon to Construct Contig

Two options:
- If all the filenames in a project contain an amplicon-specific designator, then select Select from Character X to Y and enter the starting and ending character positions of this designator. For example, Figure 2-3 shows a series of sample file names with the amplicon-specific designators of 10B and 11A located in positions 14 through 16 of the filename.

![Figure 2-3: Amplicon-specific designators in sample file name](image)

**Note:** If ROIs in the GenBank file are labeled with their Amplicon IDs, then selecting this option ensures that the appropriate ROI is evaluated for each amplicon.

- If your sample file names do not follow any file-naming standards, and you used a Grouping File to load the sample files, then select Use Sample Grouping file to help organize the contigs correctly. See “2D Filename Match Editor tool” on page 261.

**Note:** If you do use a Grouping File, then when you are adding sample files to your Mutation Surveyor project, make sure that Load Grouping File is selected on the Open Files dialog box. When you click Add in the Sample files pane, select the Grouping File. All the sample files that are defined in the Grouping File are added for the Mutation Surveyor project.

## Pairing

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exact Filename F/R Match</td>
<td>Select this option to pair your forward and reverse sample files if your filenames differ only by the directional identifier (f or r). For example: <strong>MMipOp260_f_018.ab1/MMipOp260_r_018.ab1</strong></td>
</tr>
<tr>
<td>Exact Filename Match Before F/R</td>
<td>Select this option to pair your forward and reverse sample files if your filenames are identical before the directional identifier (f or r), but vary after the directional identifier. For example: <strong>MMipR260_f_017.ab1/MMipR260_r_018.ab1</strong></td>
</tr>
</tbody>
</table>

**Note:** In some situations, neither of the above automatic file pairing options suits your current needs. For example, your files might require a complete naming overhaul before you can use either option. Additionally, you might want to set aside blocks of data for analysis at a later date. In such a situation, you should create a Grouping File to load your sample files. See “2D Filename Match Editor tool” on page 261.
### Chapter 2
#### Project Setup

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Trimming</strong></td>
<td></td>
</tr>
<tr>
<td>Quality Trim</td>
<td>Eliminates low quality data at the starting and the end of a sample trace. Quality trimming trims the sequence data based on the base quality. By default, when the S/N Ratio is greater than 15 for 7 out of 9 sequential bases, then mutation detection is carried out in this region.&lt;br&gt;&lt;br&gt;<strong>Note:</strong> Quality Trim is always implemented in Mutation Surveyor which is why the option is always selected and always unavailable. If you select other trimming options, then all the selected trimming methods are compared. The trimming method that results in the greatest number of bases being trimmed is the trim method that is applied. Quality Trimming is then applied after the selected trimming method.</td>
</tr>
<tr>
<td>Vector Trim</td>
<td>Trims the sample sequence according to a starting vector sequence and an ending vector sequence that you define using the SEQ File Editor tool. See “SEQ File Editor Tool” on page 246.</td>
</tr>
<tr>
<td>5' Trim [ ]</td>
<td>Trim the 5’ end of the sample trace by the indicated number of bases.</td>
</tr>
<tr>
<td>3' Trim [ ]</td>
<td>Trim the 3’ end of the sample trace by the indicated number of bases.</td>
</tr>
<tr>
<td>Score Trim [ ]</td>
<td>Reject regions for mutation detection in which the base quality for 7 out of 9 sequential bases falls below the specified value. For example, if the Score Trim is set to a value of 10, and the S/N Ratio is 8 for 7 out of 9 sequential bases, then mutation detection is not carried out in this region. The default value is 16.</td>
</tr>
<tr>
<td><strong>Contig Sort By</strong></td>
<td>Determines the sort order of multiple contigs in a project.</td>
</tr>
<tr>
<td></td>
<td>• Sample Filename</td>
</tr>
<tr>
<td></td>
<td>• Reference Filename</td>
</tr>
<tr>
<td></td>
<td>• Contig Num. of Sample Files</td>
</tr>
<tr>
<td>GenBank/Reference Comparison</td>
<td>If you have both GenBank and reference files loaded, and this option is selected, then Mutation Surveyor creates a synthetic sample trace from the base sequence of the GenBank file and the reference trace to classify the variance between the GenBank file and your reference files. You can, in turn, use this variance to determine systematic errors in your amplicons such as PCR artifacts.</td>
</tr>
</tbody>
</table>
Mutation tab

Figure 2-4: Mutation Project Settings dialog box, Mutation tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mutation</strong></td>
<td></td>
</tr>
<tr>
<td>Mutation Score</td>
<td>Indicates the level of confidence that a called mutation is a true mutation. The score is based on the concept of Phred scores, where quality scores are logarithmically linked to error probabilities as shown in Figure 2-5.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Figure 2-5: Phred scores and error probabilities</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Phred quality score</td>
<td>Probability that the base is called wrong</td>
</tr>
<tr>
<td>10</td>
<td>1 in 10</td>
</tr>
<tr>
<td>20</td>
<td>1 in 100</td>
</tr>
<tr>
<td>30</td>
<td>1 in 1,000</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Overlapping Factor</td>
<td></td>
</tr>
<tr>
<td>Dropping Factor</td>
<td></td>
</tr>
<tr>
<td>S/N Ratio</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Mutation Height</td>
<td>The minimum height (in RFU) required for a peak in the mutation trace to be called as a mutation peak. The default value is 500 RFU.</td>
</tr>
</tbody>
</table>
### Overlapping Factor

The average of the following two values:
- The difference in the area between the reference peak and the mutation peak.
- The difference in the area between the sample peak and the mutation peak.

For an ideal mutation peak, the overlapping factor has a value of 1.0. In reality, this value is typically less than one. The overlapping factor must be greater than or equal to the specified value for the variant to be called a mutation. The default value is .20, or 20%.

**Figure 2-6: Calculating the Overlapping Factor**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overlapping Factor</td>
<td>The average of the following two values:</td>
</tr>
<tr>
<td></td>
<td>• The difference in the area between the reference peak and the mutation</td>
</tr>
<tr>
<td></td>
<td>peak.</td>
</tr>
<tr>
<td></td>
<td>• The difference in the area between the sample peak and the mutation</td>
</tr>
<tr>
<td></td>
<td>peak.</td>
</tr>
<tr>
<td></td>
<td>For an ideal mutation peak, the overlapping factor has a value of 1.0. In</td>
</tr>
<tr>
<td></td>
<td>reality, this value is typically less than one. The overlapping factor</td>
</tr>
<tr>
<td></td>
<td>must be greater than or equal to the specified value for the variant to</td>
</tr>
<tr>
<td></td>
<td>be called a mutation. The default value is .20, or 20%.</td>
</tr>
</tbody>
</table>

**Dropping Factor**

Measures the drop in peak intensity at the variant position by normalizing the peak intensity between the reference peak and the sample peak at positions two through five on both sides of the variant. The dropping factor for a homozygous mutation is 1, or 100%. The dropping factor for a heterozygous mutation is 0.5, or 50%. The dropping factor must be greater than or equal to the specified value for the variant to be called a mutation. The default value is .10, or 10%.

**Figure 2-7: Calculating the Dropping Factor**
Chapter 2
Project Setup

S/N Ratio

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| S/N Ratio                     | Signal (S) is defined as the mutation peak intensity and noise (N) is defined as the median noise intensity for the mutation peak. The Signal to Noise Ratio (S/N Ratio) determines how large the signal must be for a mutation peak relative to the noise for the mutation to be registered.  
**Note:** The minimum noise at a given base position is 250 RFU.  
**Note:** S/N Ratio is output to some reports as SnRatio. |

**Mutation Detection**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Mutation Detection            | Determines the level of sensitivity that Mutation Surveyor uses to call mutations.  
• High sensitivity  
• Medium sensitivity  
**Note:** There are many functions that change the parameters between these two options. For example, if in 2D data, one trace indicates a mutation at a location, but the other trace does not, Mutation Surveyor checks for local base quality and decides whether to add or delete the mutation. In other situations, statistical analyses are carried out for the contigs to check for possible missed mutations, reported mutations are checked for missed mutations and so on. If you are concerned that your data might be showing a high number of false positives, then set the sensitivity to medium to reduce the number of false positives. |

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Allow for Hypervariable        | Select this option to have Mutation Surveyor automatically extend the starting and ending positions for the aligned comparison region if both of the following conditions are met:  
• At least 4 of 10 consecutive bases outside of the aligned comparison region have a Phred-like score >=15.  
• At least 8 of 12 consecutive bases outside of the aligned comparison region are identical to the reference bases.  
**Note:** By extending this region, more potential mutations can be called, which is especially useful for samples that are known to have a high mutation frequency such as viruses and the human leukocyte antigen system (HLA). |
| Mutation Detection            |                                                                                                                                                                                                             |

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Delete Indels/het_indels      | Select this option to have Mutation Surveyor automatically delete all insertion and deletion calls from the project.  
**Note:** Selecting this option helps to eliminate false positives that are common to hypervariable sequences. |
| Automatically                  |                                                                                                                                                                                                             |

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Software to Delete</td>
<td>Select this option to have Mutation Surveyor automatically delete illogical mutation calls and mutation calls that have high background noise (&gt; 250 RFU).</td>
</tr>
<tr>
<td>Mutations</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Indels Outside of ROI</td>
<td>If selected, then Mutation Surveyor automatically deletes insertions and/or deletions that fall outside the ROI.</td>
</tr>
</tbody>
</table>
### Peak Fronting

Peak Fronting is often seen as a smaller peak that is in front of a major peak of the same color, which means that the peaks represent the same base in the sequence. This small peak is often the result of PCR reactions of a dye-labeled terminator when concentrated reagents are used. With Peak Fronting Correction, the minor peak is reduced in size relative to the major peak. The default value is 1%.

**Note:** Peak Fronting Correction might reduce the mutation intensity of some peaks in the mutation trace.

**Note:** Newer chemistries often have less peak fronting, so lowering this value can increase the sensitivity of mutation detection.

### Base Labeling

- **Original**
  - Use the base position that was defined by the original base calling software.
- **Peak Center**
  - Use the bases at the center of the peak to determine peak height.

### Data Processing

**Dye blob baseline noise removal**

If the sequence traces exhibit broad peaks caused by a dye blob, then the baseline might introduce artifacts into the trace. Select this option to remove the baseline noise that is caused by a dye blob.

**Note:** Baseline removal might reduce the mutation intensity of some peaks in the mutation trace.

### Output tab

*Figure 2-8: Mutation Project Settings dialog box, Output tab*
## Project Setup

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output Table Fields</strong></td>
<td>Select the fields that are to be displayed in the Viewing and Reporting pane for the different standard mutation reports.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Base Score - The average value of the Phred scores in the comparison region. The Phred score can be derived by either the Processed Trace Phred scores or the Mobility-corrected Phred scores.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The selections that you make here affect all standard mutation reports en masse. You cannot select different fields for different reports. See Chapter 5, “Mutation Surveyor Standard Reports,” on page 125.</td>
</tr>
<tr>
<td><strong>Quality Thresholds</strong></td>
<td>Lane Quality &gt;= [ ]—Lane quality is a measure of the S/N Ratio within a sample trace prior to alignment to a reference trace. After the sample trace is aligned to the reference trace, peak spacing in the sample trace is adjusted, which often results in higher lane quality. Lane quality ranges from 0 to 100, with 100 being the highest quality. If multiple reference files are available, Mutation Surveyor chooses the reference file with the highest lane quality.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>“Low Quality” is displayed in the Lane Quality column in reports for a trace with lane quality that falls below the Quality Threshold.</td>
</tr>
<tr>
<td><strong>Output Limits</strong></td>
<td></td>
</tr>
<tr>
<td>CDS Only</td>
<td>Limits the graphical output to the CDS.</td>
</tr>
<tr>
<td>• Before (After) CDS</td>
<td>• Available only if CDS Only is selected. Specify the number of bases that are to precede/follow the coding region.</td>
</tr>
<tr>
<td>Region of Interest Only</td>
<td>Limits the graphical output to Regions of Interest.</td>
</tr>
<tr>
<td>Print Default Header Information</td>
<td>Selected by default. Prints the default Header information on a variety of standard mutation reports.</td>
</tr>
<tr>
<td>Add dbSNP Id to Comments</td>
<td>Displays the dbSNP identifier in the Comments field for a standard mutation report when Comments are selected for output.</td>
</tr>
<tr>
<td>Mutation Call Nucleotides Relative to Gene Direction</td>
<td>Make the mutation call based on the gene orientation. To make a mutation call for a gene on the reverse strand, a reverse complement is generated.</td>
</tr>
</tbody>
</table>
Display tab

*Figure 2-9: Mutation Project Settings dialog box, Display tab*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mutation Threshold</strong></td>
<td>Determines how an identified mutation is displayed—red font (low confidence) or blue font (high confidence)—in the different mutation reports. The values in the Reject column indicate the upper rejection boundary. The values in the Pass column indicate the lower acceptance boundary.</td>
</tr>
<tr>
<td></td>
<td>• If the value <em>for any</em> of the mutation settings is less than the rejection boundary, then the mutation is rejected and is not displayed in the different mutation reports.</td>
</tr>
<tr>
<td></td>
<td>• If the values <em>for all</em> the mutation settings fall within the indicated ranges, the mutation is accepted and displayed in red in the different mutation reports.</td>
</tr>
<tr>
<td></td>
<td>• If the values <em>for all</em> the mutation settings exceed their acceptance boundaries, then the mutation is accepted and displayed in blue in different mutation reports.</td>
</tr>
<tr>
<td>Note:  For 2D data, the mutation scores (F and R) are summed and the sum score is used to determine if the mutation call is rejected, passed, or put into check.</td>
<td></td>
</tr>
<tr>
<td><strong>Amino Acid</strong></td>
<td>• 1 Letter—Display 1 Letter IUPAC amino acid code in the mutation reports and views.</td>
</tr>
<tr>
<td></td>
<td>• 3 Letter—Display 3 Letter IUPAC amino acid code in the mutation reports and views.</td>
</tr>
<tr>
<td></td>
<td>• With Indel Changes—Selected by default. Displays the amino acid output including indels. Clear this option to display the amino acid output without indels.</td>
</tr>
</tbody>
</table>
### Position
- **Contig**—Show the position within the GenBank file for the queried contig in the Nucleotide Sequence frame and Mutation table of the GAD, and in the Project Reviewer report.
- **Chromosome**—Show the chromosome position for the queried contig in the Nucleotide Sequence frame and Mutation table of the GAD, and in the Project Reviewer report.

*Note:* The Chromosome option works correctly only if the GenBank file contains chromosome information; otherwise, Mutation Surveyor defaults to showing the contig information.

### Check 2D Small Peaks (Mosaic)
- **Check**—If selected, Mutation Surveyor searches for minor alleles that are present within the baseline of bi-directionally aligned peaks and indicates their presence with a short green bar.
- **Height Threshold**—Available only if Check 2D Small Peaks is selected. Specify the RFU value for the smallest peak that is to be detected.

*Note:* This option is useful for somatic mutation detection.

### Maximum Height in Mutation Electropherogram
If the height of a peak in the mutation trace exceeds this maximum value, then Mutation Surveyor normalizes the peak to this maximum height. The default value is 5000 RFU.

### Display Phred Score
If selected, the Phred-like score for each peak in the mutation trace is displayed in the sample trace directly below the base call.

### Display Negative SNPs
If selected, positions with reported variations that do not contain the SNP are indicated in the Graphical Analysis Display (GAD) by showing the possible alleles in green at the top of the mutation trace.

## 2 Directions tab

*Figure 2-10: Mutation Project Settings dialog box, 2 Directions tab*
For 2D data, the mutation scores (F and R) are summed and the sum score is used to determine if the mutation call is rejected, passed, or put into check. Figure 2-11 below illustrates how 2 Directions settings work based on the default values for a mutation project.

Figure 2-11: Examination of 2D mutation data

<table>
<thead>
<tr>
<th>F</th>
<th>R</th>
<th>Sum</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>3</td>
<td>6</td>
<td>Fail</td>
</tr>
<tr>
<td>6</td>
<td>10</td>
<td>16</td>
<td>Check</td>
</tr>
<tr>
<td>4</td>
<td>40</td>
<td>44</td>
<td>Check</td>
</tr>
<tr>
<td>12</td>
<td>18</td>
<td>30</td>
<td>Pass</td>
</tr>
</tbody>
</table>

For 1D data that is being analyzed with 2D settings, a mutation is called if it meets one of the following parameters; otherwise, it is rejected.

- Score > SumScoreReject
- Score > SumScoreReject*0.8 and Dropping Factor >= 0.3
- Score > SumScoreReject*0.6 and Dropping Factor >= 0.35
- Score > SumScoreReject*0.4 and Dropping Factor >= 0.4

Figure 2-12 below illustrates these parameters based on the default value of 20 for the SumScoreReject.

Figure 2-12: Examination of 1D mutation data analyzed with 2D settings

<table>
<thead>
<tr>
<th>Score</th>
<th>SumScoreReject Factor</th>
<th>SumScoreReject</th>
<th>Dropping Factor</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td></td>
<td>20</td>
<td>N/A</td>
<td>Pass</td>
</tr>
<tr>
<td>15</td>
<td>0.8</td>
<td>20</td>
<td>0.3</td>
<td>Fail</td>
</tr>
<tr>
<td>15</td>
<td>0.6</td>
<td>20</td>
<td>0.35</td>
<td>Pass</td>
</tr>
<tr>
<td>15</td>
<td>0.4</td>
<td>20</td>
<td>0.4</td>
<td>Pass</td>
</tr>
</tbody>
</table>
Others tab

**Figure 2-13: Mutation Project Settings dialog box, Others tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database URL</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Automatically Download GenBank Files        | • If your sample files are human DNA, then you have the option of loading only sample files for a Mutation Surveyor project. When you run the project with this option selected, Mutation Surveyor automatically accesses the database that is specified by the URL and downloads the correct GenBank file (gene) to which to match the sample files.  
  **Note:** The default URL is GRCh38. Click on the drop-down arrow to change to GRCh37 or GRCh36. Click on Update URLs to manually add a new database URL. |
| User Local Directory                        | • If the GenBank file to which you want to match your sample files resides in a directory on your local computer, clear the Automatically Download GenBank Files option, and then click the Browse button to browse to and select the local directory path. |
| **Check Gene Direction**                    |                                                                                                                                                                                                             |
| Automatically Adjust GenBank Direction      | Selected by default. Determines whether the queried gene in the GenBank file is complemented based on its location (plus (+) or minus (-) strand).  
  • Selected by default. Orient GenBank files in Gene Direction  
  • Orient GenBank files in Chromosome Direction |
## Option Setup

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Inspect GenBank for Chromosome Positions | Selected by default. Determines if the GenBank file header contains the genome build, the chromosome name, and the chromosome position. If this information is present, then chromosome information can be displayed in the Nucleotide Sequence frame and the Mutation table in the GAD, and the Project Reviewer report; otherwise, only the contig information can be displayed.  
**Note:** If you clear this selection, then Mutation Surveyor does not notify you when chromosome options will not work correctly; however, if chromosome information is contained in the GenBank file, then the chromosome options still work correctly. |
| Query Reference Traces             | Not selected by default. If a GenBank file is not loaded for the project, but reference traces are, then the sample traces are aligned only to the reference traces. If selected, Mutation Surveyor downloads the appropriate GenBank file for the project, and aligns both the reference and sample traces to the GenBank file for annotation.                                                                                       |

### Methylation

- **Methylation**  
  - **Set By User**  
    - Select this option to manually specify which forms of methylation Mutation Surveyor should detect.  
  - **Automethylation**  
    - Selected by default when Methylation is selected. Mutation Surveyor automatically detects methylated sequences.  

**Note:** For information about methylation detection in Mutation Surveyor, see “Methylation Detection” on page 301.

---

**Figure 2-14: Database URL, Update URLs button**

![Update Reference URLs](image)
Database tab

Some GenBank files contain only NT-accession numbers and not chromosome information. You specify the database on the Database tab that is to be used to translate these contig positions into chromosome positions.

Figure 2-15:  Mutation Project Settings dialog box, Database tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The address for the Annotation Database server. The default value is set to localhost, which assumes that the server is installed on the same computer as Mutation Surveyor. If this is correct, then leave the default value as-is; otherwise, modify the value accordingly.</td>
</tr>
<tr>
<td>Port</td>
<td>Leave this option set to the default value of 3306 only if no other application is already using MySQL on the port; otherwise, modify the value accordingly.</td>
</tr>
<tr>
<td>User</td>
<td>The user name for MySQL. Leave this option set to the default value of softgenetics unless your administrator has changed it.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for MySQL. Leave this option set to the default value unless your administrator has changed it.</td>
</tr>
<tr>
<td>Show Database</td>
<td>To verify the MySQL connection and populate the list of available annotation databases, click this option. <strong>Note:</strong> If the MySQL connection cannot be verified, an error message opens indicating this, and that the list of annotation databases cannot be populated. Verify that you have imported the necessary annotation databases (see the Reference and Track Manager Tool User’s Manual) and/or contact for your administrator for assistance.</td>
</tr>
<tr>
<td>Annotation DB</td>
<td>Select the appropriate annotation database.</td>
</tr>
</tbody>
</table>
Setting up a Single Mutation Surveyor Project

When you set up any Mutation Surveyor project, the following caveats apply:

- For one directional data, you can enter 48 or 2000 sample files depending on the version of Mutation Surveyor that you purchased. Only a single reference file is required.
- For two directional data, you can enter 24 or 1000 pairs of sample files depending on the version of Mutation Surveyor that you purchased. Both a forward reference file and a reverse reference file are required.
- Sample files and reference files are limited to a read length of 2500 bps. GenBank files are limited to a read length of 10 Mbp per file.
- If your amplicons do not overlap and your forward and reverse directional pairs have similar start and end locations, then the forward and reverse files with similar names that have been grouped in the same contig are automatically paired.

To set up a Mutation Surveyor project

The following procedure details how to set up a single new Mutation Surveyor project. For information about setting up and working with multiple Mutation Surveyor projects, see Chapter 11, “Multiple Projects,” on page 313.

1. Confirm that your Mutation Surveyor project options are correctly set, or modify them as needed. (See “Modifying the Default Mutation Surveyor Project Settings” on page 52.)

2. On the Mutation Surveyor main menu, click File > Open Files.

   The Open Files dialog box opens.

   Figure 2-16: Open Files dialog box
3. For each file type that you are adding to the project:
   - Click Add in the appropriate pane. (For example, to add a GenBank file, click Add in the GenBank Sequence File pane.)
   - In the Open <File> dialog box, browse to and select the files that you are adding to the project. (CTRL-click to select multiple files.)
   - Click Open to add the files to the project, and then click OK.

4. Optionally, to view the data before it is aligned, expand the Sample file folder in the Browser pane, and then double-click a sample file. You can do any of the following to change the view of the data:
   - Zoom in - Click and hold the left mouse button and draw a box from the upper left hand corner of the pane towards the lower right hand corner. A box is formed around the area that being reduced for viewing.
   - Zoom out - Click and hold the left mouse button and draw a box from the lower right hand corner of the pane towards the upper left hand corner. (The magnification for zooming out is always 100%.)
   - Move left/right - Click and hold the right mouse button, and then drag the display to the left or right.
   - If the data does not include basecalling, or if you selected the Mutation Project Setting “Load Raw Data”, click on the active “Raw Data to Processed Data” icon ( ) to view the basecalling as processed by Mutation Surveyor. See “Input tab” on page 54.

*Figure 2-17: Viewing unaligned data for a sample file*

Mutation Surveyor aligns the nucleotide sequences of the sample traces to the reference traces and groups the sample traces into contigs based on their degree of overlap. (See “Contig directory for a Mutation Surveyor project” below.) The reference traces and sample traces are then compared at a trace by trace level to identify substitutions, insertions, and deletions. All the variants are aligned in the Mutation report, which is automatically displayed in the Viewing and Reporting pane after the project is run.

6. On the main menu, click File > Save Mutation Project.

The project is assigned a default name and has the type of Mutation Project Files (*.Sgp). You cannot change the file type, but you can change the project name and select any location in which to save the project.

Contig directory for a Mutation Surveyor project

Mutation Surveyor aligns the nucleotide sequences of the sample traces to the reference traces and groups the sample traces into contigs based on their degree of overlap. Because contigs are organized relative to the reference file, forward and reverse sequence pairs are grouped into two separate contig folders that are displayed in the Browser pane. The folders are labeled as ContignF and ContignR, where F stands for forward sequence, R stands for reverse sequence, and “n” stands for the contig file name, for example, Contig2F and Contig2R. The number in the parenthesis after the contig name indicates the number of
samples for the contig.

- A green File icon with a red checkmark ✗ indicates the active reference file for the contig.

- If the reference file was derived from a GenBank file, a black checkmark ✓ indicates this GenBank file.

- A green File icon ✗ indicates the sample file that is currently selected. The corresponding data is displayed in the Viewing and Reporting pane of the GAD.

*Figure 2-19: Contig directory in the Browser pane*

You can right-click on the currently selected trace to open a context menu with the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Filename to Clipboard</td>
<td>Copies the complete file name for the selected trace to the clipboard. You can then paste the file name into a third-party application such as Word or Excel as needed.</td>
</tr>
<tr>
<td>Add/Edit Comment</td>
<td>Opens the Add/Edit Comments dialog box in which you can add/edit the comments for the selected trace. The comments are displayed above the sample trace in the GAD.</td>
</tr>
</tbody>
</table>
|                         | *Figure 2-20: Add/Edit Trace Comments dialog box*

*Note:* Trace comments can also be enabled in the Custom report. See “Display tab” on page 172.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Lane</td>
<td>The Lane Quality for a deleted lane is set to “Low Quality” in the GAD. All the mutations for the deleted lane are removed from the Mutation table.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> The Delete Lane option is available for a contig on both the Mutation table context menu and the Sample Trace name context menu. See “GAD analysis options” on page 91.</td>
</tr>
</tbody>
</table>
Chapter 2
Project Setup

### Undo Lane Deletion
The Lane Quality is reset to its original value in the GAD. All the mutations for the deleted lane are again displayed in the Mutation table.

**Note:** The Undo Lane Deletion option is available for a contig on both the Mutation table context menu and the Sample Trace name context menu. See "GAD analysis options" on page 91.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo Lane Deletion</td>
<td>The Lane Quality is reset to its original value in the GAD. All the mutations for the deleted lane are again displayed in the Mutation table.</td>
</tr>
<tr>
<td>Export Trace to Json</td>
<td>Saves the selected trace in JSON format.</td>
</tr>
</tbody>
</table>
Chapter 3  
Graphical Analysis Display

The Graphical Analysis Display visually presents mutation project data. A variety of options are available for working with the display, including options for analyzing and manipulating mutation project data so that you identify the true mutations in a mutation project.

This chapter covers the following topics:

• “Graphical Analysis Display Layout” on page 77.
• “Graphical Analysis Display Navigation and Analysis Options” on page 90.
• “Exporting the GAD” on page 94.
Graphical Analysis Display Layout

The Graphical Analysis Display (GAD) visually presents mutation project data in the Viewing and Reporting pane. A variety of options are available for working with the display, including options for analyzing and manipulating project data to identify the true mutations in a project. To open the display for a mutation project, do one of the following:

- Double-click a sample file in the Mutation report.
- Double-click a sample file in the Browser pane.
- Double-click a specific mutation in the Mutation report.

*Figure 3-1: Graphical Analysis Display in the Viewing and Reporting pane*

1 - Nucleotide Sequence frame
2 - Amino Acid frame
3 - Tracks frame
4 - Sample Traces frame
5 - Mutation table

The Graphical Analysis Display for any mutation project has up to five major components. Four of the five components—the Nucleotide Sequence frame, the Amino Acid frame, the Sample Traces frame, and the Mutation table—are always displayed for a Mutation Surveyor project. The fifth component, the Tracks frame, is displayed only if information has been imported from an annotation database for the project, and/or false positives and/or artifacts have been manually added to the project. From top to bottom, these components are:
Chapter 3
Graphical Analysis Display

- The Nucleotide Sequence frame. See “Nucleotide Sequence frame” below.
- The Amino Acid frame. See “Amino Acid frame” on page 79.
- The Tracks frame. See “Tracks frame” on page 79.
- The Sample Traces frame. See “Sample Traces frame” on page 79.
- The Mutation table. See “Mutation table” on page 83.

The settings that you specify on the output/display tabs of the Mutation Project Settings dialog box determine some of the information that is displayed in the GAD. If you modify a setting on an output/display tab and then click OK, the GAD is dynamically updated to reflect this change. (See “Modifying the Default Mutation Surveyor Project Settings” on page 52.) In addition, the Mutation Surveyor toolbar is dynamically updated with buttons that are specific for navigating and working with the GAD. (See “GAD Toolbar” on page 84.)

The following sections describe the GAD components for a 2D mutation project in which a GenBank file was used to create a synthetic reference file. There are slight differences for 1D projects, or for projects that did not use a GenBank file.

Nucleotide Sequence frame

The Nucleotide Sequence frame displays the GenBank file, the reference traces, and the sample traces as called bases.

*Figure 3-2: Nucleotide sequence frame*

From top to bottom in the frame, the rows display the following information:

- Position Information—The option that is selected on the Display tab of the Mutation Project Settings dialog box determines the information that is displayed in the first row. The positions within the GenBank file for the queried contig are displayed if Contig is selected. Chromosome number:chromosome positions are displayed if Chromosome is selected. The location of the queried gene (plus (+) or minus strand (-)) and the option that is selected for Automatically Adjust GenBank Direction on the Others tab determines the order (ascending or descending) in which this position information is displayed.

- The nucleotide sequence for the GenBank file. Within a CDS, the GenBank nucleotides are displayed in uppercase. Outside the coding region, the GenBank nucleotides are displayed in lowercase. If the gene is on the minus (-) strand and Orient GenBank Files in Gene Direction is selected for Automatically Adjust GenBank Direction, then the nucleotide sequence is also displayed upside down.

- The nucleotide sequence for the forward reference trace.
• The nucleotide sequence for the forward sample trace.
• The nucleotide sequence for the reverse sample trace.
• The nucleotide sequence for the reverse reference trace.

An asterisk indicates inconsistencies in base calls between traces. A black asterisk (*) indicates an inconsistency in sequence between a reference trace and a sample trace. A red asterisk (*) indicates an inconsistency in sequence between a reference trace and the GenBank file.

**Amino Acid frame**

The Amino Acid frame displays the codon number and the IUPAC abbreviation (unless 3 letter abbreviation setting is selected) for the corresponding amino acid sequence for the called bases that fall within a coding region in the GenBank sequence (the first line in the frame) and in the sample file (the second line in the frame). Any differences between the amino acid translations as the result of mutations in the sample file are therefore visible in this frame. The frame also shows the coding DNA reference index. Just like the Nucleotide Sequence frame, the location of the queried gene (plus (+) or minus strand (-)) and the option that is selected for Automatically Adjust GenBank Direction on the Others tab determines the order (ascending or descending) in which the codon numbers and c.dna numbers are displayed.

*Figure 3-3: Amino Acid frame*

**Tracks frame**

The Tracks frame is displayed only if information has been imported from an annotation database for the project, and/or false positives and/or artifacts have been manually added to the project. A reported single base variant at a specific chromosome position is indicated by a green tick mark. A reported variant that spans multiple bases at a specific chromosome position is indicated by a green horizontal line. You can place your cursor over a green tick mark or horizontal line to open a popup that displays detailed information for the reported variant.

*Figure 3-4: Tracks frame with mutation information displayed for a reported variant*

**Sample Traces frame**

The Sample Traces frame displays the traces for a selected sample grouped by direction.
From top to bottom, the forward reference trace, the forward sample trace, and the forward mutation trace are grouped together, and from bottom to top, the reverse reference trace, the reverse sample trace, and the reverse mutation trace are grouped together. The forward direction group is marked by a light blue vertical bar to the left of the group and the reverse direction group is marked by a light tan vertical bar to the left of the group. The trace name, the sequence direction, and the lane quality are displayed above each trace. If any comments have been added for a trace, they are also displayed above the trace. The location of the queried gene (plus (+) or minus strand (-)) and the option that is selected for Automatically Adjust GenBank Direction on the Others tab determines if the Reference trace is reverse complemented or not. The X-axis indicates the frame number and the Y-axis indicates peak intensity in Relative Fluorescence Units (RFU). The nucleotide numbering is from the 5’ end to the 3’ end on the forward trace and from the 3’ end to the 5’ end on the reverse trace. The following section identifies the different parts of the traces. In addition, the different types of peaks in the traces are identified with unique peak information. (See “Mutation trace legend” below and “Mutation trace peak identification” on page 82.)

**Figure 3-5: Reference traces, sample traces and mutation traces**

### Mutation trace legend

A peak in the mutation trace is called as a **mutation peak** when its height (in RFU) is greater than or equal to the value specified for the Mutation Height in the Mutation Project settings. (See “Mutation tab” on page 59.) A mutation peak appears in frame with the reference trace. The peak color indicates the called base for the mutation. (To see the color that is assigned to a specific base or group of bases in the mutation trace, click the Show Lines button on the GAD toolbar.)

Horizontal location bars run across the top of the mutation trace. The bar color indicates the location of the sequence that is being displayed in the trace.

- **Yellow**—Exon coding region
- **Pink**—Region of Interest (ROI)
- **Light tan**—Gene region
- **Light blue**—Primer region
• Green—Somatic (Mosaic) mutation

Somatic mutations are marked in the mutation trace only if you have selected the Check 2D Small Peaks (Mosaic) option for the mutation project settings. See “Display tab” on page 64.

• Red—Homozygous deletion or duplication. See “Mutation trace peak identification” below.

• Red with green arrows—Homozygous insertion. See “Mutation trace peak identification” below.

• Brown—Heterozygous insertion or deletion. See “Mutation trace peak identification” below.

Figure 3-6: Example of different colored Location bars in a mutation trace

Brown tick marks indicate reported variations in the GenBank file while tick marks of other colors indicate reported SNPs. Thick blue vertical bars define a comparison region, which is a region where the sample traces align to the reference traces, and all the mutation project analysis settings have been met, and therefore, mutations, with the exception of heterozygous indels, can be called in this region. (See “Mutation trace peak identification” below.)

If Display Negative SNPs is selected for the mutation project, you can zoom in on the tick marks in the mutation trace to see the involved bases. See “Display tab” on page 64.

Figure 3-7: Comparison region in mutation trace
Mutation trace peak identification

If all the criteria are met for a substitution mutation event, the values for mutation score, peak height, overlapping factor, and dropping factor are displayed on the peak.

*Figure 3-8: Substitution mutation event*

The *mobility line* is the horizontal line that runs through the center of the mutation trace. This line indicates the mobility of the sample trace relative to the reference trace—that is, by how much was the sample trace shifted so that the center of the peaks in the sample trace align to the center of the peaks in the reference trace. Typically, this line is green; however, the line changes color if an indel event is detected in the sample trace. If a *homozygous* deletion, duplication, or insertion event is detected in the sample trace, then the line is red. A positive peak in the mobility line spans a homozygous deletion event. A negative peak in the mobility line spans a homozygous duplication or insertion event.

*Figure 3-9: Homozygous deletion event*

*Figure 3-10: Homozygous duplication event*

*Figure 3-11: Homozygous insertion event*
If a heterozygous insertion or deletion event is detected in the sample trace, then the line is brown and a blue vertical line indicates that automatic mutation detection is not possible past the point of the event.

**Figure 3-12: Heterozygous mutation event**

The Mutation table is the last component in the GAD. The Mutation table displays all the mutation data for the currently opened trace. See “Modifying the Default Mutation Surveyor Project Settings” on page 52.

For a detailed explanation about the code in the Mutation field, see “Mutation Report” on page 127.

**Figure 3-13: Mutation table**

The color-coding for a substitution mutation event indicates a variety of information about the mutation:

- **Text color**—Blue text indicates that the mutation is called with high confidence. Red text indicates that the mutation is called with low confidence. (See “Mutation Threshold” on page 64.) Black text indicates that the mutation has been manually confirmed. (See “Confirm” on page 133.)
- **Purple background with green text**—A reported variation that was not found in the mutation project (Negative SNP).
- **Pink background**—A novel variant that results in a change to the amino acid sequence.
- **Purple background**—A reported variant that might or might not result in a change to the amino acid sequence.
- **Blue background**—A novel variant on the forward strand that does not result in a change to the amino acid sequence.
- **Tan background**—A novel variant on the reverse strand that does not result in a change to the amino acid sequence.
- **No background color**—A novel variant that is found in both directions that does not result
in a change to the amino acid sequence.

To view a mutation event in the mutation trace in the GAD, double-click the mutation in the table. If the mutation is a heterozygous indel, the Het-Indel tool also opens. See “To add or edit a heterozygous indel (The Het-Indel tool)” on page 331.

## GAD Toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open Files" /></td>
<td>Open Files—Opens the Open Files dialog box which you use to load GenBank files, references files and sample files for a project.</td>
</tr>
<tr>
<td><img src="image" alt="Save Project" /></td>
<td>Save Project—Saves all the project files to a single file mutation project file with an .sgp extension. You can open an entire project in a single step by opening this SGP file.</td>
</tr>
<tr>
<td><img src="image" alt="Raw Data to Processed Data" /></td>
<td>Raw Data to Processed Data—Enabled when AB1/ABI files without base call information are uploaded and Load Raw Data is selected for the Mutation Project settings. Converts the raw files so that base call information is displayed.</td>
</tr>
<tr>
<td><img src="image" alt="Run" /></td>
<td>Run—Runs the currently loaded project in Mutation Surveyor.</td>
</tr>
<tr>
<td><img src="image" alt="Restart" /></td>
<td>Restart—Opens the Options dialog box which you use to modify the current project settings. You can then run the project again using these new settings.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Browser" /></td>
<td>Show/Hide Browser—Shows/hides the Browser pane in the Mutation Surveyor main window. Also available on the Display menu (Display &gt; Browser).</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Nucleotides" /></td>
<td>Show/Hide Nucleotides—Shows/hides the Nucleotide Sequence frame in the GAD. Also available on the Display menu (Display &gt; Nucleotides).</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Amino Acids" /></td>
<td>- Show/Hide Amino Acids—Shows/hides the Amino Acid frame in the GAD. Also available on the Display menu (Display &gt; Amino Acids).</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Tracks" /></td>
<td>- Show/Hide Tracks—Shows/hides the Tracks frame in the GAD. Also available on the Display menu (Display &gt; Tracks).</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Mutation table" /></td>
<td>Show/Hide Mutation table—Shows/hides the Mutation table in the GAD. Also available on the Display menu (Display &gt; Peak table).</td>
</tr>
<tr>
<td><img src="image" alt="Show Lines" /></td>
<td>Show Lines—Provides options for:</td>
</tr>
<tr>
<td><img src="image" alt="Show All" /></td>
<td>- Show All—Shows all nucleotides in the sample traces and mutation traces.</td>
</tr>
<tr>
<td><img src="image" alt="Hide All" /></td>
<td>- Hide All—Hides all nucleotides in the sample traces and mutation traces.</td>
</tr>
<tr>
<td><img src="image" alt="Showing/hiding selected nucleotides" /></td>
<td>- Showing/hiding selected nucleotides in the sample traces and mutation traces.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Grid" /></td>
<td>- Show/Hide Grid—Hides the background grid in all sample traces and mutation traces.</td>
</tr>
<tr>
<td><img src="image" alt="Line Weight" /></td>
<td>- Line Weight—Adjusts the weight of traces from 1 to 4 times.</td>
</tr>
</tbody>
</table>

**Note:** If you select Hide Grid, you can still select Show All.
Chapter 3
Graphical Analysis Display

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Zoom In" /></td>
<td>Zoom In—Zooms in on the center of the GAD.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Out" /></td>
<td>Zoom Out—Zooms out from the center of the GAD.</td>
</tr>
</tbody>
</table>

**Note:** The GAD “remembers” all the Show/Hide settings that you last specified. Even if you close, and then reopen Mutation Surveyor, the Show/Hide settings remain the same for any project that you open.

| ![Select Reference File](image) | Select Reference File—Opens the Select Reference file dialog box in which you can select a different reference file to which to align samples traces in a contig. |
| ![Custom Report](image) | Custom Report—Opens the Custom Report Settings dialog box which you use to specify the settings for a custom report. See “Custom Report” on page 164. |
| ![Graphic Display](image) | Graphic Display—Opens the Graphic Display Report settings dialog box in which you specify the settings for generating a Graphic Display report. See “Graphic Display Report” on page 108. |
| ![GAD report](image) | GAD report—Prints the currently opened GAD in a report format. See “GAD Report” on page 114. |
| ![Display Mutations with 1D/2D Settings](image) | Display Mutations with 1D/2D Settings—Toggles the GAD between the 1D and 2D views. **Note:** With 1D setting selected, more low confidence mutation calls might be included in reports. |
| ![Detect Heterozygous Indels](image) | Detect Heterozygous Indels—Opens the Heterozygous Indel Detection window. See “To add or edit a heterozygous indel (The Het-Indel tool)” on page 331. |
| ![Save Base-Modified Samples](image) | Save Base-Modified Samples—Opens the Browser for Folder dialog box in which you can specify the directory in which to save modified traces. This button appears only after you edit a base call in a sample file or reference file. See “Edit Base” on page 93. |
| ![Re-process Modified Files](image) | Re-process Modified Files—Displayed only after you edit a base call in a sample file or reference file. Reprocesses the mutation project based on the modified files. See “Edit Base” on page 93. |
| ![Export GAD](image) | Export GAD—Exports selected GAD regions to a Word document, to JPG files, or directly to a printer. See “Exporting the GAD” on page 94. |
Search GenBank sequence

You use the Search function to search for a specific sequence or position in the GenBank file for the displayed project.

1. On the GAD toolbar, click the Search the GenBank Sequence icon.

The Search dialog box opens.

Figure 3-14: Search dialog box

2. In the Find field, enter the appropriate search string.

3. Under Options, indicate whether to search by sequence (the default value), or by position.

4. Optionally, if you select Search by Sequence, then to search by a reverse complement sequence, click Reverse Complement.

5. Click Previous or Next to search through the GenBank sequence in the Nucleotide Sequence frame.

Matching sequences or positions are highlighted in yellow.
Variation Tracks Settings dialog box

The Variation Tracks Settings dialog box contains the tracks settings for the Mutation table based on the variation databases that were imported for the project. (After being imported into Mutation Surveyor, a variation database is referred to as a track. See the Reference and Track Manager Tool User’s Manual. You can select what information to display for the tracks in the Annotation field, and you can filter the data that is displayed in the Mutation table based on the tracks, or you can choose not to filter the data based on any of the tracks.

1. On the GAD toolbar, click the Variation Tracks Settings icon.

   The Variation Tracks Settings dialog box opens. The Tracks pane is the left pane of the dialog box. The pane displays all the variation databases, or tracks, that were imported for the selected project.

   Figure 3-15:  Variation Tracks Settings dialog box, Filter Settings pane

2. If you do not want to filter the data for the project based on any of the tracks, then click Load Settings > Clear all track filters, and then click OK; otherwise, go to Step 3.

3. In the Tracks pane, select a track, and then do the following:
   a. Indicate the types of variants that are to be included in the Mutation report.
      • All - By default, all variants that meet all the filtering criteria are displayed in the Mutation report, whether they are included in the selected track.
      • Reported - Select Reported to display only those variants that meet all the filtering criteria and that are included in the selected track.
      • Unreported - Select Unreported to display only those variants that are not included in the selected track.
b. Specify the filter settings for the track.

   ![Mutation Tracks Settings dialog box, Report Display Settings pane](image)

   The available settings vary for each track.

   • Click Report Display to open the Report Display Settings dialog box.

   The Report Display Settings pane displays all the columns that can be included in the Annotation field of the Mutation table. By default, no columns are selected.

   Figure 3-16: Mutation Tracks Settings dialog box, Report Display Settings pane

4. Select the columns that are to be included in the Annotation field of Mutation table, and then optionally, select one or both of the following:

   • Display track group—Displays the track group in the Annotation field, for example, ClinVar for the ClinVar database.

   • Display track name—Displays the track name in the Annotation field. (This is the name that you assigned to the track during its import with the Track Manager tool. See the Reference and Track Manager Tool User’s Manual.

5. Click OK to close the Report Display Settings dialog box.

6. Repeat Step 3 through Step 5 for each track that is to be used to filter the Mutation table.

7. Do one of the following to save your settings and close the Variation Tracks Settings dialog box:

   • Click OK.

Going forward, the Mutation table is generated according to these saved settings until you change them.
• Save Settings > Save User Defaults, and then click OK.

The settings that you have specified for all the tracks are saved as your (the logged in user’s) default settings. Going forward, any new project that you run in Mutation Surveyor uses these settings by default. If you change the settings for a project, and want to generate the Mutation table display based on your default settings, then you can click Load Settings > Load User Defaults to restore your default settings.

• Save Settings > Save To File, and then click OK.

The settings that you have specified for all the tracks are saved to a Settings (.ini) file. Going forward, you can click Load Settings > Load From File to load this saved Settings file and generate the Mutation table display according to the settings in the file.
Graphical Analysis Display Navigation and Analysis Options

You can easily change the view in the GAD or navigate the GAD viewer using some of the toolbar icons (see “GAD Toolbar” on page 84) or your mouse and some keyboard hotkeys. Options are also available for analyzing mutation project data so that you identify the true mutations in a mutation project. Miscellaneous options are also available for manipulating the mutation project data so that you can work with the data in outside programs if needed.

GAD viewing and navigation options

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in</td>
<td>Click and hold the left mouse button and draw a box from the upper left hand corner of the pane towards the lower right hand corner. A box is formed around the area that being reduced for viewing.</td>
</tr>
</tbody>
</table>
| Zoom out                        | Click and hold the left mouse button and draw a box from the lower right hand corner of the pane towards the upper left hand corner.  
**Note:** The magnification for zooming out is always 100%.                                                                 |
| Moving an image in the GAD      | To move any image (frame or trace) in the GAD, right-click and hold the mouse button on the image, and then move the mouse.                                                                           |
| **Note:** The frames and traces are linked in the GAD. If you zoom in on a region in one of the frames or traces or zoom out from a region in one of the frames or traces, then this action is automatically duplicated in the same region in all the other frames and traces. If you move a frame or a trace, then all other frames and traces are moved to the same position as well.  |
| Moving to a mutation peak       | Press and hold the [Ctrl] key and then press:  
• F to move forward to the next mutation peak.  
• B to move back to the previous mutation peak.  
**Note:** You move to each mutation peak on a trace by trace basis. For example, if Sample Trace #1 has five mutation peaks, Sample Trace #2 has no mutation peaks, and Sample Trace #3 has one mutation peak, you must press CTRL+F five times to move to each mutation peak in the Sample Trace #1. When you press CTRL+F the 6th time, you move to the mutation peak in Sample Trace #3. |
| Moving to a trace               | Use the Browse function on the right side of the Traces component in the GAD to move to the next or previous trace.                                                                                |
GAD analysis options

Analysis options are available from the context menu for the Mutation table and from various context menus in the GAD. Any edit action (addition, substitution, or deletion) that you carry out for a mutation is displayed in the Actions column for the mutation in the Mutation table.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mutation table context menu analysis options</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Edit Comments</strong></td>
<td>You can manually add or edit comments for a mutation call.</td>
</tr>
<tr>
<td></td>
<td>• Right-click the entry for the mutation call on the Mutation table, and on the context menu that opens, click Edit Comments. You can add original comments in the Comments field, or you can select from a list of up to 200 customizable Comment templates.</td>
</tr>
<tr>
<td></td>
<td>• Right-click the entry for the mutation call on the Mutation table, and on the context menu that opens, click Edit. The Edit Substitution dialog box or the Edit Indel dialog box opens. Add comments in the Comments field in this dialog box.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>For detailed information about editing a mutation call, see Chapter 12, “Reviewing and Editing Mutation Projects,” on page 327.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Right-click the entry for the mutation in the Mutation table, and on the context menu that opens, click Edit. The Edit Substitution dialog box or the Edit Indel dialog box opens. Edit the mutation call as appropriate.</td>
</tr>
<tr>
<td><strong>Delete Mutation</strong></td>
<td>Right-click the entry for the mutation in the Mutation table, and on the context menu that opens, click Delete.</td>
</tr>
<tr>
<td></td>
<td>• Click the entry for the mutation in the Mutation table, and then click [Ctrl]-D.</td>
</tr>
<tr>
<td></td>
<td>• Press and hold the [Ctrl] key, and then right-click the mutation peak in the trace to open a Warning message about deleting the mutation call. Click OK in the message to delete the mutation call.</td>
</tr>
<tr>
<td></td>
<td>The text for the mutation code turns gray in the Mutation table. The comment &lt;&lt;Deleted&gt;&gt; is displayed in the Actions field in the Mutation table.</td>
</tr>
<tr>
<td><strong>Delete Mutation and Add to Database</strong></td>
<td>This action is available only when project meets all requirements for UKDB. Either click OK to delete the mutation without adding it to the User Knowledge database, or if the GenBank file that was used for the project contains chromosome information, then you can add the mutation to the User Knowledge database. (See “Creating a User Knowledge Database for Known Deletions” on page 342.)</td>
</tr>
<tr>
<td><strong>Undo Mutation Deletion</strong></td>
<td>Right-click the entry for the deleted mutation in the Mutation table, and on the context menu that opens, click Undo Mutation Deletion.</td>
</tr>
<tr>
<td></td>
<td>• Press and hold the [Ctrl] key, and then right-click the deleted mutation in the trace to open a Warning message about undoing the deletion of the mutation call. Click OK in the message to undo the deletion of the mutation call.</td>
</tr>
</tbody>
</table>
## Graphical Analysis Display

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Delete Lane</strong></td>
<td>Make sure that the appropriate trace is open in the GAD, and then right-click any entry in the Mutation table and on the context menu that opens, click Delete Lane.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The Lane Quality for a deleted lane is set to “Low Quality” in the GAD. All the mutations for the deleted lane are removed from the Mutation table.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The context menu for a contig in the Browser pane also has a Delete Lane option. See “Contig directory for a Mutation Surveyor project” on page 72.</td>
</tr>
<tr>
<td><strong>Undo Lane Deletion</strong></td>
<td>Make sure that the appropriate trace is open in the GAD, and then right-click on the trace’s title and on the context menu that opens, and click Undo Lane Deletion.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The Lane Quality for the lane is reset to its original value. All the mutations that were deleted for the lane are again displayed in the Mutation table.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The context menu for a contig in the Browser pane also has a UnDo Lane Deletion option. See “Contig directory for a Mutation Surveyor project” on page 72.</td>
</tr>
<tr>
<td><strong>Confirm/Undo Confirmation</strong></td>
<td>Right-click the entry for the mutation in the in the Mutation table, and on the context menu that opens, click the appropriate option.</td>
</tr>
<tr>
<td><strong>UnDo</strong></td>
<td>Undo the last edit action that was carried out for the mutation.</td>
</tr>
<tr>
<td><strong>View Edit History</strong></td>
<td>See “Viewing the Edit History (Audit Trail) for a Mutation” on page 344.</td>
</tr>
<tr>
<td><strong>Hyperlink to NCBI’s dbSNP</strong></td>
<td>Opens the NCBI’s database entry (via the web) for the variant.</td>
</tr>
</tbody>
</table>

### GAD context menu analysis options

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Delete Lane</strong></td>
<td>Make sure that the appropriate trace is open in the GAD, and then right-click the Sample Trace name, and on the context menu that opens, click Delete Lane.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The Lane Quality for a deleted lane is set to “Low Quality” in the GAD. All the mutations for the deleted lane are removed from the Mutation table.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The context menu for a contig in the Browser pane also has a Delete Lane option. See “Contig directory for a Mutation Surveyor project” on page 72.</td>
</tr>
<tr>
<td><strong>Undo Lane Deletion</strong></td>
<td>Make sure that the appropriate trace is open in the GAD, and then right-click the Sample Trace name, and on the context menu that opens, click Undo Lane Deletion.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The Lane Quality for the lane is reset to its original value. All the mutations that were deleted for the lane are again displayed in the Mutation table.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The context menu for a contig in the Browser pane also has a Undo Lane Deletion option. See “Contig directory for a Mutation Surveyor project” on page 72.</td>
</tr>
</tbody>
</table>
Chapter 3
Graphical Analysis Display

Miscellaneous GAD options

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Add Substitution Call| Right-click in the mutation trace at the position at which you want to add the substitution, and on the context menu that opens, click Add Substitution. The Add Substitution dialog box opens. Add the substitution as appropriate.  
**Note:** For detailed information about modifying a mutation call, see Chapter 12, “Reviewing and Editing Mutation Projects,” on page 327.  
**Note:** If you click a peak for a substitution mutation event, a message opens indicating that substitution already exists at the selected position and asking you if you want to replace it. Click OK to continue with the substitution.|
| Add Insertion/Deletion Call | Press and hold the [Ctrl] key, and then click the mobility line at the position of the indel. The Add Indel dialog box opens. Add the Indel call as appropriate.  
**Note:** For detailed information about modifying a mutation call, see Chapter 12, “Reviewing and Editing Mutation Projects,” on page 327. |
| Edit Base            | • Right-click a reference or sample trace and click Edit Base. A dialog box opens that displays the complete base sequence for the trace.  
• Click the base that you are editing and enter the text for the new base (A,C,G, or T.)  
• Click the Close button (“X”) to close the dialog box, and then click “Yes” at the prompt to save the base call changes.  
**Note:** If you do not want to override the original traces, you can save the modified traces to a different location. See Save Base-Modified Samples on page 85.  
• Click the Re-process Modified Files button to run the project with the modified sample and/or reference traces. |
| Copy Sequence        | Right-click a reference or sample trace and click Copy Sequence. The base calls for the portion of the trace that is in view will be copied to the clipboard. |
Chapter 3
Graphical Analysis Display

Exporting the GAD

You use the Export GAD function to export mutation traces and other information for selected mutations to a Word document, to separate JPG files, or directly to a printer.

A variety of graphic-based reports that present part or all the GAD in a report format are also available in Mutation Surveyor. See Chapter 4, “Mutation Surveyor Graphical Reports,” on page 97.

Figure 3-17: Export GAD dialog box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td></td>
</tr>
<tr>
<td>Output the Current Mutation Only</td>
<td>Exports the GAD for only those mutations (+16 bp) that are currently displayed in the GAD for the selected sample file.</td>
</tr>
<tr>
<td>Output the Mutations in the Samples</td>
<td>Exports the GADs for all the mutations in all the sample files for every contig.</td>
</tr>
<tr>
<td>Output Points of Interest</td>
<td>Exports the GAD only for the specified base positions. (The Base position must be the contig position where at least one sample contains a mutation call at the point of interest.)</td>
</tr>
<tr>
<td></td>
<td>• If Output the Mutations in the Samples is also selected, then images are captured for not only all mutation calls, but also for positive and negative mutations at all Points of Interest.</td>
</tr>
<tr>
<td></td>
<td>• If Output the Mutations in the Samples is not selected, then images are captured for only positive and negative mutations at all Points of Interest.</td>
</tr>
</tbody>
</table>
### Chapter 3

**Graphical Analysis Display**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Header Information</td>
<td>Automatically populated with the default Mutation Surveyor header information file. You can click the Browse button to open the Open File dialog box, and browse to and select a custom header to add to the report. <strong>Note:</strong> A header is a .inf file. For a discussion of Custom headers and how to create one, see “Print Header Editor Tool” on page 267.</td>
</tr>
<tr>
<td>Save the Word File As</td>
<td>Available only if Save the Report as a Word file is the selected action. Automatically populated with the default location (c:\data) and filename for the Word file to which the mutations traces for the selected mutations are being exported. You can click the Browse button to open the Save As dialog box, and specify a different location, name, or both for the Word files. <strong>Note:</strong> This function works only when Microsoft Word is installed on the client computer. If the client's copy of Word has additional add-ons, such as End Note, installed, this function might not work properly.</td>
</tr>
<tr>
<td>Save separate JPG files into</td>
<td>Available only if Saving Report as Separate JPG Files is the selected action. Automatically populated with the default location (c:\data) to which the mutation traces for the selected mutations are being exported. You can click the Browse button to open the Browse for Folder dialog box, and specify a different location for the JPG files.</td>
</tr>
</tbody>
</table>

### Action

- **Save the Report as a Word File**
  - Exports all the mutation traces to a single Word file.
- **Send the Report Directly to the Printer**
  - Exports the files to directly to the system’s default printer
- **Save the Report as Separate JPG Files**
  - Export each mutation trace as a separate JPG file

### Nomenclature

- **Genomic**
  - Displays the mutation call positions based on the genomic position referenced in the GenBank file.
- **Relative to CDS**
  - Displays the mutation call positions relative to the CDS numbering in the GenBank reference file. A mutation that is called in the CDS is prefixed with “c.” A mutation that is called in a non-coding region is prefixed with “IVS.” Its position is identified by the closest nucleotide in the coding sequence plus or minus the number of bps by which it resides away from the closest nucleotide.
- **Relative to mRNA**
  - Displays the mutation call positions relative to the mRNA numbering in the GenBank reference file. A mutation that is called in the mRNA region is prefixed with a “c.” A mutation that is called outside of an mRNA region is identified by the closest nucleotide in the mRNA region plus or minus the number of bps by which it resides away from the closest nucleotide.
### Option (cont’d)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HGVS</strong></td>
<td>Displays the mutation call positions relative to its position in the coding sequence. A mutation that is called in a non-coding region is identified by the closest nucleotide in the coding sequence plus or minus the number of bps by which it resides away from the closest nucleotide. Both alleles are shown in separate bracketed statements.</td>
</tr>
</tbody>
</table>

**Note:** For any of the four standard Nomenclature options, if a GenBank file was not loaded as the reference file, then the Base Number is enclosed in parenthesis and it indicates the position of the base in the reference file. If both a GenBank file and a reference file were loaded for the mutation project and the mutation was called at a position that does not align to the GenBank file, then the Base Number is enclosed in parenthesis and is displayed as +/- the number of base pairs by which the mutation was shifted in comparison to the GenBank file.
Chapter 4
Mutation Surveyor Graphical Reports

A variety of graphic-based reports that provide detailed information about a mutation project are available in Mutation Surveyor. All these reports, which are available from the Display option on the Mutation Surveyor main menu, present part or all the GAD in a report format. All these reports rely heavily on the use of colored legends to indicate critical information about the mutation project data. You can print the information in many of these reports and you can save and store the report information for use at a later date.

This chapter covers the following topics:

• “Project Reviewer Report” on page 99.
• “Graphic Display Report” on page 108.
• “GAD Report” on page 114.
• “Clinical Report” on page 116.
• “Nucleotide Text Display Report” on page 120.
Project Reviewer Report

You use the Project Reviewer report to view mutation project data for one contig at a time, or for all contigs at the same time. The data that you can view includes the reference nucleotide sequence, the consensus sequence for all the sample traces, the sequence for each sample trace, and all the mutation calls for all the samples. You can use the Project Reviewer functions to customize the viewing of this information for your sample files. For example, you can use the Sample Grouping function to group all your sample files by an identifier and view any overlapping contigs that result. You can also use the Project Reviewer to edit mutation calls.

Figure 4-1: Project Reviewer report

Project Reviewer report layout

To view the color coding legends that are used in the report, click Legend at the top of the report. The report displays mutation project data according to these legends in four panes.

- Sample pane—The Sample pane is the top left pane. This pane lists all the sample files that are contained in the currently selected contig.
- Base pane—The Base pane is the top center pane. The top row of numbers indicates the genomic base position in the GenBank file. The color of the horizontal location bars that run below the genomic position numbers indicates the location of the sequence that is being displayed in the trace. Colored tick marks indicate reported variations. The first row of nucleotides in the pane is the GenBank nucleotide sequence. The second row of
nucleotides in the pane is the consensus sequence for the sample traces. The remaining rows show the sequence for each sample trace. A black dash (-) indicates a match between the reference file and the sample file. If a different base is at the same position in the sample file and reference file, then the standard IUB/IUPAC code for the base is shown in the sample file at the position. Color-coding is used to indicate the mutation type. No information is displayed for areas that fall outside the comparison region. A gray square indicates a mutation that has been deleted either by Mutation Surveyor or by a user.

- **Trace pane**—The Trace pane is the top right pane. This pane displays the sample traces, the mutation traces, or both for all the selected samples in the sample and base panes. Blue highlighted bases indicate positions of called mutations.

- **Mutation Table pane**—The Mutation Table pane is the lower pane. This pane displays all the mutation calls for all the samples in the selected contig. The mutation call codes and color-coding that are used in this table are identical to the mutation call codes and color-coding that are used in the Mutation standard report. See “Mutation Report” on page 127.

The report is interactive:

- To zoom in on a selected region for the sample files, in the Base pane, click and hold the left mouse button and draw a box from the upper left hand corner of the region towards the lower right hand corner of the region. A box is formed around the area that is being reduced for viewing.

- To zoom in on a selected region for a trace, in the Trace pane, click and hold the left mouse button and draw a box from the upper left hand corner of the region towards the lower right hand corner of the region. A box is formed around the area that is being reduced for viewing.

- To zoom out from the sample files or trace, click and hold the left mouse button and draw a box from the lower right hand corner of the file sequence or trace towards the upper left hand corner of the sequence or trace. The magnification for zooming out is always 100%.

---

**By default, the Base pane and Trace pane are linked in the Project Reviewer. If you zoom in on a region in one of the panes or zoom out from a region in one of the panes, then this zooming action is automatically duplicated in the same region in the other pane. You can turn off this automatic linking. See “Project Reviewer report toolbar” on page 102.**

- To change the view in the reviewer to a selected mutation, double-click the mutation in the Mutation Table pane.

- To change the view to that for a different contig, select the contig on the Contig dropdown list.

---

**If you select All, then any overlap among the contigs is displayed in the Base pane and in the Trace pane**
To manipulate and analyze mutation project data, right-click a mutation call in the Mutation Table pane and on the context menu that opens, click the appropriate option.

**Figure 4-3: Mutation Table pane context menu**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application. <strong>Note:</strong> You can also copy the Project Reviewer report as an image. Press and hold the [Shift] key and the [Ctrl] key, and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.</td>
</tr>
</tbody>
</table>
Chapter 4
Mutation Surveyor Graphical Reports

Project Reviewer report toolbar

The Project Reviewer report toolbar contains buttons that are specific for navigating and working with the Project Reviewer report. The buttons that are displayed on the toolbar depend on whether a single contig is selected or all contigs are selected.

**Figure 4-4:**  Project Reviewer report toolbar for a selected contig

**Figure 4-5:**  Project Reviewer report toolbar for all contigs

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Edit   | Opens the Edit Substitution or Edit Indel dialog box in which you can edit the selected mutation call.  
  **Note:** For detailed information about modifying a mutation call, see Chapter 12, “Reviewing and Editing Mutation Projects,” on page 327. |
| Delete | Deletes the selected mutations.  
  **Note:** SHIFT-click to select multiple contiguous mutations.  
  The text for the mutation code turns gray in both the Project Reviewer report and the Mutation Table pane. |
| Undo Deletion | Reverses the deletion of the selected mutation.  
  **Note:** SHIFT-click to select multiple contiguous mutations. |
| Delete Mutation and Add to Database | Deletes the selected mutation and adds it to the database. |
| Delete Lane | Deletes all the mutations for a selected sample in a single step. The Lane Quality for a deleted lane is set to “Low Quality.”  
  **Note:** SHIFT-click to select multiple contiguous samples. |
| Undo Deletion | Reverses the deletion of the selected lane.  
  **Note:** SHIFT-click to select multiple contiguous samples. |
| Confirm | Confirms the selected mutations. The text for the mutation code turns black in both the Project Reviewer report and the Mutation Table pane.  
  **Note:** SHIFT-click to select multiple contiguous mutations. |
| Undo Confirmation | Removes the “Confirmed” status for the mutation.  
  **Note:** SHIFT-click to select multiple contiguous mutations. |
| Hyperlink to NCBI’s dbSNP | Opens the NCBI’s database entry (via the web) for the variant. |

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Sample Trace</td>
<td>Selected by default. Shows the sample traces in the Trace pane.</td>
</tr>
</tbody>
</table>
### Button Description

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Show Mutation Trace" /></td>
<td>Show Mutation Trace—Selected by default. Shows the mutation traces in the Trace pane.</td>
</tr>
<tr>
<td><img src="image" alt="Link" /></td>
<td>Link—Selected by default. Links the Base pane and the Trace pane. If you zoom in on a region in one of the panes or zoom out from a region in one of the panes, then this zooming action is automatically duplicated in the same region in the other pane. You can turn off this automatic linking.</td>
</tr>
</tbody>
</table>
| ![Sample Grouping](image) | Sample Grouping—Opens the Sample Grouping dialog box in which you can specify how sample traces are to be grouped in the report. **Figure 4-6: Sample Grouping dialog box**  

- From Character [ ] To Character [ ]—Select this option if all the filenames in your project contain the same character string/designator in the same positions.  
- From File—Select this option if traces that are to be grouped together contain a common Sample ID in their filenames. (The Sample IDs do not need to be in the same location in the filename.) After you click From File, click Load Sample ID to open the Load Sample ID dialog box and specify the different Sample IDs, such as Patient #, by which to group the traces. You can also click Open in the Load Sample ID dialog box to load an existing Sample ID text file.  

**Note:** By default, the Load Sample ID dialog box contains rows for up to ten different Sample IDs. You can right-click and click Insert or Delete as needed. |
| ![Move Left/Move Right](image) | Move Left/Move Right—Moves the display in the Base pane and Trace pane in the indicated direction. |
| ![Report Settings](image) | Report Settings—Opens the Project Reviewer Report Settings dialog box, in which you can specify what information is to be displayed in the report, what color-coding is to be used in the report, and what nomenclature is to be used in the report. See “Project Reviewer Report Settings dialog box” on page 104. |
| ![Save as JPG](image) | Saves current view as a JPG file. |
| ![Show/Hide Sample](image) | Show/Hide Sample—Shows/hides the Sample pane. |
| ![Show/Hide Annotation](image) | Show/Hide Annotation—Shows/hides the gene/CDS annotation in the Base pane and the Trace pane. |
Chapter 4  
Mutation Surveyor Graphical Reports

Project Reviewer Report Settings dialog box

The Project Reviewer Report Settings dialog box contains four tabs—Mutation, Color, Nomenclature, and Display—on which you can specify what information is to be displayed in the report, what color-coding is to be used in the report, what nomenclature is to be used in the report, and how many traces to view together, respectively.

Figure 4-7:  Project Reviewer Report Settings dialog box, Mutation tab

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Show/Hide Base" /></td>
<td>Shows/hides the Base pane.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Trace" /></td>
<td>Shows/hides the Trace pane.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Mutation Table" /></td>
<td>Shows/hides the Mutation Table pane.</td>
</tr>
<tr>
<td><img src="image" alt="Add GenBank File" /></td>
<td>Available only if All contigs are selected. If you used SEQ files as reference files, click the this button to open the Add GenBank file dialog box and select a GenBank to add to the project. The Project Reviewer then aligns the SEQ files to the GenBank and as a result, the SEQ files are displayed in genomic order.</td>
</tr>
</tbody>
</table>

Mutation tab

The majority of options on this tab are self-explanatory, and therefore, not all these options are discussed in this section.

- Nucleotide Position—Nucleotide positions are displayed in the nomenclature that you select on the Nomenclature tab. (See “Nomenclature tab” on page 106.)
- Amino Acid Position—By default, amino acid information is organized with the reference amino acid displayed first, the amino acid position displayed next, and the mutation amino acid displayed last. If you do not select Amino Acid Position, then a slash (/) is displayed between the reference amino acid and the mutation amino acids.
• Confidence(!)—Displays a Confidence mark (!) for mutation calls that exceed certain thresholds as defined in the MutationSurveyor.ini file.

Although you can modify these thresholds, SoftGenetics does not recommend that you do so on your own. Contact SoftGenetics for assistance.

• Comments—Displays all comments that were added to a mutation call, either automatically by Mutation Surveyor or manually by a user.

Color tab

Figure 4-8: Project Reviewer Report Settings dialog box, Color tab

The Color tab provides a variety of color-coding options to assist you with identifying different types of mutation calls and potential analysis problems. Color-coding is applied according to the following:

• If a mutation call meets several color-coding criteria, the call is displayed in the report in the color of highest priority.

• If None is selected for a color-coding option, then the color of the next highest priority is used.

• For Mutation Region Text color-coding, the priorities from highest to lowest are as follows—Deleted, Confirmed, Added, Edited, High Confidence, Low Confidence, Normal Alleles, and Not Available.

• For Mutation Region Background color coding, priorities from highest to lowest are as follows—Mosaic, Reported, A.A. Change, Indel, Synonymous, Heterozygous, Homozygous, and Not Available, where Synonymous identifies the coding and non-coding substitutions that do not affect the amino acid sequence.
**Nomenclature tab**

*Figure 4-9:  Project Reviewer Report Settings dialog box, Nomenclature tab*

If you select Nucleotide positions on the Mutation tab, then the positions are displayed in the nomenclature that you select on the Nomenclature tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genomic</td>
<td>Displays the mutation call positions based on the genomic position referenced in the GenBank file.</td>
</tr>
<tr>
<td>Relative to CDS</td>
<td>Displays the mutation call positions relative to the CDS numbering in the GenBank reference file. A mutation that is called in the CDS is prefixed with a &quot;c.&quot; A mutation that is called in a non-coding region is prefixed with &quot;IVS.&quot; Its position is identified by the closest nucleotide in the coding sequence plus or minus the number of bps by which it resides away from the closest nucleotide.</td>
</tr>
<tr>
<td>Relative to mRNA</td>
<td>Displays the mutation call positions relative to the mRNA numbering in the GenBank reference file. A mutation that is called in the mRNA region is prefixed with a &quot;c.&quot; A mutation that is called outside of an mRNA region is identified by the closest nucleotide in the mRNA region plus or minus the number of bps by which it resides away from the closest nucleotide.</td>
</tr>
<tr>
<td>HGVS</td>
<td>Displays the mutation call positions relative to its position in the coding sequence. A mutation that is called in a non-coding region is identified by the closest nucleotide in the coding sequence plus or minus the number of bps by which it resides away from the closest nucleotide. Both alleles are shown in separate bracketed statements.</td>
</tr>
<tr>
<td>Forensic (SWGDAM)</td>
<td>Displays the mutation call using SWGDAM Guidelines.</td>
</tr>
</tbody>
</table>

**Note:** If any of the five standard Nomenclature options is selected and a GenBank file was not loaded as the reference file, then the Base Number is enclosed in parenthesis and it indicates the position of the base in the reference file. If both a GenBank file and a reference file were loaded for the mutation project and the mutation was called at a position that does not align to the GenBank file, then the Base Number is enclosed in parenthesis and is displayed as +/- the number of base pairs by which the mutation was shifted in comparison to the GenBank file.
Mutation Surveyor Graphical Reports

Figure 4-10:  **Nomenclature Examples**

<table>
<thead>
<tr>
<th>Substitution</th>
<th>Genomic</th>
<th>Relative to CDS</th>
<th>Relative to mRNA</th>
<th>HGVS</th>
<th>Forensic (SWGDAM)</th>
</tr>
</thead>
<tbody>
<tr>
<td>non-coding</td>
<td>379C&gt;T</td>
<td>c.28-24C&gt;T</td>
<td>c.28-24C&gt;T</td>
<td>c.28-24C&gt;T</td>
<td>C073T</td>
</tr>
<tr>
<td>coding</td>
<td>77A&gt;T</td>
<td>c.31A&gt;T</td>
<td>c.31A&gt;T</td>
<td>c.31A&gt;T</td>
<td>A77T</td>
</tr>
<tr>
<td>coding</td>
<td>80C&gt;CA</td>
<td>c.34C&gt;CA</td>
<td>c.34C&gt;CA</td>
<td>c.34C&gt;CA</td>
<td>C080M</td>
</tr>
<tr>
<td>non-coding</td>
<td>531delT</td>
<td>c.794+1delT</td>
<td>c.794+1delT</td>
<td>c.794+1delT</td>
<td>211d</td>
</tr>
</tbody>
</table>
| coding       | 10_20delT | c.72_74delTTT   | c.72_74delTTT   | c.72_74delTTT | 15D,194,388d |}

**Display tab**

Select the number of traces to display in the Trace Pane. Default is 4. A maximum of 8 can be selected.

**Figure 4-11:  Project Reviewer Report Settings dialog box, Display tab**

![Project Reviewer Report Settings dialog box, Display tab](image-url)
Chapter 4  
Mutation Surveyor Graphical Reports

**Graphic Display Report**

You use the Graphic Display report to examine sample alignment and mutation calls for a single contig. The Graphic Display report is available from the Display option on the Mutation Surveyor main menu or you can click the Graphic Display icon \( \equiv \) on the GAD. After you select either option, the Graphic Display Report Settings dialog box opens. You specify the options in this dialog box, and then click OK to generate the report. (See Figure 4-13 on page 109.)

*Figure 4-12: Graphic Display Report Settings dialog box*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reject 1D Calls When Other Direction has No Call</td>
<td>Reject a mutation that is called in only one direction when the position falls within the comparison region of the other direction.</td>
</tr>
<tr>
<td>Reject 1D Calls When Other Direction is Not Available</td>
<td>Reject mutation calls that occur outside the region where the sample traces in both directions are aligned within the comparison region.</td>
</tr>
<tr>
<td>Reject Synonymous Mutations</td>
<td>Coding region substitutions that do not affect amino acid calls are not displayed in the report.</td>
</tr>
<tr>
<td>Display Mutations with the “Stop” Codon or Indel Only</td>
<td>Display only nonsense mutations and indels in the report.</td>
</tr>
<tr>
<td>Display Confirmed Mutations Only</td>
<td>Display only those mutations that you have manually confirmed in the report.</td>
</tr>
</tbody>
</table>
Graphic Display report layout

The top row of the Graphic Display report details the color coding legends that are used in the report. The report displays mutation project data below these legends in four panes. From top to bottom, these panes are as follows:

- **GenBank pane**—The GenBank pane displays information about the loaded GenBank file. Contig positions are indicated in kilobases (kb). The color of the horizontal *location bars* that run below the contig position numbers indicates the location of the sequence that is being displayed in the trace. Colored tick marks indicate reported variations.

- **Reference pane**—The Reference pane displays information about the reference trace that was used for the selected contig. The trace can be a reference file that you manually added to the project, or it can be a synthetic reference file that Mutation Surveyor created from the loaded GenBank file.

- **Sample pane**—The Sample pane displays all the sample files that are contained within the selected contig. Tick marks represent called mutations. Color-coding is used to indicate the mutation type.

- **Allele Frequency pane**—The Allele Frequency pane shows the percentage of samples in the contig that have the mutation call at the indicated position.

- **Mutation Score pane**—The Mutation Score pane shows the average mutation score for all the calls at the indicated position for the contig.
Chapter 4  
Mutation Surveyor Graphical Reports

The report is interactive:

• To zoom in on a selected region, in any pane, click and hold the left mouse button and draw a box from the upper left hand corner of the region towards the lower right hand corner of the region. A box is formed around the area that is being reduced for viewing.

• To zoom out from any region, click and hold the left mouse button and draw a box from the lower right hand corner of the region towards the upper left hand corner of the region. The magnification for zooming out is always 100%.

All the panes in the Graphic Display are linked. If you zoom in on a region in any pane, or zoom out from a region in any pane, then this zooming action is automatically duplicated in the same regions in all the other panes.

• To change the view to that for a different contig, select the contig on the Contig dropdown list.

• By default, the filenames for all the files (GenBank, reference files, and sample files) are displayed on the report. To remove the filenames from the report display, clear the Show Filenames option.

Graphic Display report toolbar

The Graphic Display report toolbar contains buttons that are specific for navigating and working with the Graphic Display report.

Figure 4-14:  Graphic Display report toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Print Preview](image) | Print Preview—Opens the Graphic Display Print Preview window, which displays a preview of what is to be printed for the report.  
**Note:** Before you print the Graphic Display report, make sure to adjust the zoom level so that the area of the report that you want to print is displayed in the report window. |
| ![Report Settings](image) | Report Settings—Opens the Graphic Display Report Settings dialog box, in which you can specify what information is to be displayed in the report. See Figure 4-12 on page 108. |
| ![Project Display Report](image) | Project Display Report—Opens the Project Display Report Settings dialog box, in which you specify the information that is to be displayed in the Project Display subreport, as well as how the sample files are to be grouped in the subreport. See "Project Display subreport" on page 111. |
| ![Show Filenames](image) | Selected by default. Shows the filenames on the report. |
Project Display subreport

You use the Project Display subreport as another way of graphically viewing mutation project data. Options are available for filtering mutation calls that are displayed in the report and for grouping sample files based on the character string/designator that is used in your sample filenames. This subreport, which has a layout that is almost identical to that of the Graphic Display report, is ideal for comparing overlapping sample traces that were analyzed in separate contigs. The subreport opens after you click OK in the Project Display Report Settings dialog box.

*Figure 4-15: Project Display Report Settings dialog box*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mutation Scores</strong></td>
<td></td>
</tr>
<tr>
<td>Reject 1D Calls When Other Direction has No Call</td>
<td>Reject a mutation that is called in only one direction when the position falls within the comparison region of the other direction.</td>
</tr>
<tr>
<td>Reject 1D Calls When Other Direction is Not Available</td>
<td>Reject mutation calls that occur outside the region where the sample traces in both directions are aligned within the comparison region.</td>
</tr>
<tr>
<td>Reject Synonymous Mutations</td>
<td>Coding region substitutions that do not affect amino acid calls are not displayed in the report.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>In cases where the entire column was not omitted from the report because of rejection by one of these criteria, the rejected mutations have no background color and an &quot;n.a.&quot; is displayed in the Mutation cell instead of the mutation code.</td>
</tr>
<tr>
<td><strong>Display Mutations with the “Stop” Codon or Indel Only</strong></td>
<td>Display only nonsense mutations and indels in the report.</td>
</tr>
<tr>
<td><strong>Display Confirmed Mutations Only</strong></td>
<td>Display only those mutations that you have manually confirmed in the report.</td>
</tr>
</tbody>
</table>
Chapter 4
Mutation Surveyor Graphical Reports

Chapter 4
Mutation Surveyor Graphical Reports

Figure 4-16: Project Display subreport

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Homozygous Dropping Threshold</td>
<td>Indicates the value for the dropping factor at which a mutation is identified as either a homozygous substitution or a heterozygous substitution. For example, is a mutation A&gt;C or A&gt;AC? Because Mutation Surveyor evaluates the traces rather than the base calls, noise below a major peak can sometimes be interpreted as a heterozygous substitution. This value assists in your analysis by converting these calls to homozygous substitutions. You can increase this value to view the exact call that Mutation Surveyor made, but an increased value might result in some calls remaining as heterozygous substitutions.</td>
</tr>
<tr>
<td>Sample Grouping</td>
<td>Specify the filename substring by which Mutation Surveyor groups all the mutation project samples files in the subreport.</td>
</tr>
<tr>
<td></td>
<td>• n-Primer (n-D) Text Input—Use the ND Grouping file to group the sample files. See “ND Filename Match Editor Tool” on page 264.</td>
</tr>
<tr>
<td></td>
<td>• Filename Match (based on one of the following):</td>
</tr>
<tr>
<td></td>
<td>• From Character [ ] To Character [ ]—If all the filenames in your project contain the same characters/designator in the same positions, then select this option and enter the starting and ending character positions.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Typical Block—If all the filenames in your project contain the same characters/designator but in different positions, then select this option and enter the value for the character/designator block.</td>
</tr>
</tbody>
</table>

Figure 4-16: Project Display subreport
Chapter 4
Mutation Surveyor Graphical Reports

Project Display subreport toolbar

The Project Display subreport toolbar contains options and buttons that are specific for navigating and working with the subreport.

Figure 4-17: Project Display subreport toolbar

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select GenBank File</td>
<td>If your mutation project used multiple GenBank files, then select one of these files from this list to view the file and the sample files that align to it.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Print Preview—Opens the Preview window, which displays a preview of what it to be printed for the report.</td>
</tr>
<tr>
<td>Note: Before you click the Print Preview button, make sure to adjust the zoom level so that the area of the report that you want to print will be displayed in the Preview window.</td>
<td></td>
</tr>
<tr>
<td>Modify Mutation Projects</td>
<td>Modify Mutation Projects—See &quot;Modifying Mutation Surveyor Projects&quot; on page 315.</td>
</tr>
<tr>
<td>Show Filenames</td>
<td>By default, the filenames for all the files (GenBank, reference files, and sample files) are displayed on the subreport. To remove the filenames from the report display, clear the Show Filenames option.</td>
</tr>
<tr>
<td>Exact Filename Match</td>
<td>Select this option to pair sample files in the report display when the filenames for the forward and reverse sample files are very similar.</td>
</tr>
<tr>
<td>Note: This sorting option is used in conjunction with the sorting options that you specified on the Project Display Report Settings dialog box to further group sample files in the report display.</td>
<td></td>
</tr>
</tbody>
</table>
GAD Report

The GAD report displays the Graphical Analysis Display (GAD) for the sample files that are contained in a single contig in a report format. You can specify whether the report is to display all the traces for all the sample files in the contig, or whether the report is to display only those traces for the sample files that contained mutation calls (the default setting for the report). After you click GAD Report on the Display menu, the GAD Report Settings dialog box opens. You can leave the default option of Print Samples with Mutations Only selected, or you can clear this option to display all the traces for all the sample files for a selected contig in the report. After you click OK, the GAD report opens.

Figure 4-18: GAD Report Settings dialog box

Figure 4-19: GAD report

The first two traces that are displayed in the report are the forward and reverse reference traces used for the selected contig. (The names of the traces are displayed in brown font to indicate that they are reference traces.) The remaining traces are the traces for the sample files in the selected contig. The traces are either the traces for all the sample files that are contained in the selected contig, or they are those traces for display the trace regions for only those samples in the selected contig that contain mutation calls. To view the traces for a different contig, select the contig on the Contig dropdown list.
GAD Report toolbar

The GAD report toolbar contains options and buttons that are specific for navigating and working with the report.

**Figure 4-20: GAD report toolbar**

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample</td>
<td>Indicates the sample for which the sample traces are currently in view for the report. You can select a different sample from the list, or you can use the Scroll feature on the right side of the report window to change the view.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Zooms in on a region of the report for viewing.</td>
</tr>
<tr>
<td>Note:</td>
<td>You can also manually zoom in on a region for viewing. Click and hold the left mouse button and draw a box from the upper left hand corner of the pane towards the lower right hand corner. A box is formed around the area that is being reduced for viewing.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out from a region of the report for viewing. The magnification for zooming out is always 100%.</td>
</tr>
<tr>
<td>Note:</td>
<td>You can also manually zoom out from a region for viewing. Click and hold the left mouse button and draw a box from the lower right hand corner of the pane towards the upper left hand corner.</td>
</tr>
<tr>
<td>Move Left</td>
<td>Moves the currently displayed report view to the left.</td>
</tr>
<tr>
<td>Note:</td>
<td>You can also manually move the report view to the left. Right-click and hold the mouse button on the report view, and then move the mouse.</td>
</tr>
<tr>
<td>Move Right</td>
<td>Moves the currently displayed report view to the right.</td>
</tr>
<tr>
<td>Note:</td>
<td>You can also manually move the report view to the left. Right-click and hold the mouse button on the report view, and then move the mouse.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Opens the Preview window, which displays a preview of what it to be printed for the GAD report. You can use the options on the Preview window’s toolbar to adjust variables such as the color scale and the page layout before you print the report.</td>
</tr>
<tr>
<td>Note:</td>
<td>Before you click the Print Preview button, make sure to adjust the zoom level so that the area of the report that you want to print will be displayed in the Preview window.</td>
</tr>
<tr>
<td>Print Samples with Mutations Only</td>
<td>Select this option to display only those traces for the sample files that contained mutation calls.</td>
</tr>
<tr>
<td>Show Mutation Information</td>
<td>Select this option to display the code for each mutation call on the report. The code for each call is displayed directly above the mutation peak in the sample trace.</td>
</tr>
</tbody>
</table>
The Clinical report is a custom-formatted report that contains options for displaying only those sample files with mutation calls or for displaying all positions with reported annotation information, including negative SNPs. The report shows one pair of sample files in a contig per page, and the report includes the mutation code for each called mutation. To generate a Clinical report, modify any of the settings as needed and click OK. The report opens in the Print Preview window. You can use the options on the Preview window’s toolbar to adjust variables such as the color scale and the page layout. See Figure 4-23 on page 119.

The Clinical Report Settings dialog box opens.

**Figure 4-21: Clinical Report Settings dialog box**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Samples with mutations only</td>
<td>Show only those samples that contain called mutations.</td>
</tr>
<tr>
<td>Print Samples with negative mutations</td>
<td>Show those samples that contain negative mutation calls, where a negative SNP is defined as position in the GenBank file at which a variation has been reported, but no variation was detected at the same position in the sample trace. Sample traces that have negative SNPs might still contain mutation calls.</td>
</tr>
<tr>
<td>Header File</td>
<td>Click the Browse button to open the Open File dialog box, and browse to and select a custom header to add to the report. Note: A header is a .inf file. For a discussion of Custom headers and how to create one, see “Print Header Editor Tool” on page 267.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Nomenclature</td>
<td>• Genomic—Displays the mutation call positions based on the genomic position referenced in the GenBank file.</td>
</tr>
<tr>
<td></td>
<td>• Relative to CDS—Displays the mutation call positions relative to the CDS numbering in the GenBank reference file. A mutation that is called in the CDS is prefixed with a “c.” A mutation that is called in a non-coding region is prefixed with “IVS.” Its position is identified by the closest nucleotide in the coding sequence plus or minus the number of bps by which it resides away from the closest nucleotide.</td>
</tr>
<tr>
<td></td>
<td>• Relative to mRNA—Displays the mutation call positions relative to the mRNA numbering in the GenBank reference file. A mutation that is called in the mRNA region is prefixed with a “c.” A mutation that is called outside of an mRNA region is identified by the closest nucleotide in the mRNA region plus or minus the number of bps by which it resides away from the closest nucleotide.</td>
</tr>
<tr>
<td></td>
<td>• HGVS—Displays the mutation call positions relative to its position in the coding sequence. A mutation that is called in a non-coding region is identified by the closest nucleotide in the coding sequence plus or minus the number of bps by which it resides away from the closest nucleotide. Both alleles are shown in separate bracketed statements.</td>
</tr>
<tr>
<td>Trace Display Range &lt;&gt; bp</td>
<td>Total number of bases in range of mutation call, with call centered in this range. The value can be an integer from 1 to 255. The default value is 20.</td>
</tr>
<tr>
<td>Mutation Calls per Line</td>
<td>Maximum number of mutation calls that would be displayed in a single row of the report. Options are:</td>
</tr>
<tr>
<td></td>
<td>• 1</td>
</tr>
<tr>
<td></td>
<td>• 2 (Default value)</td>
</tr>
<tr>
<td>Lines per Page</td>
<td>Maximum number of lines of mutation calls that would be displayed on a single page of the report. If a trace contains more than would fit on a single page, the report would include additional pages. Options are:</td>
</tr>
<tr>
<td></td>
<td>• 1</td>
</tr>
<tr>
<td></td>
<td>• 2 (Default value)</td>
</tr>
<tr>
<td>Show Reference Electrophogram</td>
<td>Option to display the bases of reference trace at the location of the mutation call. This option is selected by default.</td>
</tr>
<tr>
<td>Show Sample Electrophogram</td>
<td>Option to display the bases of the sample trace at the location of the mutation call. This option is selected by default.</td>
</tr>
<tr>
<td>Show Mutation Electrophogram</td>
<td>Option to display the peaks of the mutation trace at the location of the mutation call. This option is selected by default.</td>
</tr>
<tr>
<td>Show Axes Values</td>
<td>Option to display or hide the y-axis labels and gridlines. This option is unavailable for 3 mutation calls per line. This option is deselected by default.</td>
</tr>
<tr>
<td>Show Date and Title</td>
<td>Option to display or hide the current date/time and the first order grouping type at the top of report's heading section. This option is deselected by default.</td>
</tr>
<tr>
<td>Show Trace File Name</td>
<td>Option to display each trace's file name of its image. This option may not be available for 2 lines per page, depending on electropherograms to be displayed. This option is deselected by default.</td>
</tr>
</tbody>
</table>
Chapter 4
Mutation Surveyor Graphical Reports

Grouping—Traces are initially grouped based on the 1st Order Grouping option. Further sorting is then carried out based on the 2nd Order Grouping option, and then on the 3rd Order Grouping option.

- **Contig**
  - The default value for 1st Order. Groups are sorted based on the Contigs that Mutation Surveyor created for determining mutation calls.

- **Trace**
  - When Trace is selected, the From Character X to Y option is enabled. Traces are sorted into groups based on character matching in the specified positions in the trace filenames.

- **Grouping File**
  - Traces are sorted into groups based on the grouping method that is specified in the Load Grouping text file. See "2D Filename Match Editor tool" on page 261.

- **Sample ID**
  - When Sample ID is selected, both the Load Sample ID button and the From Character X to Y option are enabled. Click Load Sample ID to open the Load Sample ID dialog box and specify the different Sample IDs, such as Patient #, by which to group the traces. You can also click Open to load an existing Sample ID file.
  
  **Note:** By default, the Load Sample ID dialog box contains rows for up to ten different Sample IDs. You can right-click and click Insert or Delete as needed.

  ![Load Sample ID dialog box](image)

  The traces that are to be grouped together must contain at least one of these Sample IDs in their filenames but they do not need to be in the same location in the filename. When grouping by Sample ID, the trace filenames are first checked based on the Sample IDs defined in the Load Sample ID dialog box. The values specified in the From Character X to Y fields are ignored if all the trace filenames contain at least one of these Sample IDs. Traces that do not contain any of these Sample IDs in their filenames are sorted into groups based on the values specified in the From Character X to Y fields. Traces that do not contain any of these Sample IDs and that do not contain the characters specified in the From Character X to Y fields are sorted into their own group.

- **F/R pairing**
  - The default value for the 2nd Order. Places two-directional traces in adjacent rows.
Figure 4-23:  Clinical report
Chapter 4
Mutation Surveyor Graphical Reports

Nucleotide Text Display Report

The Nucleotide Text Display report is a color-coded report of the text base calls of all the sample file sequences for a selected contig. The report has options for displaying every nucleotide position for every sample trace in a selected contig or for displaying only those nucleotide positions at which a mutation was called. To generate a Nucleotide Text Display report, do the following:

1. On the Display menu, click Nucleotide Text Display.

   The Nucleotide Text Display Report Settings dialog box opens.

*Figure 4-24:  Nucleotide Text Display Report Settings dialog box*

2. Select the options as appropriate for your report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Base Call</td>
<td>Display the bases as called in the original sample trace at locations where variations exist between the sample and the reference.</td>
</tr>
<tr>
<td>Consensus Base Call</td>
<td>Display the base relative to the mutation call at locations where mutation calls were identified.</td>
</tr>
<tr>
<td>Display Base Call</td>
<td>Selected by default. Display every nucleotide position for every sample trace in a selected contig. If you clear this option, then only the variations relative to the Original Base Call or the Consensus Base Call are displayed for the sample trace in the selected contig.</td>
</tr>
</tbody>
</table>

3. Click OK.

   The Nucleotide Text Display report opens. See Figure 4-25 on page 121.
Nucleotide Text Display report layout

The top row of the Nucleotide Text Display report details the color coding legends that are used in the report. The color of the horizontal location bars indicates the location of the sequence that is being displayed in the trace. Colored tick marks indicate reported variations. The report displays mutation project data below these legends in three panes. From left to right these panes are:

- **Filenames pane**—The first row in the Filenames pane is the name of the reference nucleotide sequence that was used to align the sample files. The second row in the Filenames pane is the consensus sequence for the sample traces. The remaining rows in the pane shows the name for each reference and sample trace contained in the selected contig.
- **Direction pane**—The Direction pane shows the trace direction for the reference sequence, for the consensus sequence, and for each sample trace for the selected contig.
- **Nucleotide Text pane**—The Nucleotide Text pane shows the textual representation of the reference sequence, the consensus sequence, and for each sample trace contained in the selected contig.

The report is interactive:

- To view the nucleotide text display for a different contig, select the contig on the Contig dropdown list.
- To view the mutation electropherograms for sample files at a given mutation position, double-click the mutation in the report. The Contig Trace Figure window opens. (See Figure 4-26 on page 122.) You can use the Scroll function on this window to scroll through all the sample traces at the selected mutation position. Each mutation call is highlighted with either a blue or purple vertical line, for novel or reported variants.
respectively.

Figure 4-26:  Contig Trace Figure window

These last two options work best after you have zoomed in on a region in the Nucleotide Text pane for viewing. See the Zoom In function on the “Nucleotide Text Display report toolbar.”

Nucleotide Text Display report toolbar

The Nucleotide Text Display report toolbar contains options and buttons that are specific for navigating and working with the report.

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Save Report icon]</td>
<td>Opens the Save Report As dialog box in which you can specify a name and location for saving the report as a tab-delimited text file.</td>
</tr>
</tbody>
</table>
Chapter 4
Mutation Surveyor Graphical Reports

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Preview—Opens the Preview window, which displays a preview of what it to be printed for the Nucleotide Text Display report. You can use the options on the Preview window’s toolbar to adjust variables such as the color scale and the page layout before you print the report. <strong>Note:</strong> Before you click the Print Preview button, make sure to adjust the zoom level so that the area of the report that you want to print will be displayed in the Preview window.</td>
<td></td>
</tr>
<tr>
<td>Show/Hide Filenames—Shows/hides the Filenames pane.</td>
<td></td>
</tr>
<tr>
<td>Show/Hide Direction—Shows/hides the Direction pane.</td>
<td></td>
</tr>
<tr>
<td>Zoom In—Zooms in on a region of the report for viewing. <strong>Note:</strong> You can also manually zoom in on a region for viewing. Click and hold the left mouse button and draw a box from the upper left hand corner of the pane towards the lower right hand corner. A box is formed around the area that being reduced for viewing.</td>
<td></td>
</tr>
<tr>
<td>Zoom Out—Zooms out from a region of the report for viewing. The magnification for zooming out is always 100%. <strong>Note:</strong> You can also manually zoom out from a region for viewing. Click and hold the left mouse button and draw a box from the lower right hand corner of the pane towards the upper left hand corner.</td>
<td></td>
</tr>
<tr>
<td>Move Left—Moves the currently displayed report view to the left. <strong>Note:</strong> You can also manually move the report view to the left. Right-click and hold the mouse button on the report view, and then move the mouse.</td>
<td></td>
</tr>
<tr>
<td>Move Right—Moves the currently displayed report view to the right. <strong>Note:</strong> You can also manually move the report view to the left. Right-click and hold the mouse button on the report view, and then move the mouse.</td>
<td></td>
</tr>
<tr>
<td>Report Settings—Opens the Nucleotide Text Display Report Settings dialog box in which you can specify the information that is to be displayed in the report. See Figure 4-24 on page 120.</td>
<td></td>
</tr>
<tr>
<td>Amino Acid</td>
<td>Select this option to display the amino acid sequence for which the consensus sequence codes. The code is displayed in the top row of the Nucleotide Text pane as the 1 Letter IUPAC code.</td>
</tr>
<tr>
<td>Consensus Sample</td>
<td>Displays the consensus sequence for each of the sample pairs. An extra line marked as “Consensus Sample” is displayed below the sample pairs in all three of the report panes.</td>
</tr>
</tbody>
</table>
Chapter 5
Mutation Surveyor Standard Reports

A variety of text-based standard reports that provide detailed information about a mutation project are available in Mutation Surveyor. All these reports, which are available from the Reports option on the Mutation Surveyor main menu, display mutation project data according to a predefined format. You can print the report information and you can save and store the report output for use at a later date.

This chapter covers the following topics:

• “Mutation Report” on page 127.
• “Two Direction Report” on page 134.
• “Advanced Two Direction Report” on page 140.
• “Project Report” on page 146.
• “HGVS Report” on page 157.
Chapter 5
Mutation Surveyor Standard Reports
Mutation Surveyor User’s Manual

Chapter 5

Mutation Surveyor Standard Reports

Mutation Report

Mutation Surveyor aligns the nucleotide sequences of the sample traces to the reference traces and groups the sample traces into contigs based on their degree of overlap. The reference traces and sample traces are then compared at a trace by trace level to identify substitutions, insertions, and deletions. All the variants are aligned in the Mutation report, which is automatically displayed in the Viewing and Reporting pane after the project is run. In addition, the Mutation Surveyor toolbar is updated with buttons that are specific for working with the Mutation report.

You can also open the Mutation report from the Mutation Surveyor main menu (Reports > Mutation Report), or you can double-click the Mutation Report entry in the Browser pane.

Mutation Surveyor toolbar

Figure 5-1: Mutation Surveyor toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Files—Opens the Open Files dialog box which you use to load GenBank files, references files and sample files for a project.</td>
<td></td>
</tr>
<tr>
<td>Save Project—Saves all the project files to a single file mutation project file with an .sgp extension. You can open an entire project in a single step by opening this SGP file.</td>
<td></td>
</tr>
<tr>
<td>Raw Data to Processed Data—Enabled when AB1/ABI files without base call information are uploaded and Load Raw Data is selected for the Mutation Project settings. Converts the raw files so that base call information is displayed.</td>
<td></td>
</tr>
<tr>
<td>Run—Runs the currently loaded project in Mutation Surveyor.</td>
<td></td>
</tr>
<tr>
<td>Restart —Opens the Options dialog box which you use to modify the current project settings. You can then run the project again using these new settings.</td>
<td></td>
</tr>
<tr>
<td>Show/Hide Browser—Shows/hides the Browser pane in the Mutation Surveyor main window.</td>
<td></td>
</tr>
<tr>
<td>Save Report—Opens the Save Report As dialog box in which you can specify the location for saving the Mutation report as a .txt file.</td>
<td></td>
</tr>
</tbody>
</table>
### Chapter 5

#### Mutation Surveyor Standard Reports

**Figure 5-2 shows the default Mutation report in the Viewing and Reporting pane.**

**Figure 5-2: Mutation report**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Graphic Display" /></td>
<td>Opens the Graphic Display Report settings dialog box in which you specify the settings for generating a Graphic Display report. See &quot;Graphic Display Report&quot; on page 108.</td>
</tr>
<tr>
<td><img src="image" alt="Display Mutations with 1D/2D Settings" /></td>
<td>Toggles the Mutation report between the 1D and 2D views.</td>
</tr>
<tr>
<td><img src="image" alt="Show Nucleotide Text" /></td>
<td>Generates a Nucleotide Text Display report. See &quot;Nucleotide Text Display Report&quot; on page 120.</td>
</tr>
<tr>
<td><img src="image" alt="Quantify" /></td>
<td>Opens the Mutation Quantification function. See &quot;Mutation Quantifier Function&quot; on page 303.</td>
</tr>
</tbody>
</table>

**Note:** After being imported into Mutation Surveyor, a variation database is referred to as a *track*.

### Mutation report fields

The table below summarizes the default fields that are displayed in the Mutation report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample File</td>
<td>A list of all the sample traces in the mutation project, including any unmatched traces.</td>
</tr>
<tr>
<td>Reference File</td>
<td>The reference trace to which the sample trace was matched.</td>
</tr>
<tr>
<td>Direction</td>
<td>The contig number and the direction of the trace (Forward (F) or Reverse (R)).</td>
</tr>
<tr>
<td>Gene</td>
<td>The gene name as noted in the GenBank reference file.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Sample File</th>
<th>Reference File</th>
<th>No</th>
<th>Gene</th>
<th>Icon</th>
<th>RIF</th>
<th>Start</th>
<th>End</th>
<th>Size</th>
<th>Qual/Num</th>
<th>Mutation</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>BRCA1.012484.11R.1.x_2007.1</td>
<td>BRCA1.11R.D.11.R.0.1</td>
<td>2</td>
<td>87786</td>
<td>31007</td>
<td>250</td>
<td>11</td>
<td>1</td>
<td>378/4691</td>
<td>11/12/1</td>
<td></td>
</tr>
</tbody>
</table>

17  | BRCA1.11R.D.11.R.0.1 | BRCA1.11R.D.11.R.0.1 | 2   | 87786 | 31007 | 250 | 11 | 1 | 378/4691 | 11/12/1 |

18  | BRCA1.11R.D.11.R.0.1 | BRCA1.11R.D.11.R.0.1 | 2   | 87786 | 31007 | 250 | 11 | 1 | 378/4691 | 11/12/1 |

19  | BRCA1.11R.D.11.R.0.1 | BRCA1.11R.D.11.R.0.1 | 2   | 87786 | 31007 | 250 | 11 | 1 | 378/4691 | 11/12/1 |

20  | BRCA1.11R.D.11.R.0.1 | BRCA1.11R.D.11.R.0.1 | 2   | 87786 | 31007 | 250 | 11 | 1 | 378/4691 | 11/12/1 |

21  | BRCA1.11R.D.11.R.0.1 | BRCA1.11R.D.11.R.0.1 | 2   | 87786 | 31007 | 250 | 11 | 1 | 378/4691 | 11/12/1 |

22  | BRCA1.11R.D.11.R.0.1 | BRCA1.11R.D.11.R.0.1 | 2   | 87786 | 31007 | 250 | 11 | 1 | 378/4691 | 11/12/1 |

23  | BRCA1.11R.D.11.R.0.1 | BRCA1.11R.D.11.R.0.1 | 2   | 87786 | 31007 | 250 | 11 | 1 | 378/4691 | 11/12/1 |

24  | BRCA1.11R.D.11.R.0.1 | BRCA1.11R.D.11.R.0.1 | 2   | 87786 | 31007 | 250 | 11 | 1 | 378/4691 | 11/12/1 |

25  | BRCA1.11R.D.11.R.0.1 | BRCA1.11R.D.11.R.0.1 | 2   | 87786 | 31007 | 250 | 11 | 1 | 378/4691 | 11/12/1 |

26  | BRCA1.11R.D.11.R.0.1 | BRCA1.11R.D.11.R.0.1 | 2   | 87786 | 31007 | 250 | 11 | 1 | 378/4691 | 11/12/1 |

27  | BRCA1.11R.D.11.R.0.1 | BRCA1.11R.D.11.R.0.1 | 2   | 87786 | 31007 | 250 | 11 | 1 | 378/4691 | 11/12/1 |

28  | BRCA1.11R.D.11.R.0.1 | BRCA1.11R.D.11.R.0.1 | 2   | 87786 | 31007 | 250 | 11 | 1 | 378/4691 | 11/12/1 |
Chapter 5
Mutation Surveyor Standard Reports

To change the fields that are displayed in the Mutation report, select or clear the appropriate options for the Output Table Fields on the Output tab on the Mutation Project Options dialog box. (See “Output tab” on page 62.)

Mutation report codes

The mutation code is the unique code that identifies each mutation in the sample trace. The code format indicates whether the mutation is a substitution event or whether it is an insertion/duplication or deletion event.

Substitution mutation code

The mutation code for a substitution event has four components—the base number, the mutation, the amino acid sequence that is affected by the mutation, and the mutation score.

Figure 5-3: Example of a substitution mutation code

- Base Number—If a GenBank file was loaded, the Base Number is the contig position in the GenBank file. If a GenBank file was not loaded, then the Base Number is enclosed in parenthesis and it indicates the position of the base in the reference file. If both a GenBank file and a reference file were loaded for the mutation project and the mutation was called at a position that does not align to the GenBank file, then the Base Number is enclosed in parenthesis and is displayed as +/- the number of base pairs by which the mutation was shifted in comparison to the GenBank file.
Chapter 5
Mutation Surveyor Standard Reports

Figure 5-4: Mutation called at a position that does not align to GenBank file

- **Mutation**—The mutation is written as reference base > variant base, where the *reference base* represents the base called at the position in the reference trace and the *variant base* represents the base called at the position in the sample trace. The mutation can be *homozygous*, such as A > C, or the mutation can be *heterozygous*, such as A > AC.

- **Amino Acid**—If the mutation falls within the coding region of the GenBank file, the amino acid portion of the mutation code shows the codon number, the normal amino acid that is affected by the mutation, and the resulting amino acid.

- **Mutation Score**—The mutation score is the 1D score for the mutation. See “Mutation Score” on page 59.

Figure 5-5: Example of a mutation code for a homozygous mutation

```
293G>C$34
```

The mutation code indicates that the mutation is on the 293rd base. The base “C” has been substituted for the base “G.” The mutation score is 34.

Figure 5-6: Example of a mutation code for a heterozygous mutation

```
462G>AG, 75M>M/I$67
```

The mutation code indicates that the mutation is on 462nd base of the GenBank file. The bases “A” and “G” have been substituted for the base “G.” The codon number is 75. The normal amino acid is “M” and the amino acid that is produced as the result of this mutation is a mixture of the normal amino acid and the mutant amino acid “I.” The mutation score is 67.

**Color codes**
The color of a substitution mutation code indicates a variety of information about the mutation.

- **Text color**—Blue text indicates that the mutation is called with high confidence. Red text indicates that the mutation is called with low confidence. (See “Mutation Threshold” on page 64.) Black text indicates that the mutation has been manually confirmed. (See “Confirm” on page 133.)

- **Purple background with green text**—A reported variation that was not found in the mutation project.

- **Pink background**—The mutation is a novel variant that results in a change to the amino acid sequence.

- **Purple background**—The mutation is a reported variant that might or might not result in
a change to the amino acid sequence.

- No background color—The mutation is a novel variant that is found on either the forward or reverse trace and that does not result in a change in the amino acid sequence.

### Insertion, duplication, and deletion mutation codes

Mutation Surveyor monitors the mobility of a sample fragment relative to the reference. When the sequences no longer align, Mutation Surveyor continues to attempt alignment until it again occurs. If a homozygous insertion or duplication event is detected, Mutation Surveyor artificially gaps the reference trace. If a homozygous deletion event is detected, Mutation Surveyor artificially gaps the sample trace. If a heterozygous insertion or deletion event is detected, Mutation Surveyor automatically deconvolutes the mixed trace into two clean traces.

**Figure 5-7:** Example of a mutation code for a homozygous insertion event

```
23_24insTAC
Indicates the insertion of three bases—T, A, and C—between bases 23 and 24.
```

**Figure 5-8:** Example of a mutation code for a homozygous duplication event

```
21_23dupTAC
Indicates the insertion of three bases—T, A, and C—between bases 23 and 24, where the preceding bases (21 through 23) are also T, A, and C.
```

**Figure 5-9:** Example of a mutation code for a homozygous deletion event

```
65_68delTGCA
Indicates the deletion of four bases—T, G, C, and A—between bases 65 through 68.
```

**Figure 5-10:** Example of a mutation code for a heterozygous insertion event

```
98_99het_insTAG
Indicates the deletion of three bases—T, A, and G—between bases 98 and 99.
```
Chapter 5
Mutation Surveyor Standard Reports

Figure 5-11: Example of a mutation code for a heterozygous duplication event

1316het_dupT

Indicates the insertion of one base - T - between bases 1316 and 1317, where the preceding base (1316) is also T.

Figure 5-12: Example of a mutation code for a heterozygous deletion event

123_127het_delCCTGA

Indicates the heterozygous deletion of five bases—C, C, T, G, and A—between bases 123 through 127.

Mutation report viewing and analysis options

A context menu is available for the Mutation report. You use the options on this menu to change the view of the Mutation report and to manipulate and analyze mutation project data so that you identify the true mutations in a mutation project. To open the context menu, right-click anywhere in the Mutation report.

Figure 5-13: Mutation report context menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shrink</td>
<td>Fit the complete Mutation report in the Viewing and Reporting pane.</td>
</tr>
<tr>
<td>Expand</td>
<td>Expand all columns in the Mutation report to their default widths.</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Sort</td>
<td></td>
</tr>
<tr>
<td>Confirm</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Undo Confirmation</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Delete Lane</td>
<td></td>
</tr>
<tr>
<td>Undo Lane Deletion</td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td>View Edit History</td>
<td></td>
</tr>
<tr>
<td>Hyperlink to NCBI's dbSNP</td>
<td></td>
</tr>
</tbody>
</table>

Note: You might need to Browse the Viewing and Reporting pane to view the entire report.
Chapter 5
Mutation Surveyor Standard Reports

You can also view the information for a mutation in the Mutation report in the GAD. To open the GAD for the trace that contains a mutation, double-click the mutation in the report.

If you click a trace in the GAD with the Mutation report open, the GAD is brought to the front. To bring the Mutation report to the front again, press [CTRL]-T.
Two Direction Report

The Two Direction report is automatically generated after you click Reports > Two Direction Report on the Mutation Surveyor main menu. The Two Direction report shows mutation information organized by paired sample traces. The fields that are displayed by default in the report and the color coding of the mutation calls in the report are identical to the default fields and color coding in the Mutation report. (See “Mutation report fields” on page 128 and “Color codes” on page 130.) Also, just like the Mutation report, you can change the fields that are displayed in the report by selecting or clearing the appropriate options on the Output tab on the Mutation Project Options dialog box. (See “Output tab” on page 62.) Figure 5-14 shows the default Two Direction report. The report opens in a window that is separate from the Viewing and Reporting pane.

Figure 5-14: Two Direction report

Two Direction report layout

The Two Direction report provides the same general information as the Mutation report with the following exceptions:

- Forward and reverse samples traces are paired next to each other in the report based on the contig in which they were found. Alternating colors of light blue and light tan are used to differentiate the sample pairs.

- Mutations are grouped in the report based on their position in the contig. For a position that shows a mutation call for some of the sample traces:
  - The Mutation # cell is blank for other sample traces that do not show a mutation at this position in the aligned region.

Sample traces that do not show a mutation at a position in the aligned region.

Sample traces that show the mutation at a position, but is filtered due to report settings, or the position is outside the aligned region.

Allele frequency
• “n.a.” is displayed in the Mutation # cell for other sample traces that show the mutation at this position, but is filtered due to report settings, or the position is outside the aligned region.

• A row below each group of paired sample files shows the sum of all sizes in the contig, the average lane quality, and the allele frequency (as a percentage).

Two Direction report toolbar

The Two Direction report toolbar contains buttons that are specific for working with the report and for changing the information that is displayed in the report.

Figure 5-15: Two Direction report toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Copy]</td>
<td>Copy—Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.</td>
</tr>
<tr>
<td>![Save Report]</td>
<td>Save Report—Opens the Save Report As dialog box in which you can specify a name and location for saving the report as well as its format (.txt, .xls/.xlsx, .xml, or .htm).</td>
</tr>
<tr>
<td>![Report Settings]</td>
<td>Report Settings—Opens the Two Direction Report Settings dialog box which contains options for filtering the information that is to be displayed in the report. See “Two Direction report settings” on page 136.</td>
</tr>
<tr>
<td>![Advanced Two Direction Report]</td>
<td>Advanced Two Direction Report—Opens the Advanced Two Direction Report Settings dialog box which contains options for filtering the information that is to be displayed in the report. It also contains options for specifying the formatting of the mutation code in the report. See “Advanced Two Direction Report” on page 140.</td>
</tr>
<tr>
<td>![Undo Latest Deletions]</td>
<td>Undo Latest Deletions—Restores the deletion that you last carried out in the Two Direction report. Allows for multiple undos.</td>
</tr>
<tr>
<td>![Lock Sample File in View]</td>
<td>Lock Sample File in View—Freezes the Sample Filename column while scrolling.</td>
</tr>
</tbody>
</table>

Mutation Surveyor User’s Manual 135
Two Direction report mutation codes

The mutation codes that are used in the Two Direction report are identical to the codes that are used in the Mutation report with one exception—by default, the substitution mutation code also indicates the Dropping Factor and Overlapping Factor for the mutation call.

*Figure 5-16: Substitution mutation code in Two Direction report*

30988A>AG,356Q>Q/R$22,0$54,1.00

To prevent one or both of these values from being displayed in the mutation code, open the Two Direction Report Settings dialog box (see “Two Direction report settings” on page 136) and clear the appropriate options.

Two Direction report viewing and analysis options

The Two Direction report has multiple options available for changing the view of the report and for manipulating and analyzing mutation project data. These options are:

- The Two Direction report settings. See “Two Direction report settings” below.
- The Two Direction report context menu. See “Two Direction report context menu” on page 137.

Two Direction report settings

To open the Two Direction Report Settings dialog box, click the Report Settings button on the Two Direction report toolbar.

*Figure 5-17: Two Direction Report Settings dialog box*
Chapter 5  
Mutation Surveyor Standard Reports

Two Direction report context menu

A context menu is available for the Two Direction report. You use the options on this menu to change the view of the Two Direction report and to manipulate and analyze mutation project data so that you identify the true mutations in a mutation project. To open the context menu, right-click anywhere in the Two Direction report.

**Figure 5-18: Two Direction report context menu**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Homozygous Dropping Threshold</td>
<td>Indicates the value for the dropping factor at which a mutation is identified as either a homozygous substitution or a heterozygous substitution. For example, is a mutation A&gt;C or A&gt;AC? Because Mutation Surveyor evaluates the traces rather than the base calls, noise below a major peak can sometimes be interpreted as a heterozygous substitution. This value assists in your analysis by converting these calls to homozygous substitutions. <strong>Note:</strong> You can increase this value to view the exact call that Mutation Surveyor made, but an increased value might result in some calls remaining as heterozygous substitutions.</td>
</tr>
<tr>
<td>Display the Mutations Deleted by the Software</td>
<td>By default, mutations that are deleted automatically by Mutation Surveyor are displayed in gray text in the Two Direction report. Clear this option to remove these mutation calls from the report display.</td>
</tr>
<tr>
<td>Display Mutations Deleted by the User</td>
<td>By default, mutations that are deleted by a user are displayed in gray text in the Two Direction report. Clear this option to remove these mutation calls from the report display.</td>
</tr>
<tr>
<td>Display Dropping Factor</td>
<td>By default, the substitution mutation code in the Two Direction report indicates the Dropping factor for the mutation call. Clear this option to remove this value from the mutation code.</td>
</tr>
<tr>
<td>Display Overlapping Factor</td>
<td>By default, the substitution mutation code in the Two Direction report indicates the Overlapping factor for the mutation call. Clear this option to remove this value from the mutation code.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application. <strong>Note:</strong> You can also copy the Two Direction report as an image. Press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.</td>
</tr>
<tr>
<td>Confirm</td>
<td>Confirms the selected mutations. <strong>Note:</strong> SHIFT-click to select multiple contiguous mutations or to select all mutations in a column. The text for the mutation code turns black in both the Two Direction report and the Mutation table in the GAD. The comment &lt;&lt;Checked&gt;&gt; is displayed in the Actions field for the mutation call in the Mutation table in the GAD.</td>
</tr>
<tr>
<td>Undo Confirmation</td>
<td>Removes the “Confirmed” status for the mutation. <strong>Note:</strong> SHIFT-click to select multiple contiguous mutations or to select all mutations in a column.</td>
</tr>
<tr>
<td>Sort By Score (Descending)</td>
<td>Click the appropriate option to sort the all the data by descending mutation score or ascending mutation score.</td>
</tr>
<tr>
<td>Sort by Score (Ascending)</td>
<td></td>
</tr>
<tr>
<td>Delete Mutations</td>
<td>Deletes the selected mutations. <strong>Note:</strong> SHIFT-click to select multiple contiguous mutations, to select all mutations in a column, or to select multiple rows. The text for the mutation code turns gray in both the Two Direction report and the Mutation table in the GAD. The comment &lt;&lt;Deleted&gt;&gt; is displayed in the Actions field for the mutation call in the Mutation table in the GAD. <strong>Note:</strong> To undo the last deletion that you carried out, click the Undo Latest Deletions button on the report toolbar.</td>
</tr>
<tr>
<td>Delete Lane</td>
<td>Deletes all the mutations for a selected sample in a single step. The Lane Quality for a deleted lane is set to “Low Quality.”</td>
</tr>
<tr>
<td>Undo Lane Deletion</td>
<td>The Lane Quality for the lane is reset to its original value.</td>
</tr>
<tr>
<td>Undo</td>
<td>Undo the last edit action that was carried out for the mutation.</td>
</tr>
<tr>
<td>View Edit History</td>
<td>See “Viewing the Edit History (Audit Trail) for a Mutation” on page 344.</td>
</tr>
<tr>
<td>Hyperlink to NCBI’s dbSNP</td>
<td>Opens the NCBI’s database entry (via the web) for the variant.</td>
</tr>
</tbody>
</table>
You can also view the information for a mutation in the Two Direction report in the GAD. To open the GAD for the trace that contains a mutation, double-click the mutation in the report.

If you click a trace in the GAD with the Two Direction report open, the GAD is brought to the front. To bring the Two Direction report to the front again, press [CTRL]-T.
Advanced Two Direction Report

Like the Two Direction report, the Advanced Two Direction report shows mutation information organized by paired sample traces. Also, the layout of the Advanced Two Direction report is identical to the layout of the Two Direction report. (See “Two Direction report layout” on page 134.) The Advanced Two Direction report, however, has different settings for changing the mutation information that is displayed in the report.

The fields that are displayed by in the report, the mutation codes, and the color coding of the mutation calls in the report are identical to the fields, mutation codes, and color coding in the Mutation report (See “Mutation report fields” on page 128, “Mutation report codes” on page 129, and “Color codes” on page 130.) Just like the Mutation report and the Two Direction report, you can change the fields that are displayed in the report by selecting or clearing the appropriate options on the Output tab on the Mutation Project Options dialog box. (See “Output tab” on page 62.)

1. To open the Advanced Two Direction report, do one of the following:

   • Click the Advanced Two Direction Report button on the Two Direction report toolbar.

The Advanced Two Direction Report Settings dialog box opens.

Figure 5-19: Advanced Two Direction Report Settings dialog box
2. Accept the default settings for the report, or make any changes as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mutation Scores</strong></td>
<td></td>
</tr>
<tr>
<td>Reject 1D Calls When Other Direction has No Call</td>
<td>Reject a mutation that is called in only one direction when the position falls within the comparison region of the other direction.</td>
</tr>
<tr>
<td>Reject 1D Calls When Other Direction is Not Available</td>
<td>Reject mutation calls that occur outside the region where the sample traces in both directions are aligned within the comparison region.</td>
</tr>
<tr>
<td>Reject Synonymous Mutations</td>
<td>Coding region substitutions that do not affect amino acid calls are not displayed in the report.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>In cases where the entire column was not omitted from the report because of rejection by one of these criteria, the rejected mutations have no background color and an “n.a.” is displayed in the Mutation cell instead of the mutation code.</td>
</tr>
<tr>
<td>Display Mutations with the “Stop” Codon or Indel Only</td>
<td>Display only nonsense mutations and indels in the report.</td>
</tr>
<tr>
<td>Display Confirmed Mutations Only</td>
<td>Display only those mutations that you have manually confirmed in the report.</td>
</tr>
<tr>
<td>Display Mosaic Mutations</td>
<td>Display mosaic mutations in the report.</td>
</tr>
<tr>
<td><strong>Homozygous Dropping Threshold</strong></td>
<td>This value is the dropping factor at which a mutation is identified as either a homozygous substitution or a heterozygous substitution. For example, is a mutation A&gt;C or A&gt;AC? Because Mutation Surveyor evaluates the traces rather than the base calls, noise below a major peak can sometimes be interpreted as a heterozygous substitution. This value assists in your analysis by converting these calls to homozygous substitutions. <strong>Note:</strong> You can increase this value to view the exact call that Mutation Surveyor made, but an increased value might result in some calls remaining as heterozygous substitutions.</td>
</tr>
<tr>
<td><strong>Mutation Output Format</strong></td>
<td></td>
</tr>
<tr>
<td>Display Mutation As</td>
<td>Select one option to set the format of the mutation code in the report.</td>
</tr>
<tr>
<td>• 123T&gt;CT (Default value)</td>
<td></td>
</tr>
<tr>
<td>• 123CT</td>
<td></td>
</tr>
<tr>
<td>Display Negative Mutation as 123T</td>
<td>Display the position and the normal allele for a negative mutation in the report.</td>
</tr>
<tr>
<td>Number Bases Relative to cDNA</td>
<td>• If this option is cleared, the numbering is the genomic position within the GenBank file.</td>
</tr>
<tr>
<td></td>
<td>• If this option is selected:</td>
</tr>
<tr>
<td></td>
<td>• Select CDS to number the bases relative to the CDS numbering in the GenBank reference file.</td>
</tr>
<tr>
<td></td>
<td>• Select mRNA to number the bases relative the mRNA numbering in the GenBank reference file.</td>
</tr>
</tbody>
</table>
3. Click OK.

   The Advanced Two Direction report is generated and displayed in a window that is separate from the Viewing and Reporting pane.

**Figure 5-20: Advanced Two Direction report**

The Advanced Two Direction report toolbar contains buttons that are specific for working with the report and for changing the information that is displayed in the report.

**Figure 5-21: Advanced Two Direction report toolbar**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy—Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.</td>
</tr>
<tr>
<td><img src="image" alt="Save Report" /></td>
<td>Save Report—Opens the Save Report As dialog box in which you can specify a name and location for saving the report as well as its format (.txt, .xls/.xlsx, .xml, or .htm).</td>
</tr>
<tr>
<td><img src="image" alt="Report Settings" /></td>
<td>Report Settings—Opens the settings dialog box to allow adjustment of the Homozygous Dropping Factor.</td>
</tr>
</tbody>
</table>
### Chapter 5

**Mutation Surveyor Standard Reports**

**Homolog Consensus Sequence Text**—Generates an onscreen text file of the consensus base calls for the forward samples in a contig, for the reverse samples in a contig, and for the forward and reverse samples together.

**Figure 5-22: Homolog Consensus Sequence Text window**

- **Save button** —Opens the Save As dialog box in which you can specify a name and location for saving the sequence text as a .txt file.
- **Display Sequence in One Line button** —Displays the consensus sequences in fasta format.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Button" /></td>
<td>Homolog Consensus Sequence Text—Generates an onscreen text file of the consensus base calls for the forward samples in a contig, for the reverse samples in a contig, and for the forward and reverse samples together.</td>
</tr>
<tr>
<td><img src="Image" alt="Button" /></td>
<td>Lock Sample File in View—Freezes the Sample Filename column while scrolling.</td>
</tr>
</tbody>
</table>

**Lock Sample File in View**

Freezes the Sample Filename column while scrolling.
Advanced Two Direction report viewing and analysis options

A context menu is available for the Advanced Two Direction report. You use the options on this menu to change the view of the Advanced Two Direction report and to manipulate and analyze mutation project data so that you identify the true mutations in a mutation project. To open the context menu, right-click anywhere in the Advanced Two Direction report.

*Figure 5-23: Advanced Two Direction report context menu*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Copy                    | Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.  
  **Note:** You can also copy the Advanced Two Direction report as an image. Press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application. |
| Confirm                 | Confirms the selected mutations.  
  **Note:** SHIFT-click to select multiple contiguous mutations or to select all mutations in a column.  
  The text for the mutation code turns black in both the Advanced Two Direction report and the Mutation table in the GAD. The comment <<Checked>> is displayed in the Actions field for the mutation call in the Mutation table in the GAD. |
| Undo Confirmation       | Removes the “Confirmed” status for the mutation.  
  **Note:** SHIFT-click to select multiple contiguous mutations or to select all mutations in a column. |
Chapter 5
Mutation Surveyor Standard Reports

You can also view the information for a mutation in the Advanced Two Direction report in the GAD. To open the GAD for the trace that contains a mutation, double-click the mutation in the report.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort By Score (Descending)</td>
<td>Click the appropriate option to sort the all the data by descending mutation score or ascending mutation score.</td>
</tr>
<tr>
<td>Sort by Score (Ascending)</td>
<td></td>
</tr>
<tr>
<td>Delete Mutations</td>
<td>Deletes the selected mutations. Note: SHIFT-click to select multiple contiguous mutations, to select all mutations in a column, or to select multiple rows. The text for the mutation code turns gray in both the Advanced Two Direction report and the Mutation table in the GAD. The comment &lt;&lt;Deleted&gt;&gt; is displayed in the Actions field for the mutation call in the Mutation table in the GAD.</td>
</tr>
<tr>
<td>Delete Lane</td>
<td>Deletes all the mutations for a selected sample in a single step. The Lane Quality for a deleted lane is set to “Low Quality.”</td>
</tr>
<tr>
<td>Undo Deletion</td>
<td>The Lane Quality for the lane is reset to its original value.</td>
</tr>
<tr>
<td>Undo</td>
<td>Undo the last edit action that was carried out for the mutation.</td>
</tr>
<tr>
<td>View Edit History</td>
<td>See “Viewing the Edit History (Audit Trail) for a Mutation” on page 344.</td>
</tr>
<tr>
<td>Hyperlink to NCBI’s dbSNP</td>
<td>Opens the NCBI’s database entry (via the web) for the variant.</td>
</tr>
</tbody>
</table>

If you click a trace in the GAD with the Advanced Two Direction report open, the GAD is brought to the front. To bring the Advanced Two Direction report to the front again, press [CTRL]-T.
Chapter 5
Mutation Surveyor Standard Reports

Project Report

Like the directional reports, the Project report shows mutation information organized by paired sample traces. Although the layout of the Project report is very similar to the layout of the directional reports, the report has different settings for working with the report and for changing the information that is displayed in the report, and reports samples aligning to a single GenBank file. The fields that are displayed in the report, the mutation codes, and the color coding of the mutation calls in the report are identical to the fields, mutation codes, and color coding in the Mutation report (See “Mutation report fields” on page 128, “Mutation report codes” on page 129, and “Color codes” on page 130.) Just like the other standard mutation reports, you can change the fields that are displayed in the report by selecting or clearing the appropriate options on the Output tab on the Mutation Project Options dialog box. (See “Output tab” on page 62.)

1. To open the Project report, on the Mutation Surveyor main menu, click Reports > Project report.

The Project Report Settings dialog box opens.

Figure 5-24: Project Report Settings dialog box

2. Accept the default settings for the report, or make any changes as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mutation Scores</strong></td>
<td></td>
</tr>
<tr>
<td>Reject 1D Calls When Other Direction has No Call</td>
<td>Reject a mutation that is called in only one direction when the position falls within the comparison region of the other direction.</td>
</tr>
<tr>
<td>Reject 1D Calls When Other Direction is Not Available</td>
<td>Reject mutation calls that occur outside the region where the sample traces in both directions are aligned within the comparison region.</td>
</tr>
</tbody>
</table>
### Reject Synonymous Mutations

Coding region substitutions that do not affect amino acid calls are not displayed in the report.

**Note:** In cases where the entire column was not omitted from the report because of rejection by one of these criteria, the rejected mutations have no background color and an “n.a.” is displayed in the Mutation cell instead of the mutation code.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display Mutations with the “Stop” Codon or Indel Only</strong></td>
<td>Display only nonsense mutations and indels in the report.</td>
</tr>
<tr>
<td><strong>Display Confirmed Mutations Only</strong></td>
<td>Display only those mutations that you have manually confirmed in the report.</td>
</tr>
<tr>
<td><strong>Display Mosaic Mutations</strong></td>
<td>Display mosaic mutations in the report. This option requires using Check 2D Small Peaks in the Mutation Project Settings “Display tab” on page 64.</td>
</tr>
<tr>
<td><strong>Homozygous Dropping Threshold</strong></td>
<td>This value is the dropping factor at which a mutation is identified as either a homozygous substitution or a heterozygous substitution. For example, is a mutation A&gt;C or A&gt;AC? Because Mutation Surveyor evaluates the traces rather than the base calls, noise below a major peak can sometimes be interpreted as a heterozygous substitution. This value assists in your analysis by converting these calls to homozygous substitutions. You can increase this value to view the exact call that Mutation Surveyor made, but an increased value might result in some calls remaining as heterozygous substitutions.</td>
</tr>
</tbody>
</table>

### Sample Grouping

Specify the filename substring by which Mutation Surveyor groups all the mutation project samples files in the report. (These groupings are also used in the Project Sample Assembly subreport and in the Comparison functions. See “Project report toolbar” on page 148.)

- **n-Primer (n-D) Text Input**—Use the ND Grouping file to group the sample files. See “ND Filename Match Editor Tool” on page 264.
- **Filename Match** (based on one of the following):
  - **From Character [ ] To Character [ ]**—If all the filenames in your project contain the same characters/designator in the same positions, then select this option and enter the starting and ending character positions.
  - **Typical Block**—If all the filenames in your project contain the same characters/designator but in different positions, then select this option and enter the value for the character/designator block.
Chapter 5
Mutation Surveyor Standard Reports

3. Click OK.

The Project report is generated and displayed in a window that is separate from the Viewing and Reporting pane.

*Figure 5-25:  Project report*

![Project report](image)

**Project report toolbar**

The Project report toolbar contains buttons that are specific for working with the report and for changing the information that is displayed in the report. It also contains buttons for generating subreports in which you can view mutations in a matrix and view the alleles for each mutation.

*Figure 5-26:  Project report toolbar*

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Copy icon" /></td>
<td>Copy—Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.</td>
</tr>
<tr>
<td><img src="image" alt="Save Report icon" /></td>
<td>Save Report—Opens the Save Report As dialog box in which you can specify a name and location for saving the report as well as its format (.txt, .xls/.xlsx, .xml, or .htm).</td>
</tr>
</tbody>
</table>
### Chapter 5
Mutation Surveyor Standard Reports

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Report Settings" /></td>
<td><strong>Report Settings</strong>—Opens the Project Report Settings dialog box. See Step 2 of “Project Report” on page 146.</td>
</tr>
<tr>
<td><img src="image" alt="Project Sample Assembly" /></td>
<td><strong>Project Sample Assembly</strong>—Opens the Project Sample Assembly subreport. The Project Sample Assembly subreport creates a consensus of all the samples traces as defined by the Sample Grouping parameters set in the Project Report Settings dialog box. This subreport also lists the alleles for each mutation. See “Project Sample Assembly subreport” on page 150.</td>
</tr>
<tr>
<td><img src="image" alt="Consensus Sequence Text" /></td>
<td><strong>Consensus Sequence Text</strong>—Opens the Consensus Sequence Text dialog box. The Consensus Sequence Text function searches sample files that have been grouped based on a specific filename for consensus sequence strings. See “Consensus Sequence Text function” on page 151.</td>
</tr>
<tr>
<td><img src="image" alt="Sequence Text Comparison" /></td>
<td><strong>Sequence Text Comparison</strong>—Opens the Sequence Text Comparison dialog box. The Sequence Text Comparison function compares the sequence text for sample files that have been grouped based on a specific filename substring to the sequence text in the reference file. See “Sequence Text Comparison function” on page 152.</td>
</tr>
<tr>
<td><img src="image" alt="Amino Acid Text Comparison" /></td>
<td><strong>Amino Acid Text Comparison</strong>—Opens the Amino Acid Text Comparison dialog box. The Amino Acid Text Comparison function compares the amino acid sequence for sample files that have been grouped based on a specific filename substring to the amino acid sequence in the reference file. See “Amino Acid Text Comparison function” on page 154.</td>
</tr>
<tr>
<td><img src="image" alt="Lock Sample File in View" /></td>
<td><strong>Lock Sample File in View</strong>—Freezes the Sample Filename column while scrolling.</td>
</tr>
</tbody>
</table>
Chapter 5
Mutation Surveyor Standard Reports

Project Sample Assembly subreport

The Project Sample Assembly subreport displays a separate row for each substring, the total number of mutations found in all the files that contain the specified substring, and the code for each called mutation. The subreport can be saved as a text file.

*Figure 5-27: Project Sample Assembly subreport*

- To view the group consensus results within a matrix, click Display Results on the subreport toolbar.

*Figure 5-28: Results matrix view of mutations*

- To view a matrix of the alleles for each group consensus for each mutation, click Display Alleles on the subreport toolbar.

*Figure 5-29: Allele matrix view of mutations*
Consensus Sequence Text function

The Consensus Sequence Text function searches sample files that have been grouped based on a specific filename for consensus sequence strings. You can also specify a minimum lane quality to exclude low quality samples.

Figure 5-30: Consensus Sequence Text Settings dialog box

Figure 5-31 is an example of the Consensus Sequence Text report. The reference information is displayed at the top of the report. The consensus sequence for the base pair region is displayed below the reference information and is grouped by filename substring.

Figure 5-31: Consensus Sequence Text report

Consensus Sequence Text window toolbar

The Consensus Sequence Text window toolbar contains buttons that are specific for working with the output and for changing the output display.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save Sequence Text" /></td>
<td>Save Sequence Text—Opens the Save As dialog box in which you can specify a name and location for saving the output as a .txt file.</td>
</tr>
</tbody>
</table>
Chapter 5  
Mutation Surveyor Standard Reports  

Sequence Text Comparison function  

The Sequence Text Comparison function compares the sequence text for sample files that have been grouped based on a specific filename substring to the sequence text in the reference file. You can also specify a minimum lane quality to exclude low quality samples.  

*Figure 5-32: Sequence Text Comparison Settings dialog box*  

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Display Sequence in One Line" /></td>
<td>Display Sequence in One Line—Displays the consensus sequences in fasta format.</td>
</tr>
</tbody>
</table>
| ![Save As PHD file](image) | Save As PHD file—Opens the Browse for Folder dialog box in which you can specify the location for saving the output as a .phd file. A .phd file contains three columns:  
  - Column 1-Base call  
  - Column 2-Quality score for the called base  
  - Column 3-Raw data frame for called base  
You can open a .phd file in Notepad. |

*Figure 5-33 on page 153* is an example of the Sequence Text Comparison report. The reference sequence is displayed at the top of the report as a single continuous string of characters without numbering or spacing. Sample files are grouped by substring and are displayed below the reference sequence. In a sample file sequence, a black dot (.) indicates a match between the reference file and the sample file. A black dash (-) indicates an artificial gap added to a sample file so that all the sample files remain aligned. This gap can be the result of a deletion in the gapped sample or of an insertion in another sample. If a different base is at the same position in the sample file and reference file, then the standard IUB/IUPAC code for the base is shown in the sample file at the position.
Chapter 5
Mutation Surveyor Standard Reports

**Figure 5-33: Sequence Text Comparison report**

The Sequence Text window toolbar contains buttons that are specific for working with the output.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save Sequence Text" /></td>
<td>Save Sequence Text—Opens the Save As dialog box in which you can specify a name and location for saving the output as a .txt file.</td>
</tr>
</tbody>
</table>
| ![Save As PHD file](image) | Save As PHD file—Opens the Browse for Folder dialog box in which you can specify the location for saving the output as a .phd file. A .phd file contains three columns:  
  • Column 1-Base call  
  • Column 2-Quality score for the called base  
  • Column 3-Raw data frame for called base  
  You can open a PHD file in Notepad. |
Amino Acid Text Comparison function

The Amino Acid Text Comparison function compares the amino acid sequence for sample files that have been grouped based on a specific filename substring to the amino acid sequence in the reference file. You can also specify a minimum lane quality to exclude low quality samples.

*Figure 5-34: Amino Acid Text Comparison Settings dialog box*

*Figure 5-35* is an example of the Amino Acid Text Comparison report. The amino acid sequence for the reference file displayed at the top of the report using standard IUB/IUPAC amino acid codes. Sample files are grouped by substring and are displayed below the reference sequence. In a sample file sequence, a black dot (.) indicates a match between the reference file and the sample file. If a different amino acid is at the same position in the sample file and reference file, then the standard IUB/IUPAC code for the amino acid is shown in the sample file at the position.

*Figure 5-35: Amino Acid Text Comparison report*
Amino Acid Text Comparison window toolbar

The Amino Acid Text Comparison window toolbar contains a single button that is specific for working with the output.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button Icon]</td>
<td>Save Sequence Text—Opens the Save As dialog box in which you can specify a name and location for saving the output as a .txt file.</td>
</tr>
</tbody>
</table>

Project report viewing and analysis options

A context menu is available for the Project report. You use the options on this menu to change the view of the Project report and to manipulate and analyze mutation project data so that you identify the true mutations in a mutation project. To open the context menu, right-click anywhere in the Project report.

*Figure 5-36:  Project report context menu*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Copy   | Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.  
**Note:** You can also copy the Project report as an image. Press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application. |
| Confirm| Confirms the selected mutations.  
**Note:** SHIFT-click to select multiple contiguous mutations or to select all mutations in a column.  
The text for the mutation code turns black in both the Project report and the Mutation table in the GAD. The comment <<Checked>> is displayed in the Actions field for the mutation call in the Mutation table in the GAD. |
Chapter 5
Mutation Surveyor Standard Reports

You can also view the information for a mutation in the Project report in the GAD. To open the GAD for the trace that contains a mutation, double-click the mutation in the report.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo Confirmation</td>
<td>Removes the &quot;Confirmed&quot; status for the mutation.</td>
</tr>
<tr>
<td>Note: Shift-click to select multiple contiguous mutations or to select all mutations in a column.</td>
<td></td>
</tr>
<tr>
<td>Sort By Score (Descending)</td>
<td>Click the appropriate option to sort the all the data by descending mutation score.</td>
</tr>
<tr>
<td>Sort by Score (Ascending)</td>
<td></td>
</tr>
</tbody>
</table>

If you click a trace in the GAD with the Project report open, the GAD is brought to the front. To bring the Project report to the front again, press [CTRL]-T.
HGVS Report

Like the directional reports, the HGVS report shows mutation information organized by paired sample traces. Also, the layout of the HGVS report is very similar to the layout of the directional reports. (See “Two Direction report layout” on page 134.) The HGVS report, however, displays mutation calls according to the guidelines established by the Human Genome Variations Society. (The color coding of these calls is still the same as the color coding that is used in the other standard Mutation Surveyor reports. See “Color codes” on page 130.) In addition to the standard report mutation fields specified for the project (see “Output tab” on page 62), the HGVS report shows many quality values for the project, including quality values for the entire trace, the comparison region, and the ROIs.

1. To open the HGVS report, on the Mutation Surveyor main menu, click Reports > HGVS report.

   The HGVS Report Settings dialog box opens.

   Figure 5-37: HGVS Report Settings dialog box
2. Accept the default settings for the report, or make any changes as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mutation Scores</strong></td>
<td></td>
</tr>
<tr>
<td>Reject 1D Calls When Other Direction has No Call</td>
<td>Reject a mutation that is called in only one direction when the position falls within the comparison region of the other direction.</td>
</tr>
<tr>
<td>Reject 1D Calls When Other Direction is Not Available</td>
<td>Reject mutation calls that occur outside the region where the sample traces in both directions are aligned within the comparison region.</td>
</tr>
<tr>
<td>Reject Synonymous Mutations</td>
<td>Coding region substitutions that do not affect amino acid calls are not displayed in the report.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>In cases where the entire column was not omitted from the report because of rejection by one of these criteria, the rejected mutations do not have a background color and an &quot;n.a.&quot; is displayed in the Mutation cell instead of the mutation code.</td>
</tr>
<tr>
<td>Display Mutations with the “Stop” Codon or Indel Only</td>
<td>Display only nonsense mutations and indels in the report.</td>
</tr>
<tr>
<td>Display Confirmed Mutations Only</td>
<td>Display only those mutations that you have manually confirmed in the report.</td>
</tr>
<tr>
<td>Display Mosaic Mutations</td>
<td>Display mosaic mutations in the report. This option requires using Check 2D Small Peaks in the Mutation Project Settings. See “Display tab” on page 64.</td>
</tr>
<tr>
<td>Homozygous Dropping Threshold</td>
<td>Indicates the value for the dropping factor at which a mutation is identified as either a homozygous substitution or a heterozygous substitution. For example, is a mutation A&gt;C or A&gt;AC? Because Mutation Surveyor evaluates the traces rather than the base calls, noise below a major peak can sometimes be interpreted as a heterozygous substitution. This value assists in your analysis by converting these calls to homozygous substitutions. You can increase this value to view the exact call that Mutation Surveyor made, but an increased value might result in some calls remaining as heterozygous substitutions. <strong>Note:</strong> You can increase this value to view the exact call that Mutation Surveyor made, but an increased value might result in some calls remaining as heterozygous substitutions.</td>
</tr>
<tr>
<td>Phred Score Threshold</td>
<td>A measure of base quality, all bases that are in the ROI and that have a Phred score &lt;= to the specified value are displayed in the Bases Below Threshold (ROI) report column. Reducing this value reduces the number of bases that are displayed. Conversely, increasing this value increased the number of based that are displayed.</td>
</tr>
</tbody>
</table>

**Trace Quality**
3. Click OK.

The HGVS report is generated and displayed in a window that is separate from the Viewing and Reporting pane.

Figure 5-38: HGVS report
Chapter 5
Mutation Surveyor Standard Reports

**HGVS report toolbar**

The HGVS report toolbar contains buttons that are specific for working with the report and for changing the information that is displayed in the report.

*Figure 5-39: HGVS report toolbar*

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy—Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.</td>
</tr>
<tr>
<td><img src="image" alt="Save Report" /></td>
<td>Save Report—Opens the Save Report As dialog box in which you can specify a name and location for saving the report as well as its format (.txt, .xls/.xlsx, .xml, or .htm).</td>
</tr>
<tr>
<td><img src="image" alt="Homolog Consensus Sequence Text" /></td>
<td>Homolog Consensus Sequence Text—Generates an onscreen text file of the consensus base calls for the forward samples in a contig, for the reverse samples in a contig, and for the forward and reverse samples together.</td>
</tr>
</tbody>
</table>

*Figure 5-40: Homolog Consensus Sequence Text window*

- Save button —Opens the Save As dialog box in which you can specify a name and location for saving the .txt file.
- Display Sequence in One Line button —Displays the consensus sequences in fasta format.
HGVS report viewing and analysis options

A context menu is available for the HGVS report. You use the options on this menu to change the view of the HGVS report and to manipulate and analyze mutation project data so that you identify the true mutations in a mutation project. To open the context menu, right-click anywhere in the HGVS report.

Figure 5-42: HGVS report context menu

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mutation Output for Database—Outputs the HGVS report to a format that can be exported to a database.</td>
<td></td>
</tr>
<tr>
<td>Figure 5-41: Mutation Output for Database</td>
<td></td>
</tr>
<tr>
<td>• Save button —Opens the Save As dialog box in which you can specify a name and location for saving the mutation output as a .txt file.</td>
<td></td>
</tr>
<tr>
<td>• Report Settings button —Opens the Mutation Output dialog box. You use the options on this dialog box to select the fields that are to be included in the Mutation output. By default, when the dialog box first opens, all standard mutation report fields are selected.</td>
<td></td>
</tr>
<tr>
<td>Lock Sample File in View</td>
<td>Freezes the Sample Filename column while scrolling.</td>
</tr>
</tbody>
</table>
Chapter 5
Mutation Surveyor Standard Reports

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Copy                    | Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.  
**Note:** You can also copy the HGVS report as an image. Press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application. |
| Confirm                 | Confirms the selected mutations.  
**Note:** SHIFT-click to select multiple contiguous mutations or to select all mutations in a column.  
The text for the mutation code turns black in both the HGVS report and the Mutation table in the GAD. The comment <<Checked>> is displayed in the Actions field for the mutation call in the Mutation table in the GAD. |
| Undo Confirmation       | Removes the “Confirmed” status for the mutation.  
**Note:** SHIFT-click to select multiple contiguous mutations or to select all mutations in a column. |
| Sort By Score           | Click the appropriate option to sort the all the data by descending mutation score or ascending mutation score.                                                                                             |
| (Descending)           |                                                                                                                                                |
| (Ascending)            |                                                                                                                                                |
| Delete Mutations        | Deletes the selected mutations.  
**Note:** SHIFT-click to select multiple contiguous mutations, to select all mutations in a column, or to select multiple rows.  
The text for the mutation code turns gray in both the HGVS report and the Mutation table in the GAD. The comment <<Deleted>> is displayed in the Actions field for the mutation call in the Mutation table in the GAD. |
| Delete Lane             | Deletes all the mutations for a selected sample in a single step. The Lane Quality for a deleted lane is set to “Low Quality.”                                                                           |
| Undo Deletion           | The Lane Quality for the lane is reset to its original value.                                                                               |
| Undo                   | Undo the last edit action that was carried out for the mutation.                                                                               |
| View Edit History       | See “Viewing the Edit History (Audit Trail) for a Mutation” on page 344.                                                                    |

You can also view the information for a mutation in the HGVS report in the GAD. To open the GAD for the trace that contains a mutation, double-click the mutation in the report.

If you click a trace in the GAD with the HGVS report open, the GAD is brought to the front. To bring the HGVS report to the front again, press [CTRL]-T.
Chapter 6
Mutation Surveyor Custom Report

A text-based custom report is available in Mutation Surveyor. This reports contain options for building a tailored report that provides detailed information about your mutation projects in a format that best suits your specific working needs. In addition, you can print the report information and you can save and store the report output for use at a later date.

This chapter covers the following topics:
- “Custom Report” on page 164.
Chapter 6
Mutation Surveyor Custom Report

Custom Report

The Custom report offers a variety of report formats in which to display your mutation project data. A variety of options are also available for tailoring the report to best suit your working needs, including sample grouping options, report heading options, options for filtering the variations that are displayed in the report, display options for samples and mutation calls, color-coding options for mutation calls, and nomenclature options for mutation calls. You can create a custom report template from scratch, or you can load an existing custom report template, modify the settings as needed, and then save the modified template.

To create a Custom Report template


   The Custom Report Settings dialog box opens. The Format tab is the active tab.

   ![Custom Report Settings dialog box, Format tab](Figure 6-1: Custom Report Settings dialog box, Format tab)
2. Do one of the following:
   • To set up a new custom report from scratch, select your options and specify the appropriate values on the different dialog box tabs.
   • To generate the report based on existing settings, click Load to browse to and select the MS Report Template.ini file that you want to use. Optionally, before you generate the report, modify the settings for the loaded report as needed.

   See:
   • “Format tab” on page 166.
   • “Filters tab” on page 170.
   • “Display tab” on page 172.
   • “Mutation tab” on page 173.
   • “Color tab” on page 176.
   • “Nomenclature tab” on page 177.
   • “Other tab” on page 179.

3. Do one of the following:
   • To generate an onscreen report according to the settings that you have specified, click OK.

   The report opens in the Custom Report window.

   Click Default at any time to reset all the values on all the tabs to the system default values.
Chapter 6  
Mutation Surveyor Custom Report

- To save the settings for loading and generating a report at a later date, click Save. The Save Mutation Surveyor Report Template dialog box opens. By default, a Custom report is saved as MutationSurveyor_CRSettings.ini file in the %localappdata%\SoftGenetics\MutationSurveyor\Report folder. If you do not want to override the default custom report file supplied with Mutation Surveyor, change the name of the file, the location of the file, or both.

Format tab

The Format tab contains options for the formatting and layout of the custom report. 

Figure 6-3: Custom Report Settings dialog box, Format tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table Format</strong></td>
<td></td>
</tr>
<tr>
<td>One Trace Per Row</td>
<td>Display all mutation information for each trace in its own row.</td>
</tr>
<tr>
<td>Generate Forward/Reverse Consensus</td>
<td>Create a single consensus by merging the forward consensus and reverse consensus.</td>
</tr>
<tr>
<td>Generate Group Consensus</td>
<td>Create a single consensus by merging all the consensus information for the sample group.</td>
</tr>
<tr>
<td>Mutation Position Specific for Column</td>
<td>Aligns mutations by column within each group (By Group) or aligns mutations by column across all groups (By Table).</td>
</tr>
<tr>
<td>One Mutation per Row</td>
<td>Display information for each mutation call in its own row.</td>
</tr>
<tr>
<td><strong>Note:</strong> Select if mutation information is to be exported to a database.</td>
<td></td>
</tr>
<tr>
<td>Transpose</td>
<td>Generates a table that has base positions in rows and sample traces in columns.</td>
</tr>
</tbody>
</table>
### Chapter 6

**Mutation Surveyor Custom Report**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Headings</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Show Display Region Heading</strong></td>
<td>Selected by default. If you clear this option, then column headings are not displayed in the report.</td>
</tr>
<tr>
<td><strong>Show Mutation Number</strong></td>
<td>Labels mutation call columns with Variant number.</td>
</tr>
<tr>
<td><strong>Show Position Information</strong></td>
<td>Labels mutation call columns by the genomic position referenced in the GenBank file.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A particularly useful option if you display mutation calls by a nomenclature other than Genomic.</td>
</tr>
<tr>
<td><strong>Show Default Header Information</strong></td>
<td>Displays the Mutation Surveyor version number, the date and time that the report was generated, the project name (if loading a saved project) and the report settings file name. “Default” is displayed as the report settings filename when the report is generated using the system default settings. The actual report filename is displayed when the report is generated using a saved report settings file. “Customized” is displayed in all other cases. (The settings were not loaded using a saved report settings file and the settings are not the system default settings.)</td>
</tr>
<tr>
<td><strong>Create Header/Custom Header File</strong></td>
<td>Click Create Header to open the Create Header dialog box which contains a template for creating a custom header that can be displayed at the top of a custom report.</td>
</tr>
</tbody>
</table>

**Figure 6-4: Create Header dialog box**

Do one of the following:
- Modify any of the default template information in either column.
- Click Open to select an existing custom header file to modify.

You can add or delete rows of information as needed.
- To delete a row from the header, right-click the row, and then click Delete a Row.
- To insert a row into the header, right-click the row that is to be located below the inserted row, and then click Insert a Row.
- To add a row as the last row in the header, right-click any row, and then click Add a Row.

Click Save to save the custom header as an .inf file, and then click the Browse button to browse to and load the saved header file for the custom report.
Chapter 6  
Mutation Surveyor Custom Report

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Grouping</strong></td>
<td>Traces are initially grouped based on the 1st Order Grouping option. Further sorting is then carried out based on the 2nd Order Grouping option, and then on the 3rd Order Grouping option.</td>
</tr>
<tr>
<td>• Contig</td>
<td>The default value for 1st Order. Groups are sorted based on the Contigs that Mutation Surveyor created for determining mutation calls.</td>
</tr>
<tr>
<td>• Trace</td>
<td>When Trace is selected, the From Character X to Y option is enabled. Traces are sorted into groups based on character matching in the specified positions in the trace filenames.</td>
</tr>
<tr>
<td>• Grouping File</td>
<td>Traces are sorted into groups based on the grouping method that is specified in the Load Grouping text file. See &quot;2D Filename Match Editor tool&quot; on page 261.</td>
</tr>
<tr>
<td>• Sample ID</td>
<td>When Sample ID is selected, both the Load Sample ID button and the From Character X to Y option are enabled. Click Load Sample ID to open the Load Sample ID dialog box and specify the different Sample IDs, such as Patient #, by which to group the traces. You can also click Open to load an existing Sample ID file.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> By default, the Load Sample ID dialog box contains rows for up to ten different Sample IDs. You can right-click and click Insert or Delete as needed.</td>
</tr>
<tr>
<td>• F/R pairing</td>
<td>The default value for the 2nd Order. Places two-directional traces in adjacent rows.</td>
</tr>
</tbody>
</table>

![Figure 6-5: Load Sample ID dialog box](image)

The traces that are to be grouped together must contain at least one of these Sample IDs in their filenames but they do not need to be in the same location in the filename. When grouping by Sample ID, the trace filenames are first checked based on the Sample IDs defined in the Load Sample ID dialog box. The values specified in the From Character X to Y fields are ignored if all the trace filenames contain at least one of these Sample IDs. Traces that do not contain any of these Sample IDs in their filenames are sorted into groups based on the values specified in the From Character X to Y fields. Traces that do not contain any of these Sample IDs and that do not contain the characters specified in the From Character X to Y fields are sorted into their own group.
### Mutation Surveyor Custom Report

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trace Position</td>
<td>The default value for the 3rd Order. Traces are sorted into groups based on where they match to the GenBank reference file. Each trace is matched at its starting genomic base number. Groups can be sorted so that traces that match to the earliest reference base are displayed first.</td>
</tr>
<tr>
<td>Gene</td>
<td>Traces are sorted into groups based on the gene names defined in the GenBank reference file.</td>
</tr>
<tr>
<td>Exon</td>
<td>Traces are sorted into groups based on the exons defined in the GenBank reference file.</td>
</tr>
<tr>
<td>Trace Quality</td>
<td>Traces are sorted into groups based on the lane quality for the trace.</td>
</tr>
<tr>
<td>None</td>
<td>Ignore the sorting level.</td>
</tr>
<tr>
<td>All in One Group</td>
<td>Traces are placed in a single group. Only available for the 1st Order.</td>
</tr>
</tbody>
</table>

**Add Blank Rows between Groups**

Selected by default. Clear this option if you do not want a blank row to be displayed between groups of traces in the custom report.

### Group Summary

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do Not Show Group Summary Information</td>
<td>Do not display a row below each group that shows such information as the average frequency of the call among the traces.</td>
</tr>
<tr>
<td>Show Allele Information</td>
<td>• Show Allele Frequency—Adds a row below each group that displays the average frequency of the call among all the traces. For which data is not available for the indicated position are not used in the frequency calculation.</td>
</tr>
<tr>
<td></td>
<td>• Show Advanced Allele Information—Applicable only if you are analyzing diploid samples. Displays the frequency of each allele by traces and as a grand total.</td>
</tr>
<tr>
<td></td>
<td>• Total—Shows the frequency of the two alleles within each sample trace.</td>
</tr>
<tr>
<td></td>
<td>• Grand Total (2D data)</td>
</tr>
<tr>
<td></td>
<td>• If both the forward and reverse traces show a mutation at the position, then the alleles in the Forward direction mutation call are used in the calculation of the allele frequency.</td>
</tr>
<tr>
<td></td>
<td>• If data is not available for the position in one of the traces, then the alleles in the mutation call in the other direction are used in the calculation of the allele frequency.</td>
</tr>
<tr>
<td></td>
<td>• If data is available for the position in both traces, but only one of the traces has a mutation call, then Mutation Surveyor ignores this pair and the alleles in the sample trace with the mutation call are not used in the calculation of the allele frequency.</td>
</tr>
<tr>
<td></td>
<td>• Grand Total (1D data)—The alleles in each trace are used in the calculation of the allele frequency.</td>
</tr>
<tr>
<td>Show Mutation Summary</td>
<td>• Applicable only if you have loaded a GenBank file with reported variations. Displays a listing of variants within each group, with variants placed in one of two columns—Unreported and Reported. The Unreported column displays novel variants that were found in the sample files, but were not reported in the GenBank file. The Reported column displays the reported variants that were found in the sample files.</td>
</tr>
</tbody>
</table>
Filters tab

The Filters tab contains options for specifying which traces are to be displayed in the custom report.

Some of the options on this tab are self-explanatory, and therefore, not all these options are discussed in this section.

Figure 6-6: Custom Report Settings dialog box, Filters tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traces</td>
<td>Filtering options that limit the traces that are displayed in the report to only those that meet the selected criteria.</td>
</tr>
<tr>
<td></td>
<td>• Containing No Mutation Calls</td>
</tr>
<tr>
<td></td>
<td>• Containing only normal alleles—Traces without mutations that can have mosaics, negative SNPs, and/or negative mutations.</td>
</tr>
<tr>
<td></td>
<td>• Containing Negative SNPs—A negative SNP is defined as position in the GenBank file at which a variation has been reported, but no variation was detected at the same position in the sample trace. Sample traces that have negative SNPs might still contain mutation calls.</td>
</tr>
<tr>
<td></td>
<td>• Containing Negative Mutations—A negative mutation is defined as a position in a sample trace at which a variation was detected, but no variation was detected at the same position for other sample traces in the group. Sample traces that have negative mutations might still contain mutation calls.</td>
</tr>
<tr>
<td></td>
<td>• Unmatched Traces—Clear this option to remove sample traces from the Custom report that do not match to the reference trace.</td>
</tr>
</tbody>
</table>
### Nucleotide Quality

- **Phred Score**
- **Intensity**

Define nucleotide quality thresholds based on the nucleotide Phred Score and the nucleotide Intensity. Used to mitigate the calling of false positives when the data quality is poor.

### Mutation Calls

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show All Mutations</strong></td>
<td>Show all mutations of all types in all regions.</td>
</tr>
<tr>
<td><strong>Show Selected Mutations</strong></td>
<td>Filtering options that limit the mutations that are displayed in the report to only those that meet the selected criteria of type and region. (Show only mutations of the selected type in the selected regions.)</td>
</tr>
<tr>
<td>• Regions</td>
<td>Limit the mutations that are displayed to only those that are called within regions of interest (ROI) that are defined in the GenBank reference file.</td>
</tr>
<tr>
<td>• Mutation Types</td>
<td></td>
</tr>
<tr>
<td>• Selected Types</td>
<td>You must choose at least one type from each group.</td>
</tr>
</tbody>
</table>

**Note:** When choosing at least one type from each group:

- **Homozygous Dropping Threshold**—Indicates the value for the dropping factor at which a mutation is identified as either a homozygous substitution or a heterozygous substitution. For example, is a mutation A>C or A>AC? Because Mutation Surveyor evaluates the traces rather than the base calls, noise below a major peak can sometimes be interpreted as a heterozygous substitution. This value assists in your analysis by converting these calls to homozygous substitutions. You can increase this value to view the exact call that Mutation Surveyor made, but an increased value might result in some calls remaining as heterozygous substitutions.

- **Reject 1D Calls When Other Direction has No Call**—Reject a mutation that is called in only one direction when the position falls within the comparison region of the other direction.

- **Reject 1D Calls When Other Direction is Not Available**—Reject a mutation that is called in only one direction when the position falls outside the comparison region of the other direction.
Display tab

The Display tab contains options for specifying the columns to display in the custom report. 

The majority of the options on this tab are self-explanatory, and therefore, not all these options are discussed in this section.

**Figure 6-7: Custom Report Settings dialog box, Display tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Region of Interest   | • ROI Coverage—Identifies when an ROI has not aligned entirely within the Comparison Region.  
                        • ROI Phred String—Display a single ASCII character representation of the Phred score for each nucleotide position within an ROI. The ASCII character that is displayed for a Phred Score is the Phred Score + 32. For example, if the Phred Score = 1, then 1 + 32 = 33, or the 33rd character in the ASCII character set, which is an exclamation point (!).  
                        **Note:** For an ASCII character map, see [http://www.asciitable.com/](http://www.asciitable.com/). |
| Quality Information  | • Trace Quality Information—Options in this section are used to identify traces of low quality. The Low Quality Threshold is the value that is specified for Lane Quality in the Mutation project settings. (See "Quality Trim" on page 58.) The trace is also identified with the background color that has been selected for Quality Failure on the Colors tab. (See "Color tab" on page 176.)  
                        • Nucleotide Quality Information—Options in this section are used to identify nucleotide positions of poor quality. (See "Score Trim [ ]" on page 58.) |
Mutation tab

The Mutation tab contains options for displaying information for the various mutation calls as well as options for displaying information about positions where mutations were not called.

The majority of options on this tab are self-explanatory, and therefore, not all these options are discussed in this section.

**Figure 6-8: Custom Report Settings, Mutation tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Mutation Call Information</td>
<td>Nucleotide positions are displayed in the nomenclature that you select on the Nomenclature tab. (See “Nomenclature tab” on page 177.)</td>
</tr>
<tr>
<td>Amino Acid Position</td>
<td>By default, amino acid information is organized with the reference amino acid appearing first, the amino acid position appearing next, and the mutation amino acid appearing last. If you do not select Amino Acid Position, then a slash (/) is displayed between the reference amino acid and the mutation amino acids.</td>
</tr>
<tr>
<td>Confidence(!)</td>
<td>Displays a Confidence mark (!) for mutation calls that exceed certain thresholds that are defined in the MutationSurveyor.ini file. <strong>Caution:</strong> Although you can modify these thresholds, SoftGenetics does not recommend that you do so on your own. Contact SoftGenetics for assistance.</td>
</tr>
<tr>
<td>Comments</td>
<td>Displays all comments that were added to a mutation call, either automatically by Mutation Surveyor or manually by a user.</td>
</tr>
</tbody>
</table>
### Chapter 6
Mutation Surveyor Custom Report

**Show Non-Mutation Call Information**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Show Normal Alleles     | • Show Negative SNP—Display selected Show Normal Allele Information for nucleotides that do not show the variations reported in the GenBank or SEQ file. For indels, “no_ins” or “no_del” is displayed.  
  • Show Negative Mutations—Display selected Show Normal Allele Information for a position in a sample trace at which a variation was not detected, but the variation was detected at the same position for other sample traces in the group.  
  • Show Normal Allele Information—Specify the information that is to be displayed for positions that do not have an identified mutation call.  
  **Note:** When Normal Allele Information is displayed and One Mutation per Row is selected (see “Table Format” on page 166), all options selected in the Show Mutation Call Information section are exported for both mutation calls and normal alleles. |

**General Information**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Reported Variant Annotation | Displays all the variations’ annotations that are included in the GenBank file such as the dbSNP identifier as well as the annotation fields from the Variation Tracks selected to report. |}

**Genotype**

With this option selected, Mutation Surveyor assumes that the analysis is for a diploid organism and displays the two alleles at the nucleotide position. For indels, a homozygous insertion of “A,” for example, is displayed as “insA insA,” and a heterozygous insertion of “A,” is displayed as “normal ins A.” If there is no insertion, then “Normal Normal” is displayed.

**NM_Score**

Assigns a score to each sample nucleotide that indicates the contribution of the normal allele at the position compared to the contribution of the possible mutant alleles at the same position. The score is based on the height ratio of the four different dye colors and the shape of the four peaks at each nucleotide position. The range is 0-100. A high score indicates a high degree of similarity between the sample trace and the reference trace, which, in turn, means that the sample trace more than likely contains a normal allele at the position. A low score indicates a high degree of difference between the sample trace and the reference trace, which, in turn, means that the sample trace more than likely contains a homozygous substitution. Scores in the middle indicate high levels of noise and error or heterozygous substitutions in the sample trace.
**Chapter 6**  
*Mutation Surveyor Custom Report*

**Display Information**—Specifies how the mutation call information is to be distributed in table cells for display.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **One Field**               | • All the information displayed in a single field.  
• Report the Deletion and Insertion as Delins—If an insertion and deletion occur at the same position, then they are merged into a single call at the position.  
• Mutation Call Nucleotides Relative to Gene Direction—Make the mutation call based on the gene orientation. To make a mutation call for a gene on the reverse strand, a reverse complement is generated. |
| **Multiple Fields**         | • Multiple Fields (Group Nts, A.A., and Score into One Field or Group Nts and A.A. into Relevant Fields)—Specific pieces of information grouped into fields.  
• All Information in Unique Fields—Each piece of information displayed in its own column.                                                                 |

**Show Advanced Display**  
• [ ] # of nucleotides Displayed Before/After Mutation—Displays the specified normal number of alleles on either side of the variant. The position is displayed with a slash (/) between the normal allele and the mutation alleles.  
• Display Position—Displays the reference nucleotide and its position, the consensus nucleotides for the group at this position, the amino acid information (if applicable), and the reported variants’ annotations. This information can be displayed in One Field or in Multiple Fields.
Color tab

The Color tab provides a variety of color-coding options to assist you with identifying different types of mutation calls and potential analysis problems.

Figure 6-9: Custom Report Settings dialog box, Color tab

Color-coding is applied according to the following:

- If a mutation call meets several color-coding criteria, the call is displayed in the report in the color of highest priority.
- If None is selected for a color-coding option, then the color of the next highest priority is used.
- For Mutation Region color-coding, Quality Failure has the highest priority.
- For Mutation Region Text color-coding, the priorities from highest to lowest are as follows—Deleted, Confirmed, Added, Edited, High Confidence, Low Confidence, Normal Alleles, and Not Available.
- For Mutation Region Background color coding, priorities from highest to lowest are as follows—Discrepancy, Mosaic, Familial, Pathogenic, Likely_Pathogenic, Unlikely_Pathogenic, Benign, Drug_Sensitive, Drug_Resistant, dbSNP, VUS, Reported, A.A. Change, Indel, Synonymous, Heterozygous, Homozygous, Not Available, and Heading(s) where:
  - **Discrepancy** identifies the variants within a consensus of traces that have at least one member of the consensus that differs from the others. The Discrepancy indicator is available for the Generate Forward/ Reverse Consensus table format and the Generate Group Consensus table format. (See “Table Format” on page 166.)
• **Synonymous** identifies the coding region substitutions that do not affect the amino acid sequence.

> *When a consensus is formed, discrepancies are identified only for positions that have data available. For example, if Generate Forward/Reverse Consensus is the selected table format, and the Forward trace contains a mutation call at position #320 but the Reverse trace does not at this position because data is not available, then a discrepancy is not detected.*

If you select Apply Color Coding as text, then when you save the Custom report as a .txt file, the color-coding is shown as a comment in the file.

### Nomenclature tab

The Nomenclature tab contains options for specifying the nomenclature that is to be used for the mutation calls.

*Figure 6-10: Custom Report Settings dialog box, Nomenclature tab*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genomic</td>
<td>Displays the mutation call positions based on the genomic position referenced in the GenBank file.</td>
</tr>
<tr>
<td>Relative to CDS</td>
<td>Displays the mutation call positions relative to the CDS numbering in the GenBank reference file. A mutation that is called in the CDS is prefixed with &quot;c.&quot; A mutation that is called in a non-coding region is prefixed with &quot;IVS.&quot; Its position is identified by the closest nucleotide in the coding sequence plus or minus the number of bps by which it resides away from the closest nucleotide.</td>
</tr>
</tbody>
</table>
Chapter 6
Mutation Surveyor Custom Report

Figure 6-11: Nomenclature examples

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative to mRNA</td>
<td>Displays the mutation call positions relative to the mRNA numbering in the GenBank reference file. A mutation that is called in the mRNA region is prefixed with a &quot;c.&quot; A mutation that is called outside of an mRNA region is identified by the closest nucleotide in the mRNA region plus or minus the number of bps by which it resides away from the closest nucleotide.</td>
</tr>
<tr>
<td>HGVS</td>
<td>Displays the mutation call positions relative to its position in the coding sequence. A mutation that is called in a non-coding region is identified by the closest nucleotide in the coding sequence plus or minus the number of bps by which it resides away from the closest nucleotide. Both alleles are shown in separate bracketed statements.</td>
</tr>
<tr>
<td>Forensic (SWGDAM)</td>
<td>Displays the mutation call using SWGDAM Guidelines.</td>
</tr>
<tr>
<td>Custom</td>
<td>Allows you to tailor the nomenclature for mutation calls to best suit your working needs.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Substitution</th>
<th>Genomic</th>
<th>Relative to CDS</th>
<th>Relative to mRNA</th>
<th>HGVS</th>
<th>Forensic (SWGDAM)</th>
</tr>
</thead>
<tbody>
<tr>
<td>coding</td>
<td>875C&gt;T</td>
<td>IVS4-14C&gt;T</td>
<td>c.26-14C&gt;T</td>
<td>c.[41-14C&gt;T][41-14C&gt;T]</td>
<td>C977T</td>
</tr>
<tr>
<td>non-coding</td>
<td>77C&gt;T</td>
<td>c.31A&gt;T</td>
<td>c.31A&gt;T</td>
<td>c.[31A&gt;T][31A&gt;T]</td>
<td>A77T</td>
</tr>
<tr>
<td>coding</td>
<td>831C&gt;CT</td>
<td>IVS4-466C&gt;CT</td>
<td>c.[+2,466C&gt;T]</td>
<td>c.[45466C&gt;T][+]</td>
<td>CN11Y</td>
</tr>
<tr>
<td>non-coding</td>
<td>800CA</td>
<td>c.340CA</td>
<td>c.[+2,103A&gt;]</td>
<td>c.[340CA][+]</td>
<td>C8BM</td>
</tr>
<tr>
<td>coding</td>
<td>211delT</td>
<td>IVS774+4delT</td>
<td>c.59+4delT</td>
<td>c.71+4delT</td>
<td>211d</td>
</tr>
<tr>
<td>non-coding</td>
<td>18.30delTT</td>
<td>c.72.34delTT</td>
<td>c.59_61delTT</td>
<td>c.72.74delTT</td>
<td>18.30 delTT</td>
</tr>
<tr>
<td>coding</td>
<td>133.134delTA</td>
<td>IVS714+21_137het_delTA</td>
<td>c.59+16_58+137het_delTA</td>
<td>c.71+16_71+137het_delTA</td>
<td>133.134delTA</td>
</tr>
<tr>
<td>non-coding</td>
<td>14_15het_yaaT</td>
<td>c.69_69het_yaaT</td>
<td>c.59_59het_yaaT</td>
<td>c.69_69het_yaaT</td>
<td>13.15Y</td>
</tr>
</tbody>
</table>

Note: If any one of the four standard Nomenclature options is selected and a GenBank file was not loaded as the reference file, then the Base Number is enclosed in parenthesis and it indicates the position of the base in the reference file. If both a GenBank file and a reference file were loaded for the mutation project and the mutation was called at a position that does not align to the GenBank file, then the Base Number is enclosed in parenthesis and is displayed as +/- the number of base pairs by which the mutation was shifted in comparison to the GenBank file.
Other tab

The Other tab contains options that affect the report display as well as processing options for the report.

Figure 6-12: Custom Report Settings dialog box, Other tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output</strong></td>
<td></td>
</tr>
<tr>
<td>Save Processing Settings with Report</td>
<td>Saves all the settings that you selected for the report as part of the report output.</td>
</tr>
<tr>
<td>Save Excel Format as Text</td>
<td>Saves the Custom report as an Excel file with all the data columns formatted as Text.</td>
</tr>
</tbody>
</table>
| Save VCF Report                             | • Save as One Report—Selected by default. Generate a single VCF report that includes the information for all the sample groupings.  
• Save Each Group as Individual Reports—Generate a VCF report for each sample grouping.  
  **Note:** Remember, you specify the sample grouping on the Format tab. See “Format tab” on page 166. |
| **Other Settings**                          |                                                                             |
| Enable “Hide Selected Rows/Columns”         | Enables on the Hide Columns and Hide Rows function on the Custom report context menu. See “Custom Report viewing and analysis options” on page 181. |
Chapter 6
Mutation Surveyor Custom Report

Custom Report toolbar

The Custom report toolbar contains buttons that are specific for working with the report and for changing the information that is displayed in the report.

*Figure 6-13: Custom report toolbar*

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Save" /></td>
<td>Save—Opens the Save Report As dialog box in which you can specify a name for the saved report as well as its format (.vcf, .xls/.xlsx, or .txt). The default location is %localappdata%\SoftGenetics\MutationSurveyor\Report, but you can select a different location.</td>
</tr>
<tr>
<td><img src="Image" alt="Settings" /></td>
<td>Settings—Opens the Custom Report Settings dialog box in which you can adjust your report settings.</td>
</tr>
<tr>
<td><img src="Image" alt="Print" /></td>
<td>Print—Opens the custom report in the Print Custom Report window. The window toolbar contains buttons for working with the report and for printing the report.</td>
</tr>
</tbody>
</table>

*Figure 6-14: Print Custom Report window*

- Print button —Opens the Print dialog box in which you can specify the options for printing the Custom report. By default, only the page that is currently displayed in the Print Custom Report window is selected for printing. You can leave the default as is, or you can select the entire report or a range of pages for printing.
- Display Previous and Display Next buttons—Use these buttons to Browse forward and backward through the Custom report one page at a time.
- Page Setup button —Opens the Page Setup dialog box in which you can specify the page properties of the report pages (such as page size and orientation) for printing.
Custom Report viewing and analysis options

A context menu is available for the Custom report. You use the options on this menu to change the view of the Custom report and to manipulate and analyze mutation project data so that you identify the true mutations in a mutation project. To open the context menu, right-click anywhere in the Custom report.

Figure 6-15: Custom report context menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Copy                     | Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.  
  **Note:** You can also copy the Custom report as an image. Press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application. |
| Confirm                  | Confirms the selected mutations.  
  **Note:** SHIFT-click to select multiple contiguous mutations for confirmation or to select all mutations in a column for confirmation.  
  The text for the mutation code turns black in both the Custom report and the Mutation table in the GAD. The comment <<Checked>> is displayed in the Actions field for the mutation call in the Mutation table in the GAD. |
| Undo Confirmation        |                                                                                                                                               |
| Delete Mutations         |                                                                                                                                               |
| Undo Deletion            |                                                                                                                                               |
| Delete Lane              |                                                                                                                                               |
| Undo Deletion            |                                                                                                                                               |
| Hide Selected Rows       |                                                                                                                                               |
| Hide Selected Columns    |                                                                                                                                               |
| Undo Last Hide Rows/Columns |                                                                                                                                                |
| Undo                     |                                                                                                                                               |
| View Edit History        |                                                                                                                                               |
| Hyperlink to NCBI's dbSNP |                                                                                                                                               |
Chapter 6
Mutation Surveyor Custom Report

Other options include the following:

- To open the GAD for the trace that contains a mutation, double-click the mutation in the Custom report.

If you click a trace in the GAD with the Custom report open, the GAD is brought to the front. To bring the Custom report to the front again, press [CTRL]-T.

- To select all cells in the Custom report in a single step, press [CTRL]-A.

- To auto-scale the width of a column to its largest entry, double-click the first cell in the column.

If you auto-scale the report after selecting all the cells in the report, you can resize the entire report easily in a single step.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo Confirmation</td>
<td>Removes the “Confirmed” status for a selected mutation or a selected column.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> SHIFT-click to select multiple contiguous mutations for confirmation or to select all mutations in a column for confirmation.</td>
</tr>
<tr>
<td>Delete Mutations</td>
<td>Deletes the selected mutations.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> SHIFT-click to select multiple contiguous mutations for deletion, to select all mutations in a column for deletion, or to select multiple rows for deletion. The text for the mutation code turns gray in both the Custom report and the Mutation table in the GAD. The comment &lt;&lt;Deleted&gt;&gt; is displayed in the Actions field for the mutation call in the Mutation table in the GAD.</td>
</tr>
<tr>
<td>Undo Deletion</td>
<td>Removes the “Deleted” status for a selected mutation, a selected column, or a selected row.</td>
</tr>
<tr>
<td>Delete Lane</td>
<td>Deletes all the mutations for a selected sample in a single step. The Lane Quality for a deleted lane is set to “Low Quality.”</td>
</tr>
<tr>
<td>Undo Lane Detection</td>
<td>The Lane Quality for the lane is reset to its original value.</td>
</tr>
<tr>
<td>Hide Selected Rows</td>
<td>Enabled if “Enable Hide Selected Rows/Columns” is selected on the Other tab. (See “Other tab” on page 179.)</td>
</tr>
<tr>
<td>Hide Selected Columns</td>
<td>Enabled if “Enable Hide Selected Rows/Columns” is selected on the Other tab. (See “Other tab” on page 179.)</td>
</tr>
<tr>
<td>Undo Last Hide Rows/Columns</td>
<td>Enabled if selected rows and/or columns are hidden in the Custom report.</td>
</tr>
<tr>
<td>Undo</td>
<td>Undo the last edit action that was carried out for the mutation.</td>
</tr>
<tr>
<td>View Edit History</td>
<td>See “Viewing the Edit History (Audit Trail) for a Mutation” on page 344.</td>
</tr>
<tr>
<td>Hyperlink to NCBI’s dbSNP</td>
<td>Opens the NCBI’s database entry (via the web) for the variant.</td>
</tr>
</tbody>
</table>
Chapter 7
Mutation Surveyor Customer Reports

Customer reports are another type of custom report in Mutation Surveyor. Each report was initially developed as a template to provide custom content that met a specific customer’s needs. All these report templates are now available from the Reports > Customer Reports option on the Mutation Surveyor main menu.

This chapter covers the following topics:

- “JHU report” on page 185.
- “Tassel report” on page 190.
- “Emory report” on page 193.
- “Bentley report and MSM_Song report” on page 196.
- “PrettyBase report” on page 200.
- “Methylation report” on page 203.
- “Vertex report” on page 207.
- “Vertex2 report” on page 209.
- “Vertex3 report” on page 212.
- “Full Gene report” on page 215.
- “FullBase report” on page 222.
JHU report

The JHU report displays various quality scores for a defined ROI organized by paired sample traces. The layout of the JHU Output report is identical to the layout of the Two Direction report. (See “Two Direction report layout” on page 134.) The mutation codes, and the color coding of the mutation calls in the report are identical to the mutation codes and color coding in the Mutation report (See “Mutation report fields” on page 128, “Mutation report codes” on page 129, and “Color codes” on page 130.) The JHU report contains fields that are specific to the report as well as all the fields that are displayed in any of the standard mutation reports.

Figure 7-1: JHU report

![JHU report screenshot]
## JHU Report toolbar

The JHU report toolbar contains buttons that are specific for working with the report and for changing the information that is displayed in the report.

![JHU report toolbar](image)

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy—Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.</td>
</tr>
<tr>
<td><img src="image" alt="Save Report" /></td>
<td>Save Report—Opens the Save Report As dialog box in which you can specify a name and location for saving the report as well as its format (.txt, .xls/.xlsx, .xml, or .htm).</td>
</tr>
<tr>
<td><img src="image" alt="Undo Latest Deletions" /></td>
<td>Undo Latest Deletions—Restores the deletion that you last carried out in the JHU report. Allows for multiple undos.</td>
</tr>
<tr>
<td><img src="image" alt="Report Settings" /></td>
<td>Report Settings—Opens the JHU Report Settings dialog box which contains options for filtering the information that is to be displayed in the report. See “JHU report settings” on page 187.</td>
</tr>
<tr>
<td><img src="image" alt="Display the Sequence of ROI" /></td>
<td>Display the Sequence of ROI—Generates an onscreen text file of the sequences in the GenBank ROIs.</td>
</tr>
</tbody>
</table>

![Sequence in Region of Interest window](image)

- Save button —Opens the Save Sequence Text As dialog box in which you can specify a name and location for saving the .txt file.
- Display Sequence in One Line button —Displays the sequences in fasta format.

| Lock Sample File in View | Freezes the Sample Filename column while scrolling. |
JHU report viewing and analysis options

The JHU report has multiple options available for changing the view of the report and for manipulating and analyzing mutation project data. These options are:

- The JHU report settings. See “JHU report settings” below.
- The JHU report context menu. See “JHU report context menu” on page 188.

JHU report settings

To open the JHU Report Settings dialog box, click the Report Settings button on the JHU report toolbar.

Figure 7-4: JHU Report Settings dialog box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Homozygous Dropping Threshold</strong></td>
<td>Indicates the value for the dropping factor at which a mutation is identified as either a homozygous substitution or a heterozygous substitution. For example, is a mutation A&gt;C or A&gt;AC? Because Mutation Surveyor evaluates the traces rather than the base calls, noise below a major peak can sometimes be interpreted as a heterozygous substitution. This value assists in your analysis by converting these calls to homozygous substitutions. <strong>Note:</strong> You can increase this value to view the exact call that Mutation Surveyor made, but an increased value might result in some calls remaining as heterozygous substitutions.</td>
</tr>
<tr>
<td><strong>Phred Score Threshold</strong></td>
<td>Call a mutation only if the Phred score for the variant base or bases is greater than the indicated threshold.</td>
</tr>
<tr>
<td><strong>ROI Boundaries</strong></td>
<td>Affects the values that are output to the Start (ROI) and End (ROI) column for traces that do not have complete coverage of the Region of Interest. For example, an ROI is set for positions 50 to 150 (Expected value). The sample trace's comparison region is positions 100 to 200. Only positions 100 to 150 of the ROI are within the comparison region (Actual value) whereas positions 50-99 are not covered.</td>
</tr>
<tr>
<td><strong>Output Confidence Mark for JHU</strong></td>
<td>Displays a Confidence mark (!) for mutation calls that exceed certain thresholds that are defined in the MutationSurveyor.ini file. <strong>Note:</strong> Although you can modify these thresholds, SoftGenetics does not recommend that you do so on your own. Contact SoftGenetics for assistance.</td>
</tr>
</tbody>
</table>
Chapter 7
Mutation Surveyor Customer Reports

JHU report context menu

A context menu is available for the JHU report. You use the options on this menu to change the view of the JHU report and to manipulate and analyze mutation project data so that you identify the true mutations in a mutation project. To open the context menu, right-click anywhere in the JHU report.

Figure 7-5: JHU report context menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Copy                          | Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.  
**Note:** You can also copy the JHU report as an image. Press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application. |
| Confirm                       | Confirms the selected mutations.  
**Note:** SHIFT-click to select multiple contiguous mutations to select all mutations in a column.  
The text for the mutation code turns black in both the JHU report and the Mutation table in the GAD. The comment <<Checked>> is displayed in the Actions field for the mutation call in the Mutation table in the GAD. |
| Undo Confirmation             | Removes the “Confirmed” status for the mutation.  
**Note:** SHIFT-click to select multiple contiguous mutations or to select all mutations in a column. |
| Sort By Score (Descending)    | Click the appropriate option to sort all the data by descending mutation score. |
| Sort by Score (Ascending)     | Click the appropriate option to sort all the data by ascending mutation score. |
You can also view the information for a mutation in the JHU report in the GAD. To open the GAD for the trace that contains a mutation, double-click the mutation in the report.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Mutations</td>
<td>Deletes the selected mutations.</td>
</tr>
<tr>
<td><strong>Note:</strong> SHIFT-click to select multiple contiguous mutations, to select all mutations in a column, or to select multiple rows. The text for the mutation code turns gray in both the JHU report and the Mutation table in the GAD. The comment &lt;&lt;Deleted&gt;&gt; is displayed in the Actions field for the mutation call in the Mutation table in the GAD. <strong>Note:</strong> To undo the last deletion that you carried out, click the Undo Latest Deletions button on the report toolbar.</td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>Undo the last edit action that was carried out for the mutation.</td>
</tr>
<tr>
<td>View Edit History</td>
<td>See “Viewing the Edit History (Audit Trail) for a Mutation” on page 344.</td>
</tr>
</tbody>
</table>
Tassel report

The Tassel report is ideal for identifying mutations in your sample traces if your traces are grouped by Sample ID (see “Sample ID” on page 168) or if all the filenames in your project contain the same characters/designator but in different positions. After you click Tassel Report on the Customer Reports menu, the Tassel Report Settings dialog box opens.

Figure 7-6:  Tassel Report Settings dialog box

1. Do one of the following:
   • If all the filenames in your project contain the same character string/designator in the same positions, then select From Character [ ] To Character [ ] and enter the starting and ending character positions of the characters/designator.
   • If all the filenames in your project contain the same character string /designator but in different positions, then select Typical Block and enter the character string/designator.

2. Click OK.

The Tassel report is generated.

Figure 7-7:  Tassel report
The layout of the Tassel report is somewhat similar to the layout of the Two Direction Output report. (See “Two Direction report layout” on page 134.) The similarities between the Tassel report and any of the other standard reports, however, ends there. In the Tassel report:

- Cells showing a novel variant that results in a change to the amino acid sequence are displayed in pink.
- Cells showing a reported variant that results in a change to the amino acid sequence are displayed in lime green.
- A lowercase letter indicates a 1D mutation, while an uppercase letter indicates a 2D mutation.
- If a mutation is a substitution, then the standard IUPAC code for the variant base or bases is displayed for the mutation.
- If a mutation is a deletion, then a zero (0) is displayed for the mutation.

You can also view the information for a mutation in the Tassel report in the GAD. To open the GAD for the trace that contains a mutation, double-click the mutation in the report.

### Tassel report toolbar

The Tassel report toolbar contains just two buttons for working with the report.

**Figure 7-8: Tassel report toolbar**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Copy](image) | Copy—Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.  
**Note:** You can also copy the Tassel report as an image. Press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application. |
| ![Save Report](image) | Save Report—Opens the Save Report As dialog box in which you can specify a name and location for saving the report as well as its format (.txt, .xls/.xlsx, xml, or .htm). |

### Tassel report viewing and analysis options

Although the Tassel report does not have a context menu, you can still copy the report as an
image. You can also view the information for a mutation in the report in the GAD.

- To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.

- To open the GAD for the trace that contains a mutation, double-click the mutation in the report.
Chapter 7
Mutation Surveyor Customer Reports

Emory report

The layout of the Emory report is very similar to the layout of the Two Direction report. (See “Two Direction report layout” on page 134.) The mutation codes and the color coding of the mutation calls in the report are identical to the mutation codes and color coding in the Mutation report (See “Mutation report codes” on page 129 and “Color codes” on page 130.) The Emory report, however, displays only the quality score and the number of mutations for each sample.

Figure 7-9: Emory report

Emory report toolbar

The Emory report toolbar contains just two buttons for working with the report and an option to control the display while scrolling the report.

Figure 7-10: Emory report toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy—Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.</td>
</tr>
<tr>
<td><img src="image" alt="Save Report" /></td>
<td>Save Report—Opens the Save Report As dialog box in which you can specify a name and location for saving the report as well as its format (.txt, .xls/.xlsx, .xml, or .htm).</td>
</tr>
<tr>
<td><img src="image" alt="Lock Sample File in View" /></td>
<td>Lock Sample File in View—Freezes the Sample Filename column while scrolling.</td>
</tr>
</tbody>
</table>
Emory report viewing and analysis options

A context menu is available for the Emory report. You use the options on this menu to change the view of the Emory report and to manipulate and analyze mutation project data so that you identify the true mutations in a mutation project. To open the context menu, right-click anywhere in the Emory report.

*Figure 7-11: Emory report context menu*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Copy                      | Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.  
*Note:* You can also copy the Emory report as an image. Press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application. |
| Confirm                   | Confirms the selected mutations.  
*Note:* SHIFT-click to select multiple contiguous mutations or to select all mutations in a column.  
The text for the mutation code turns black in both the Emory report and the Mutation table in the GAD. The comment &lt;Checked&gt; is displayed in the Actions field for the mutation call in the Mutation table in the GAD. |
| Undo Confirmation         | Removes the “Confirmed” status for the mutation.  
*Note:* SHIFT-click to select multiple contiguous mutations or to select all mutations in a column. |
## Chapter 7
Mutation Surveyor Customer Reports

### Option | Description
--- | ---
**Sort By Score**
(Descending) | Click the appropriate option to sort all the data by descending mutation score or ascending mutation score.

**Delete Mutations** | Deletes the selected mutations.  
**Note:** SHIFT-click to select multiple contiguous mutations, to select all mutations in a column, or to select multiple rows.  
The text for the mutation code turns gray in both the Emory report and the Mutation table in the GAD. The comment <<Deleted>> is displayed in the Actions field for the mutation call in the Mutation table in the GAD.

**Delete Lane** | Deletes all the mutations for a selected sample in a single step. The Lane Quality for a deleted lane is set to “Low Quality.”

**Undo Lane Deletion** | The Lane Quality for the lane is reset to its original value.

**Undo** | Undo the last edit action that was carried out for the mutation.

**View Edit History** | See “Viewing the Edit History (Audit Trail) for a Mutation” on page 344.

**Hyperlink to NCBI’s dbSNP** | Opens the NCBI’s database entry (via the web) for the variant.

---

You can also view the information for a mutation in the Emory report in the GAD. To open the GAD for the trace that contains a mutation, double-click the mutation in the report.
Bentley report and MSM_Song report

The Bentley and MSM_Song reports are useful when carrying out analyses of diploid samples. Both reports show the genomic position of the mutation, the genotype, and the frequency of each allele by traces and as a grand total.

For a detailed explanation of allele frequency by trace and grand total allele frequency, see “Show Allele Information” on page 169.

The layout of the reports is very similar to the layout of the Two Direction Output report. (See “Two Direction report layout” on page 134.) Both of the reports contain the same fields that are displayed in any of the standard mutation reports. There are few minor differences between the Bentley report and the MSM_Song report:

- By default, the MSM_Song report displays the entire sequence of the GenBank file in the top row of the report. The Bentley does not.
- In both reports, the mutation call is split between two columns, with the first column displaying a summary for a specific position and the second column displaying the genotype for each sample file. The format, however, for these two columns differs slightly between the reports.

Figure 7-12: Bentley report

Figure 7-13: MSM_Song report
Bentley/MSM_Song report toolbar

The Bentley toolbar and the MSM_Song toolbar contain the same buttons that are specific for working with the reports and for changing the information that is displayed in the reports.

Figure 7-14:  Bentley/MSM_Song report toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Copy](image) | Copy—Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.  
Note: You can also right-click and select Copy to copy the selected text to your clipboard.  
Note: You can also copy both output reports as an image. Press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application. |
| ![Save Report](image) | Save Report—Opens the Save Report As dialog box in which you can specify a name and location for saving the report as well as its format (.txt, .xls/.xlsx, .xml, or .htm). |
| ![Report Settings](image) | Report Settings—Opens the Report Settings dialog box which contains options for filtering the information that is to be displayed in the report. See “Bentley/MSM_Song report settings” on page 198. |

Bentley/MSM_Song reports viewing and analysis options

The Bentley and MSM_Song reports have several options available for changing the view of the reports and for manipulating and analyzing mutation project data. These options are:

- The Bentley/MSM_Song report settings. See “Bentley/MSM_Song report settings” on page 198.
- The Bentley/MSM_Song report context menu. See “Bentley/MSM_Song reports context menu” on page 198.
Bentley/MSM_Song report settings

*Figure 7-15:  Bentley/MSM_Song Report Settings dialog box*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>• Lane Number—Selected by default. Clear this option if you do not want the Lane Number to be displayed in the report.</td>
<td></td>
</tr>
<tr>
<td>• Well Position—Selected by default. Clear this option if you do not want the Well Position to be displayed in the report.</td>
<td></td>
</tr>
<tr>
<td>• Mut#—Selected by default. Clear this option if you do not want the mutation number to be displayed in the report.</td>
<td></td>
</tr>
<tr>
<td>• Sequence of GenBank File</td>
<td></td>
</tr>
<tr>
<td>• Not selected by default for the Bentley Output report—Select this option if you want the entire sequence of the GenBank file to be displayed in the top row of the report.</td>
<td></td>
</tr>
<tr>
<td>• Selected by default for the MSM_Song Output report—Clear this option if you do not want the entire sequence of the GenBank file to be displayed in the top row of the report.</td>
<td></td>
</tr>
<tr>
<td><strong>Mutation Filter</strong></td>
<td></td>
</tr>
<tr>
<td>Display Mutations with the “Stop” Codon or Indel Only</td>
<td>Display only nonsense mutations and indels in the report.</td>
</tr>
</tbody>
</table>

Bentley/MSM_Song reports context menu

Although the Bentley and MSM_Song reports do not have a full context menu, you can still copy text from each report, or copy each report as an image. You can also view the information for a mutation in the reports in the GAD.

• Select the text that you want to copy or to copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Right-click and select Copy to copy the selected text to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.

• To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then...
click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.

• To open the GAD for the trace that contains a mutation, double-click the mutation in the report.
Chapter 7
Mutation Surveyor Customer Reports

PrettyBase report

The PrettyBase format was developed by the SeattleSNPs project for easily representing SNP information for groups of subjects over a given span of reference sequence. The report displays the following information (in order from left to right)—SNP Position, Sample Name, Normal Allele, Allele 1, Allele 2, IUPAC code for the mutation call, Mutation Call, Comments, Phred Score, and NM_Score.

Figure 7-16: PrettyBase report

PrettyBase report toolbar

The PrettyBase report toolbar contains buttons that are specific for working with the report and for changing the information that is displayed in the report.

Figure 7-17: PrettyBase report toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="button.png" alt="Copy" /></td>
<td>Copy—Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.</td>
</tr>
<tr>
<td><img src="button.png" alt="Save Report" /></td>
<td>Save Report—Opens the Save Report As dialog box in which you can specify a name and location for saving the report as well as its format (.txt, .xls/.xlsx, .xml, or .htm).</td>
</tr>
<tr>
<td><img src="button.png" alt="Report Settings" /></td>
<td>Report Settings—Opens the PrettyBase Report Settings dialog box which contains options for filtering the information that is to be displayed in the report. See “PrettyBase report settings” on page 201.</td>
</tr>
</tbody>
</table>
PrettyBase report viewing and analysis options

The PrettyBase report has multiple options available for changing the view of the report and for manipulating and analyzing mutation project data. These options are:

- The PrettyBase report settings. See “PrettyBase report settings” below.

PrettyBase report settings

To open the PrettyBase Report Settings dialog box, click the Report Settings button on the PrettyBase report toolbar.

*Figure 7-18: PrettyBase Report Settings dialog box*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display</strong></td>
<td></td>
</tr>
<tr>
<td>Mutations Only</td>
<td>• Mutations Only—Selected by default. Show only all called mutations</td>
</tr>
<tr>
<td></td>
<td>• Mutations and Negative Mutations—Select this option to show all called mutations and negative mutations.</td>
</tr>
<tr>
<td></td>
<td>• All Positions (in ROI)—Select this option to show all nucleotide positions within defined ROIs.</td>
</tr>
<tr>
<td><strong>Mutation Filter</strong></td>
<td></td>
</tr>
<tr>
<td>Display Mutations with the “Stop” Codon or Indel Only</td>
<td>Display only nonsense mutations and indels in the report.</td>
</tr>
</tbody>
</table>
Although the PrettyBase report does not have a full context menu, you can still copy text from the report, or copy the report as an image. You can also view the information for a mutation in the report in the GAD.

- Select the text that you want to copy or to copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Right-click and select Copy to copy the selected text to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.

- To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.

- To open the GAD for the trace that contains a mutation, double-click the mutation in the report.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phred Score</td>
<td>All four of these columns are displayed by default in the PrettyBase Output report. Clear any or all options that you do want to be displayed in the report.</td>
</tr>
<tr>
<td>NM_Score</td>
<td>For information about the NM_Score, see “NM_Score” on page 174.</td>
</tr>
<tr>
<td>Normal Allele</td>
<td></td>
</tr>
<tr>
<td>Mutation Call</td>
<td></td>
</tr>
</tbody>
</table>

PrettyBase report context menu

Although the PrettyBase report does not have a full context menu, you can still copy text from the report, or copy the report as an image. You can also view the information for a mutation in the report in the GAD.

- Select the text that you want to copy or to copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Right-click and select Copy to copy the selected text to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.

- To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.

- To open the GAD for the trace that contains a mutation, double-click the mutation in the report.
Methylation report

How Mutation Surveyor calls mutations for methylated DNA assumes 100% conversion of the non-methylated cytosines to uracil during bisulfite treatment. The evaluation of the methylation level in CpG islands as well as the level of incomplete conversion of unmethylated cytosines, however, is critical for ensuring that your methylation project has the necessary high quality data that is required for accurate mutation calls. The Methylation report displays information for methylation detection projects. The report distinguishes between cytosines that are contained in CpG islands and cytosines that are contained in other sequences. The report also displays a Conversion ratio, which is the ratio of the number of samples that were successfully converted at a given position to the total number of samples with the position. A Conversion Ratio of 100% indicates that the conversion was successful for all samples at the given position.

Figure 7-19: Methylation report

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Cytosines contained in CpG islands</td>
</tr>
<tr>
<td></td>
<td>• M—Methylated</td>
</tr>
<tr>
<td></td>
<td>• U—Non-methylated</td>
</tr>
<tr>
<td>S</td>
<td>Cytosines contained in other sequences</td>
</tr>
<tr>
<td></td>
<td>• S—Successful conversion of cytosine (C) to thymine (T)</td>
</tr>
<tr>
<td>I</td>
<td>• I—Incomplete conversion</td>
</tr>
</tbody>
</table>
Chapter 7
Mutation Surveyor Customer Reports

Methylation report toolbar

The Methylation report toolbar contains buttons that are specific for working with the report and for changing the information that is displayed in the report.

**Figure 7-20:  Methylation report toolbar**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save Report" /></td>
<td>Save Report—Opens the Save Report As dialog box in which you can specify a name and location for saving the report as a tab-delimited .txt file.</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy—Copies the selected text in the cell to your clipboard. To copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.</td>
</tr>
<tr>
<td><img src="image" alt="Report Settings" /></td>
<td>Report Settings—Opens the Methylation Report Settings dialog box which contains options for filtering the information that is to be displayed in the report.</td>
</tr>
</tbody>
</table>

**Figure 7-21:  Methylation Report Settings dialog box**

- Homozygous Dropping Threshold—Indicates the value for the dropping factor at which a mutation is identified as either a homozygous substitution or a heterozygous substitution. For example, is a mutation A>C or A>AC? Because Mutation Surveyor evaluates the traces rather than the base calls, noise below a major peak can sometimes be interpreted as a heterozygous substitution. This value assists in your analysis by converting these calls to homozygous substitutions.

**Note:** You can increase this value to view the exact call that Mutation Surveyor made, but an increased value might result in some calls remaining as heterozygous substitutions.

- Mutation Dropping Threshold—The dropping threshold must be greater than or equal to the specified value for the variant to be called a mutation. See “Dropping Factor” on page 60.

| ![Graphic Display](image) | Graphic Display—Opens the Graphic Display of Methylation report. See “Graphic Display of Methylation report” on page 205. |
Graphic Display of Methylation report

The Graphic Display of Methylation report graphically shows the pattern of methylated and non-methylated cytosines along the DNA fragments used for analysis. By default, when the report first opens, only cytosines that are part of a CpG island are indicated in the report. Red tick marks indicate methylated sites. Dark blue tick marks indicate non-methylated sites. The Methylation Ratio graph represents the percentage of samples that are methylated at the indicated position in a CpG island. The Conversion Ratio graph represents the percentage of samples that were converted at the indicated position outside of a CpG island.

Figure 7-22:  Graphic Display of Methylation report

The report is interactive:

- To view the cytosines that are contained in other sequences, click Display S/I. Light blue tick marks indicate successful conversion of cytosine (C) to uracil (U). Gray tick marks indicate incomplete conversion.

- To zoom in on a selected region, click and hold the left mouse button and draw a box from the upper left hand corner of the region towards the lower right hand corner of the region. A box is formed around the area that is being reduced for viewing.

- To zoom out from any region, click and hold the left mouse button and draw a box from the lower right hand corner of the region towards the upper left hand corner of the region. The magnification for zooming out is always 100%.

- If your mutation project used multiple GenBank files, then select one of these files from the Select GenBank file to view the display for the file and the sample files that align to it.

- By default, the filenames for all the files (GenBank, reference files, and sample files) are
displayed on the report. To remove the filenames from the report display, clear the Show Filenames option.

Methylation report context menu

Although the Methylation report does not have a full context menu, you can still copy text from the report, or copy the report as an image. You can also view the information for a mutation in the report in the GAD.

• Select the text that you want to copy or to copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Right-click and select Copy to copy the selected text to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.

• To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.

• To open the GAD for the trace that contains a mutation, double-click the mutation in the report.
Vertex report

The Vertex report displays mutations in all the sample sequences for a selected contig. By default, the mutations are shown as the 1 Letter IUPAC representation of the normal amino acid that is affected by the mutation and the resulting amino acid. Also by default, the entire sequence of the GenBank file is displayed at the top of the report.

Figure 7-23: Vertex report

The report is interactive:

- To view the amino acid sequences for the sample traces in a different contig, select the contig from the Select Contig list.
- To display the 3 Letter IUPAC representation for the amino acids, select Three Letter.
- To toggle between the amino acids and the called bases for the mutation, clear/select Show Amino Acid. (Like the amino acid codes, the called bases are represented by their IUPAC codes.)
- To zoom in on a selected region of the GenBank file, click and hold the left mouse button and draw a box from the upper left hand corner of the region towards the lower right hand corner of the region. A box is formed around the area that is being reduced for viewing.
- To zoom out from the GenBank file, click and hold the left mouse button and draw a box from the lower right hand corner of the sequence towards the upper left hand corner of the sequence. The magnification for zooming out is always 100%.
- To save the report as an .xls/.xlsx or .txt file, click the Save Report icon on the report toolbar. A Save Report As dialog box opens in which you can specify the name, format and location for the saved report. (The .txt format is available only when saving the nucleotide sequence for the report. The .xls/.xlsx format is available only when saving the amino acid sequence for the report.)
- To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to
copy the image to your clipboard. Use standard keyboard commands or menu commands
to paste the copied image into an application.
Vertex2 report

You use the Vertex2 report to assemble variations from multiple sequences or samples within one or multiple projects. The Vertex2 report is especially useful for analyzing hypervariable sequences. After you click Vertex2 Report on the Customer Reports menu, the Vertex Report Settings dialog box opens. You can leave the default values as is, or you can modify any of the values as needed, and then click OK to generate the report.

*Figure 7-24:  Vertex Report Settings dialog box*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sample Grouping</strong>—Determines how traces are to be grouped in the report.</td>
<td></td>
</tr>
<tr>
<td>From Character [ ] To Character [ ]</td>
<td>Select this option if all the filenames in your project contain the same character string/designator in the same positions.</td>
</tr>
<tr>
<td>From File—Select this option if traces that are to be grouped together contain a common Sample ID in their filenames. (The Sample IDs do not need to be in the same location in the filename.) After you click From File, click Load Sample ID to open the Load Sample ID dialog box and specify the different Sample IDs, such as Patient #, by which to group the traces. You can also click Open in the Load Sample ID dialog box to load an existing Sample ID text file.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> By default, the Load Sample ID dialog box contains rows for up to ten different Sample IDs. You can right-click and click Insert or Delete as needed.</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 7-25:  Load Sample ID dialog box*
Chapter 7
Mutation Surveyor Customer Reports

Table 7-6: Mutation Output Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heterozygous Call From [ ] To [ ]</td>
<td>A mutation call with a dropping factor that falls within the specified range is classified as a heterozygous mutation call. It is classified as a homozygous normal allele if its dropping factor falls below the lower threshold and as a homozygous mutation if its dropping factor exceeds the upper threshold.</td>
</tr>
<tr>
<td>Output Confirmed Mutations Only</td>
<td>Display only manually confirmed mutations in the report.</td>
</tr>
<tr>
<td>Output Comments</td>
<td>Display automatically added and manually added comments in the report.</td>
</tr>
</tbody>
</table>

Table 7-7: Sequence Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Amino Acid—Show the 1 Letter IUPAC representation of the normal amino acid that is affected by the mutation and the resulting amino acid.</td>
<td></td>
</tr>
<tr>
<td>Show Nucleotide—Show the IUPAC codes for the called bases for the mutation.</td>
<td></td>
</tr>
<tr>
<td>Three Letters—Available only if Show Amino Acid is selected. Show the 3 Letter representation of the normal amino acid that is affected by the mutation and the resulting amino acid.</td>
<td></td>
</tr>
<tr>
<td>Output Nucleotide Change—Display only those traces with called mutations in the report.</td>
<td></td>
</tr>
<tr>
<td>Output Amino Acid Change Only—Display only those traces with called mutations in the report, and for these traces, display the 1 Letter or 3 Letter IUPAC representation of the normal amino acid that is affected by the mutation and the resulting amino acid.</td>
<td></td>
</tr>
<tr>
<td>Output Consensus Sequence—Display the consensus sequence for all sample traces in the report.</td>
<td></td>
</tr>
<tr>
<td>Output Sample Sequences—Display the sequence for each individual sample trace in the report.</td>
<td></td>
</tr>
</tbody>
</table>

Figure 7-26: Vertex2 report
Vertex2 report toolbar

The Vertex2 report toolbar contains just two buttons for working with the report.

Figure 7-27: Vertex2 report toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save Report" /></td>
<td>Save Report—Opens the Save Report As dialog box in which you can specify a name and location for saving the report as well as its format (.xls/.xlsx or .txt).</td>
</tr>
<tr>
<td><img src="image" alt="Report Settings" /></td>
<td>Report Settings—Opens the Vertex2 Report Settings dialog box which contains options for grouping and filtering the information that is to be displayed in the report. See &quot;Vertex2 report&quot; on page 209.</td>
</tr>
</tbody>
</table>

Vertex2 report viewing and analysis options

Although the Vertex2 report does not have a context menu, you can copy the report as an image. You can also view the information for a mutation in the report in the GAD.

- To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.
- To open the GAD for the trace that contains a mutation, double-click the mutation in the report.
### Vertex3 report

Like the Vertex2 report, you can use the Vertex3 report to assemble variations from multiple sequences or samples within one or multiple projects. After you click Vertex3 Report on the Customer Reports menu, the Vertex3 Report Settings dialog box opens. You can leave the default values as they are, or you can modify any of the values as needed, and then click OK to generate the report.

**Figure 7-28: Vertex Report Settings dialog box**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sample Grouping</strong></td>
<td>Determines how traces are to be grouped in the report.</td>
</tr>
<tr>
<td></td>
<td>• From Character [ ] To Character [ ]—Select this option if all the filenames in your project contain the same character string/designator in the same positions.</td>
</tr>
<tr>
<td></td>
<td>• From File—Select this option if traces that are to be grouped together contain a common Sample ID in their filenames. (The Sample IDs do not need to be in the same location in the filename.) After you click From File, click Load Sample ID to open the Load Sample ID dialog box and specify the different Sample IDs, such as Patient #, by which to group the traces. You can also click Open in the Load Sample ID dialog box to load an existing Sample ID text file.</td>
</tr>
</tbody>
</table>

**Note:** By default, the Load Sample ID dialog box contains rows for up to ten different Sample IDs. You can right-click and click Insert or Delete as needed.

*Figure 7-29: Load Sample ID dialog box*
Chapter 7
Mutation Surveyor Customer Reports

Vertex3 report layout

The Vertex3 report is organized by Clone (Sample) ID and contains three sections for each Sample ID:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nucleotide Sequences</td>
<td>Displays the reference nucleotide sequence for the samples and the consensus nucleotide sequence for the samples.</td>
</tr>
<tr>
<td>Nucleotide Changes</td>
<td>Displays a list of each location that contains a variation between the reference nucleotide and the sample nucleotide, the reference nucleotide at the location, the sample nucleotide at the location and a column denoting whether the variant is synonymous (S) or non-synonymous (N).</td>
</tr>
<tr>
<td>Amino Acid</td>
<td>Displays the codon number, the reference amino acid and the consensus amino acid for each non-synonymous variation.</td>
</tr>
</tbody>
</table>

Figure 7-30: Vertex3 report
Chapter 7
Mutation Surveyor Customer Reports

Vertex3 report toolbar

The Vertex3 Report toolbar contains a single button on the toolbar—the Save Report button.
Click this button to open a Save Report As dialog box in which you can specify the name and location for saving the report as a .txt file.

Vertex3 report viewing and analysis options

Although the Vertex3 report does not have a full context menu, you can still copy text from the report, or copy the report as an image.

• Select the text that you want to copy or to copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Right-click and select Copy to copy the selected text to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.

• To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.
Full Gene report

Of all the Customer reports, the Full Gene report is the most customizable report. It has options for:

- Organizing sample traces into groups based on matching filenames and then further sort the sample traces within the groups based on specific character positions in the filenames.
- Custom color-coding to assist you with identifying different types of mutation calls and potential analysis problems.
- Creating and displaying a custom header above each group of sample traces.

After you click Full Gene Report on the Customer Reports menu, the Full Gene Report Settings dialog box opens. You can leave the default values as they are, or you can modify any of the values as needed, and then click OK to generate the report. See:

- “Full Gene Report Settings dialog box, Format tab.”
- “Full Gene Report Settings, Output tab” on page 217.

Figure 7-31: Full Gene report
### Full Gene Report Settings dialog box, Format tab

**Figure 7-32:** Full Gene Report Settings dialog box, Format tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sample Grouping</strong></td>
<td></td>
</tr>
<tr>
<td>n-Primer (n-D) Text input</td>
<td>Select this option if you have defined primers when using a GenBank reference file to group sample files in forward and reverse pairs.</td>
</tr>
<tr>
<td>Filename match</td>
<td>• From Character [ ] To Character [ ]—Select this option if all the filenames in your project contain the same character string/designator in the same positions.</td>
</tr>
<tr>
<td></td>
<td>• Typical Block—If all the filenames in your project contain the same character string/designators but in different positions, then select this option and enter the character string/designator.</td>
</tr>
<tr>
<td>Sort By</td>
<td>From Character [ ] To Character [ ]—Select this option to further sort sample traces within a group based on specific character positions in the filenames.</td>
</tr>
<tr>
<td><strong>Background Color-Coding</strong></td>
<td></td>
</tr>
<tr>
<td>Accept the default colors for the different types of mutations, or modify them as you want.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Mutation position specific for column—Aligns mutations by column within each group.</td>
</tr>
<tr>
<td></td>
<td>• Display Mutation Number—Display the number of mutations found in the sample trace.</td>
</tr>
</tbody>
</table>
Full Gene Report Settings, Header tab

The Header tab opens after you click Next on the Format tab.

*Figure 7-33: Full Gene Settings dialog box, Header information*

---

Full Gene Report Settings, Output tab

The Output tab opens after you click Next on the Header tab.

*Figure 7-34: Full Gene Report Settings dialog box, Mutation Score and Output options*
## Chapter 7
Mutation Surveyor Customer Reports

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mutation Scores</strong></td>
<td></td>
</tr>
<tr>
<td>Reject 1D Calls When Other Direction has No Call</td>
<td>Reject a mutation that is called in only one direction when the position falls within the comparison region of the other direction.</td>
</tr>
<tr>
<td>Reject 1D Calls When Other Direction is Not Available</td>
<td>Reject a mutation that is called in only one direction when the position falls outside the comparison region of the other direction.</td>
</tr>
<tr>
<td>Reject Synonymous Mutations</td>
<td>Coding region substitutions that do not affect amino acid calls are not displayed in the report.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>An “n.a.” is displayed in the Mutation cell for rejected mutations instead of the mutation code.</td>
</tr>
<tr>
<td>Display Mutations with the “Stop” Codon or Indel Only</td>
<td>Display only nonsense mutations and indels in the report.</td>
</tr>
<tr>
<td>Display Confirmed Mutations Only</td>
<td>Display only those mutations that you have manually confirmed in the report.</td>
</tr>
<tr>
<td>Display Mosaic Mutations</td>
<td>Display mosaic mutations in the report.</td>
</tr>
<tr>
<td><strong>Mutation Output Format</strong></td>
<td></td>
</tr>
<tr>
<td>Display Mutation As</td>
<td>Select one option to set the format of the mutation code in the report.</td>
</tr>
<tr>
<td></td>
<td>• 123T&gt;CT (Default value)</td>
</tr>
<tr>
<td>Number Bases Relative to cDNA</td>
<td>If this option is cleared, the numbering is the genomic position within the GenBank file.</td>
</tr>
<tr>
<td></td>
<td>• If this option is selected:</td>
</tr>
<tr>
<td></td>
<td>• Select CDS to number the bases relative to the CDS numbering in the GenBank reference file.</td>
</tr>
<tr>
<td></td>
<td>• Select mRNA to number the bases relative the mRNA numbering in the GenBank reference file.</td>
</tr>
</tbody>
</table>
**Figure 7-35: Full Gene report**

The Full Gene report toolbar contains just two buttons for working with the report.

**Figure 7-36: Full Gene report toolbar**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save Report" /></td>
<td>Save Report—Opens the Save Report As dialog box in which you can specify a name and location for saving the report as well as its format (.xls/.xlsx, .xls/.xlsx (Excel sample in different sheet) or .txt).</td>
</tr>
</tbody>
</table>
| ![Report Settings](image) | Report Settings—Opens the Full Gene Report Settings dialog box which contains options for grouping and filtering the information that is to be displayed in the report.  
**Note:** The Sample Grouping options are not available on the Format tab when you open the Full Gene Report Settings dialog box from the report toolbar. This prevents you from changing the report format after you have added custom text. To change the report format, close and then re-open the report. See “Full Gene Report Settings dialog box, Format tab,” “Full Gene Report Settings, Header tab,” and “Full Gene Report Settings, Output tab.” |
Full Gene viewing and analysis options

A context menu that contains options for changing the view of the Full Gene report and for manipulating and analyzing mutation project data. To open the context menu, right-click anywhere in the Full Gene report.

*Figure 7-37: Full Gene report context menu*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Confirm               | Confirms the selected mutations.  
**Note:** SHIFT-click to select multiple contiguous mutations or to select all mutations in a column.  
The text for the mutation code turns black in both the Full Gene report and the Mutation table in the GAD. The comment <<Checked>> is displayed in the Actions field for the mutation call in the Mutation table in the GAD. |
| Undo Confirmation     | Removes the “Confirmed” status for the mutation.  
**Note:** SHIFT-click to select multiple contiguous mutations or to select all mutations in a column. |
| Delete Mutations      | Deletes the selected mutations.  
**Note:** SHIFT-click to select multiple contiguous mutations, to select all mutations in a column, or to select multiple rows.  
The text for the mutation code turns gray in both the Full Gene report and the Mutation table in the GAD. The comment <<Deleted>> is displayed in the Actions field for the mutation call in the Mutation table in the GAD. |
| Delete Lane           | Deletes all the mutations for a selected sample in a single step. The Lane Quality for a deleted lane is set to “Low Quality.” |
| Undo Lane Deletion    | The Lane Quality for the lane is reset to its original value. |
The Full Gene report is interactive.

- You can double click in the Date, Batch Run/ID or/or Result fields and enter any text as needed.

- You can also view information for a mutation in the report in the GAD. To open the GAD for the trace that contains a mutation, double-click the mutation in the report.
Chapter 7
Mutation Surveyor Customer Reports

FullBase report

The FullBase report shows the forward and reverse consensus sequences for each base within specified ROIs. Amplicon IDs must be defined in GenBank or SEQ reference files and these IDs must be present in all the respective sample filenames. The Full Base report groups replicated positions into a single cell. After you click FullBase Report on the Customer Reports menu, the FullBase Report Settings dialog box opens. You can leave the default values as they are, or you can modify any of the values as needed, and then click OK to generate the report.

You use GenBank File Editors to define Amplicon IDs. See Chapter 8, “GenBank File Editors,” on page 225 for information about defining Amplicon IDs.

Figure 7-38: FullBase Report Settings dialog box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplicon ID from Character [ ] To Character [ ]</td>
<td>Displays the starting and ending positions of the amplicon-specific starting designator in your reference filenames.</td>
</tr>
<tr>
<td>Sample ID from Character to [ ] To Character [ ]</td>
<td>Enter the starting and ending positions for the range in your sample filenames that contain the amplicon-specific designator.</td>
</tr>
<tr>
<td>Expected Number of Reads per Group</td>
<td>The expected total number of traces (forward and reverse) to pass the discrepancy check for a group of sample files.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> More traces can be in the consensus without being highlighted with a yellow background.</td>
</tr>
<tr>
<td>Analyst 1</td>
<td>Optional information to further clarify your analysis setup.</td>
</tr>
<tr>
<td>Analyst 2</td>
<td>Optional information to further clarify your analysis setup.</td>
</tr>
<tr>
<td>Reviewer</td>
<td>Optional information to further clarify your analysis setup.</td>
</tr>
</tbody>
</table>
FullBase report layout

Mutation calls are displayed in cells where a variation has been identified with the font color indicating the call confidence. Forward and reverse samples traces are paired next to each other with alternating colors of light tan and light blue differentiating the sample pairs. Positions that do not have enough samples for determining mutation calls are highlighted in yellow. Discrepancies (identifies the variants within a consensus of traces that have at least one member of the consensus that differs from the others) are also highlighted in yellow. The Comments field is a free text field for entering additional information about your project.

Figure 7-39: Full Base report

<table>
<thead>
<tr>
<th>Nucleotide Position</th>
<th>Reference Sequence</th>
<th>Allelic ID</th>
<th>BRCA1_012345</th>
<th>BRCA1_012345</th>
<th>BRCA1_012345</th>
<th>BRCA1_012345</th>
<th>BRCA1_012345</th>
<th>BRCA1_012345</th>
</tr>
</thead>
<tbody>
<tr>
<td>X051</td>
<td>t</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
</tr>
<tr>
<td>X052</td>
<td>g</td>
<td>135</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
</tr>
<tr>
<td>X053</td>
<td>a</td>
<td>135</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
</tr>
<tr>
<td>X054</td>
<td>g</td>
<td>136</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
</tr>
<tr>
<td>X055</td>
<td>t</td>
<td>136</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
</tr>
<tr>
<td>X056</td>
<td>a</td>
<td>137</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
</tr>
<tr>
<td>X057</td>
<td>g</td>
<td>138</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
</tr>
<tr>
<td>X058</td>
<td>c</td>
<td>139</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
</tr>
<tr>
<td>X059</td>
<td>t</td>
<td>140</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
</tr>
<tr>
<td>X060</td>
<td>t</td>
<td>141</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
<td>134</td>
</tr>
</tbody>
</table>

FullBase report toolbar

The FullBase Report toolbar contains a single button on the toolbar—the Save Report button . Click this button to open a Save As dialog box in which you can specify the name and location for saving the report as an .xls/.xlsx or .txt file.
FullBase viewing and analysis options

Although the FullBase report does not have a full context menu, you can still copy text from the report, or copy the report as an image, and you can paste copied text into the editable Comments field. You can also view the information for a mutation in the Full Base report in the GAD.

- Select the text that you want to copy or to copy text in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Right-click and select Copy to copy the selected text to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application, or use the Paste command on the Context menu to paste copied text into the editable Comments field.

- To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.

- Because the FullBase report shows every position and not just mutations, double-click a cell in the report to open the relevant position in the first trace of the consensus.
Chapter 8
GenBank File Editors

Mutation Surveyor provides many tools for optimizing input data and analyzing results. This chapter details the three tools that are specifically designed for editing GenBank files and Sequence files—the GBK File Editor, the Advanced GenBank Editor, and the SEQ File Editor. You use all these tools to view, add, and edit CDS information in multi-exon GenBank files, which are essential functions for creating and using GenBank-derived reference traces.

Although Mutation Surveyor provides many tools for optimizing input data and analyzing results, the GenBank Editor tools are the most commonly used of all the tools and that is why they are afforded their own chapter. Other Mutation Surveyor tools are discussed in appropriate chapters, including Chapter 9, “Mutation Surveyor Tools,” on page 253.

This chapter covers the following topics:
• “Overview of GenBank Files” on page 227.
• “Advanced GBK File Editor Tool” on page 231.
• “SEQ File Editor Tool” on page 246.
Overview of GenBank Files

The GenBank sequence database is an open access, annotated collection of all publicly available nucleotide sequences and their protein translations. This database is produced at the National Center for Biotechnology Information (NCBI) as part of the International Nucleotide Sequence Database Collaboration, or INSDC. A GenBank file is a text-based file that shows the amino acid translation that corresponds to the base coding sequence (CDS). A GenBank file is always an optional file for a Mutation Surveyor project. If you do use a GenBank file as a reference file for Mutation Surveyor project, then the file must be in one of two formats—.gbk or .gb, which represents the sequence text of multiple CDSs or .seq, which represents the sequence text of a single CDS. All three file formats contain the same information and have similar conventions.

- A comment line is preceded with the greater than (>) symbol or a forward slash (/) and it contains the following information—the gene name, the CDS number, the reading frame number of the starting CDS base, the starting base number, the coding sequence (CDS), the starting amino acid number, the starting and ending vector sequences, the translation protein sequence from the CDS, and the DNA variations. Any text in a comment line is not read into the DNA sequence.

- The coding sequence is in uppercase. All other sequences are in lowercase.

⚠️Mutation Surveyor is designed to work with GenBank files that are obtained solely from NCBI. You should not use GenBank files that are obtained from other sources. See “To download a GenBank file.”

To download a GenBank file

2. On the Search dropdown menu, select Gene.
3. In the search field, enter the official name or symbol for your gene of interest, and then click Search.

A list of all organisms that contain the specified gene is displayed.

Figure 8-1: Searching for a gene (NCBI)
4. Scroll to the Genomics region section in the search results and select the correct assembly for your project.

*Figure 8-3: Assembly options in the Gene report*
5. Download the selected assembly. Note the following about the different assemblies:

<table>
<thead>
<tr>
<th>Assembly</th>
<th>Description</th>
</tr>
</thead>
</table>
| NG Accession | • The RefSeq.  
• Most RefSeq GenBank files contain only a single transcript.  
• NG Accession can show dbSNP.  
• Nucleotide positions do not relate to chromosome coordinates.  
• Click the GenBank link to download your selected NG Accession.  
See Figure 8-4 below. |
| NC Accession | • NC accessions often contain several transcripts.  
• NC accessions do not have dbSNP.  
• Nucleotide positions are chromosome coordinates.  
• Click the GenBank link to download your selected NC Accession.  
See Figure 8-5 below. |
| NT Accession | • NT Accessions often contain several transcripts  
• Nucleotide positions can be translated to chromosome coordinates.  
• Available for download through Mutation Surveyor |

*Figure 8-4: NG Accession selected*

*Figure 8-5: NC Accession selected*
6. Optionally, before you download and save the GenBank file, do one or more of the following:
   - To include additional upstream and/or downstream sequences (for example, to include promoter regions), under Change Region Shown, click Selected Region, enter the new starting and ending base numbers, and then click Update View.
   - To include SNPs for an NG Accession, open the Customize View menu, and under Features added by NCBI, select the [ ] SNPs option, and then click Update View.
   - To change the view of the GenBank file for a gene that is on the minus strand, open the Customize View menu, and under Display Options, deselect Show Reverse Complement, and then click Update View.

   **Figure 8-6: Optional actions for a GenBank file**

7. To save the GenBank file, open the Send menu, and then do the following.
   a. Select Complete Record.
   b. For Choose Destination, select File.
   c. For Format, select GenBank.
   d. Click Create File.

   A File Download dialog box opens with options to Open or Save the selected GenBank file.

8. Save the file in a location of your choosing.

   You can now use the Advanced GBK Editor to view, edit, and annotate this GenBank file and you can also use the Advanced GBK Editor to save the file as a SEQ file. See “Advanced GBK File Editor Tool” on page 231.
Advanced GBK File Editor Tool

You use the Advanced GBK Editor tool to view, edit, or annotate a GenBank file. If the GenBank file contains multiple protein and mRNA isoforms, the Advanced GBK File Editor tool displays all the proteins in the file and it displays the corresponding mRNA information for each isoform. You can also use the Advanced GenBank File Editor tool to add, view, or edit custom tags and identifiers to the reported variations in the file.

To load a GenBank file into the Advanced GBK File Editor tool

1. On the Mutation Surveyor main menu, click Tools > Advanced GBK File Editor.
2. On the Advanced GBK File Editor window main menu, click File > Open and in the Open File dialog box, select the appropriate file, and then click Open.

The file is loaded into the Advanced GBK File Editor. The Advanced GBK File Editor window has a toolbar with buttons that are specific for buttons for working with the loaded file and it has two panes—the GenBank Tree File pane and the Tabs pane. When the window first opens, the Sequence tab is the active tab in the Tabs pane.

Figure 8-7:  Advanced GBK File Editor window
## Advanced GBK File Editor tool toolbar

![Advanced GBK File Editor tool toolbar](image)

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New" /></td>
<td>New—Clears the currently loaded GBK file and readies the editor to accept a new file.</td>
</tr>
<tr>
<td><img src="image" alt="Open Files" /></td>
<td>Open Files—Opens the Open Files dialog box which you use to load GenBank files or other files into the editor.</td>
</tr>
<tr>
<td><img src="image" alt="Save All CDSs and all mRNAs" /></td>
<td>Save All CDSs and all mRNAs—Saves all the CDSs and mRNAs for the loaded GenBank file in a single file.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Refresh—Updates the display in the Advanced GBK File Editor window after you make a modification to the loaded GenBank file.</td>
</tr>
<tr>
<td><img src="image" alt="Search in Sequence" /></td>
<td>Search in Sequence—Opens the Search in Sequence dialog box in which you can specify a nucleotide sequence for which to search. See “Advanced GBK File Editor tool functions” on page 243.</td>
</tr>
<tr>
<td><img src="image" alt="Adjust" /></td>
<td>Adjust—Opens the Adjust File dialog box which you can specify the Sequence Start for the selected isoform. See “Advanced GBK File Editor tool functions” on page 243.</td>
</tr>
<tr>
<td><img src="image" alt="Search in Database" /></td>
<td>Search in Database—Opens the Search in Database dialog box which provides an option for accessing a SoftGenetics server and downloading a GenBank file. See “Advanced GBK File Editor tool functions” on page 243.</td>
</tr>
</tbody>
</table>
Advanced GBK File Editor tool GenBank Tree File pane

The left pane in the Advanced GBK File Editor window is the GenBank Tree File pane. This pane displays all the GBK file information (protein and mRNA) in a simple tree format. Click the plus (+) and minus (-) symbols to expand and collapse the tree structure, respectively.

**Figure 8-9: Advanced GBK File Editor GenBank Tree File pane**

The GenBank Tree File is interactive:

- Click an isoform in the tree structure to select it. The selected protein is marked with a green checkmark in the pane. Mutation Surveyor automatically selects the corresponding mRNA region for the CDS and marks it with a yellow checkmark.

  The nucleotide sequence is the same for all isoforms. Only the mRNA and CDS locations change when you select a different isoform.

- Optionally, after you select an isoform, click File > Save As on the Advanced GBK File Editor tool main menu, and then on the dialog box that opens, indicate what information is to be saved:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected Gene Region</td>
<td>Saves all the transcripts (CDSs and mRNAs) for the gene to a new GenBank file. You can specify the name of this new GenBank file, and the location in which to save it.</td>
</tr>
<tr>
<td>Selected Gene Region; Selected mRNA Region</td>
<td>Saves only the transcript (CDS and mRNA) that is currently selected to a new GenBank file. You can specify the name of this new GenBank file, and the location in which to save it.</td>
</tr>
</tbody>
</table>
Chapter 8  
GenBank File Editors

- Expand the Variations folder to view a list of all the recorded variations.

*Figure 8-10: Expanded Variations folder*

- Double-click a variation in the Variations list to open the Variation Settings dialog box. The Variation Settings dialog box provides detailed information about the selected variation, including its alleles and its position in the gene.

*Figure 8-11: Variation Settings dialog box*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seq Files for Selected CDS</td>
<td>An individual SEQ file is created for each exon in the currently selected CDS. The default name for each SEQ file is (&lt;\text{GenBank filename}&gt;_\text{exon}_&lt;n&gt;.seq), where (&lt;n&gt;) reflects the exon number, and the files are saved in the same folder as the loaded GenBank file; for example, BRCA1_AmpID_exon_1.seq.</td>
</tr>
</tbody>
</table>
Advanced GBK File Editor tool Tabs pane

The Tabs pane is the right pane in the Advanced GBK File Editor window. The tabs that are displayed in this pane depend on the item that is selected in the GenBank Tree File pane. If a protein or mRNA is selected in the GenBank Tree File pane, then the tabs that are displayed are the Basic Information tab and the Sequence tab. If a variation is selected in the GenBank Tree File pane, then the tabs that are displayed are the Allele Frequency tab and the Sequence tab. The Sequence tab is always the active tab when the Tabs pane first opens.

**Figure 8-12: Advanced GBK File Editor window Sequence tab**

Sequence tab

The Sequence tab provides a visual representation of the gene. The tab is divided into three sections (upper, middle, and lower) that display different information for the gene.

- The upper section displays the **Base Count**, which is the total base count on a per nucleotide basis, with each base having a different color-code. The upper section also shows the Sequence Start, which typically has a value of one, but can be negative if promoter regions are used. You can modify the value in the Sequence Start field, or you can modify it using the Adjust option. (See “Advanced GBK File Editor tool functions” on page 243.) You can also modify the values in the Amino Acid Start or the mRNA start index fields. To view the amino acid translation for the nucleotides in the CDS, click Amino Acids.

**Figure 8-13: Amino acid translation for a CDS**

```
.321  tctatgtgt taagtTCAT TGGACAGAA AGAAATGGAAT TTATCTGCTC TTGGCGTGTGA
     M D E S A I R V E
.381  AGAATGACAA AATGCTATCA ATGCTATGCA GAAATCCTTA GAGTGCCTCA TCTGttaagt
     E V Q N V I N A M Q K I L E C P I
```
• The middle section is a view-only textual representation of the full nucleotide sequence for the selected protein or mRNA region. Black lowercase letters indicate nucleotides in a non-coding (intron or intragenic) region. Red uppercase letters indicate nucleotides in a coding region (CDS). Green uppercase letters indicate nucleotides in an mRNA region. Blue letters indicate reported variations. (The letters are uppercase or lowercase depending on the region in which the variation occurs.) After you make a modification to the loaded GenBank file and click Refresh, Mutation Surveyor updates the display accordingly.

• The lower section is a color-coded bar chart that indicates different information about the gene. mRNA regions are shown in green and CDS regions are shown in red. Reported variations, including indels, are indicated by tick marks of different colors. The first row of numbers indicates the starting genomic base position for a CDS and the second row of numbers indicates the CDS. For example, in Figure 8-14 below, the 7th CDS has a starting genomic base position of 34,399.

Figure 8-14: CDS and genomic position numbering

The Sequence tab is interactive:

• To move the display in the middle section to the sequence for a CDS, double-click the CDS on the bar chart. Similarly, to move the display in the middle section to the sequence for an mRNA region, double-click the mRNA region on the bar chart.

• To zoom in on a CDS region or an mRNA region in the bar chart for easier viewing, hold down the left mouse button and draw a box from the upper left hand corner of the region towards the lower right hand corner. A box is formed around the area that is being reduced for viewing.

You must double-click exactly the green region or the red region on the bar chart. If you click anywhere else on the bar chart, the display in the middle section does not move.

• To zoom out, hold down the left mouse button and draw a box from the lower right hand corner of the region towards the upper left hand corner. (The magnification for zooming out is always 100%.)

You must make sure to include the entire CDS region or the mRNA region in the box and you cannot extend the box’s upper boundary into the middle section.
To open a context menu that contains options for working with the sequence text display, right-click anywhere in the sequence text display.

**Figure 8-15: Sequence text display context menu**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies selected text in the sequence text display to your clipboard. To select text for copying, click and hold the left mouse button and drag the mouse to select the text that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes copied text into the sequence text display.</td>
</tr>
<tr>
<td>Find</td>
<td>Opens the Search in Sequence dialog box. You use the options on this dialog box to search for specific text in the sequence text display. (See “Advanced GBK File Editor tool functions” on page 243.)</td>
</tr>
</tbody>
</table>

## Basic Information tab

Mutation Surveyor pulls information directly from the loaded GenBank file and populates the fields on the Basic Information tab with this information. The information that is displayed on the tab depends on what option is selected in the GenBank Tree File pane—an isoform or an mRNA region. (See Figure 8-18 on page 239.)

**Figure 8-16: Advanced GBK File Editor, Basic Information tab for selected isoform**

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDS</td>
<td>3.84523,87996, 57940.25900, 61570.02970, 62119.69316, 62019.74034, 74109.76257, 76300.77746, 77800.79049, 79773</td>
</tr>
<tr>
<td>Program of Interest</td>
<td>1</td>
</tr>
<tr>
<td>Note</td>
<td>isoform EPCA1-delta10.11b is encoded by a transcript variant of EPCA1 (delta10.11b) derived by automated computational analysis</td>
</tr>
<tr>
<td>From file</td>
<td>M00724.3</td>
</tr>
</tbody>
</table>

**Field** | **Description** |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CDS</td>
<td>Lists the starting and ending base numbers for the first CDS, the second CDS, and so on. Within a CDS, the starting and ending base numbers are separated by two decimal points (..). CDSs are separated by commas. You can manually edit the information in the CDS field.</td>
</tr>
</tbody>
</table>
## Region of Interest/Amplicon Id

List of the ROIs defined in the CDS. Within an ROI, the starting and ending base numbers are separated by two decimal points (..). ROIs are separated by commas. Several options are available for adding and editing ROIs.

- You can manually edit the information in the ROI Field.
- You can right-click in either the ROI or Amplicon ID field and select View of Table of Values to open the Table of Values dialog box which lists the ROIs and Amplicon IDs in table. You can modify the ROI values directly in this table, and you can right-click in this dialog box and select Insert Item to add new ROIs and Amplicon IDs.

![Table of Values dialog box](image)

**Note:** Amplicon ID is always an optional value; however, if your samples overlap and you are using amplicons to construct contigs, then to ensure proper alignment, the Amplicon ID should be the same as the Amplicon ID that is used in your sample filenames. (See “Use Amplicon to Construct Contig” on page 57.)

- You can add ROIs that are based on the CDSs. See “Advanced GBK File Editor tool functions” on page 243.

**Note:** Even if you modify the information for both the CDSs and the ROIs on this tab, your project’s graphical output can be limited based on the options that you have selected for Output Limits. See “Output Limits” on page 63.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region of Interest/Amplicon Id</td>
<td>List of the ROIs defined in the CDS. Within an ROI, the starting and ending base numbers are separated by two decimal points (..). ROIs are separated by commas. Several options are available for adding and editing ROIs.</td>
</tr>
<tr>
<td>External Primer Internal Primer</td>
<td>Lists the starting and ending base numbers for the external/internal primer 5’ end and then for the external/internal primer 3’ end. For each end, the starting (From) and ending (To) base numbers are separated by two decimal points (..). The primers are separated by commas. Primer pairs are separated by semicolons.</td>
</tr>
</tbody>
</table>
Chapter 8
GenBank File Editors

Field | Description
--- | ---
• CodonStart  
• product  
• protein_id  
• note  
• translation  
• Corresponding_mRNA_region  
• transl_table  
Mutation Surveyor pulls the information in these fields directly from the loaded GenBank file. Mutation Surveyor deduces the corresponding mRNA region for each protein by inspecting the start and end positions of each of the exons between the protein and the mRNA. Mutation Surveyor deduces the amino acid translation relative to the nucleotides in the coding sequence.

Field | Description
--- | ---
Region  
transcript_id  
product  
note  
Corresponding_CDS_region  
Mutation Surveyor pulls the information in these fields directly from the loaded GenBank file. Mutation Surveyor deduces the corresponding protein for each mRNA region by inspecting the start and end positions of each of the exons between the protein and the mRNA.

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>15171-16126, 16128-17123, 17125-18127, 18129-20129, 20131-22131, 22133-25133, 25135-26135, 26136-28136, 28137-28138</td>
</tr>
<tr>
<td>transcript_id</td>
<td>NM_007206.2</td>
</tr>
<tr>
<td>product</td>
<td>breast cancer I, early onset, transcript variantBICA1-dele5-11</td>
</tr>
<tr>
<td>note</td>
<td>Defined by automated computational analysis usinggene prediction method BestFolding</td>
</tr>
<tr>
<td>Corresponding_CDS_region</td>
<td>NP_007206.1</td>
</tr>
</tbody>
</table>

Figure 8-18: Advanced GBK File Editor, Basic Information tab with mRNA region selected in GenBank Tree File pane

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>Lists the starting and ending base numbers for the first mRNA region, the second mRNA region, and so on. Within an mRNA region, the starting and ending base number are separated by two decimal points (...). mRNA regions are separated by commas. You can manually edit the information in the Region field.</td>
</tr>
</tbody>
</table>
| transcript_id  
product  
note  
Corresponding_CDS_region  | Mutation Surveyor pulls the information in these fields directly from the loaded GenBank file. Mutation Surveyor deduces the corresponding protein for each mRNA region by inspecting the start and end positions of each of the exons between the protein and the mRNA. |
Allele Frequency tab

If a variation is selected in the GenBank Tree File pane, then the Tabs pane contains an Allele Frequency tab instead of a Basic Information tab. This tab lists all the reported variations in the GenBank file as well as any of the variations that you or other users have added to the file.

The frequency information refers to allele frequency with regards to population studies. Mutation Surveyor does not use this information and most SNPs in dbSNP do not have this information populated.

<table>
<thead>
<tr>
<th>No</th>
<th>Position</th>
<th>Allele Number</th>
<th>db_xref</th>
<th>Frequency</th>
<th>Gene</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>54</td>
<td>2</td>
<td>dbSNP:8176075</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>2</td>
<td>56</td>
<td>2</td>
<td>dbSNP:8176077</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>3</td>
<td>56</td>
<td>0</td>
<td>dbSNP:8176077</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>4</td>
<td>60</td>
<td>2</td>
<td>dbSNP:123456</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>5</td>
<td>65.56</td>
<td>2</td>
<td>dbSNP:35433937</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>6</td>
<td>96.37</td>
<td>2</td>
<td>dbSNP:34191881</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>7</td>
<td>122</td>
<td>2</td>
<td>dbSNP:68946604</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>8</td>
<td>281</td>
<td>2</td>
<td>dbSNP:799305</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>9</td>
<td>365</td>
<td>2</td>
<td>dbSNP:55680227</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>10</td>
<td>516</td>
<td>2</td>
<td>dbSNP:8176076</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>11</td>
<td>1120</td>
<td>2</td>
<td>dbSNP:8176077</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>12</td>
<td>1221</td>
<td>2</td>
<td>dbSNP:3765640</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>13</td>
<td>1251-1255</td>
<td>2</td>
<td>dbSNP:35629245</td>
<td>N/A</td>
<td>BRCA1</td>
</tr>
<tr>
<td>14</td>
<td>1774-1791</td>
<td>?</td>
<td>dbSNP:8176078</td>
<td>N/A</td>
<td>RRH-L1</td>
</tr>
</tbody>
</table>

To open a context menu that contains options for annotating the information in the Frequency column adding a variation, deleting a variation, and copying a variation, right-click anywhere in the Allele Frequency tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify Parameter</td>
<td>Opens the Variation Setting dialog box in which you can modify the selected variation. See “Modifying and adding variations” on page 241.</td>
</tr>
<tr>
<td>Add Variation</td>
<td>Opens a blank Variation Setting dialog box in which you can add a new variation to the loaded GenBank file. See “Modifying and adding variations” on page 241.</td>
</tr>
</tbody>
</table>
Modifying and adding variations

You can use functions that are available for the Allele Settings box to modify the information for a selected variation, add a variation to the loaded GenBank file, and add tags and identifiers to the variations.

Figure 8-21: Variation Settings dialog box

- To modify any of the information in the Position field or Gene Name field, double-click a displayed value to select it, and then modify the value.
- To modify the Identifier information for an existing tag, double-click the displayed value to select it, and then modify the value. You can also select a different tag for the variation on the Tag dropdown list.
- To add multiple tags for a variation, right-click anywhere in the db_xref pane, and on the context menu that opens, click Add Line. A new blank line for a tag and identifier is added to the pane.
To modify the information in the Allele Frequency area for a selected variation, *triple-click* the allele that is being modified to select it, and then modify the allele as needed.

**Figure 8-22: Modifying a selected variation**

- To delete an allele from a variation, right-click in the Allele Frequency area, and on the context menu that opens, click Delete Allele. Allele2 is deleted. Repeat this step to delete Allele 1.
- To add a new variation:
  1. Enter the Position and Gene Name for the variation.
  2. Right-click in the Allele Frequency area, and on the context menu that opens, click Add Allele. Enter a value for Allele1. Repeat this step for Allele 2.
  3. In the db_xref pane, select a tag from the Tag dropdown list, and then enter a value in the Identifier field. You can include both the tag and the identifier, or just one, or none. You can also include multiple tags and/or identifiers.

After you have made modifications to an existing variation, or added the values for a new variation, click OK to save your edits.
Advanced GBK File Editor tool functions

The Advanced GBK File Editor tool contains a variety of functions for working with the loaded GenBank file. You can:

- Search the loaded GenBank file for a specific sequence. See “To search the loaded GenBank file for a specific sequence” below.
- Access a GenBank database on a SoftGenetics server to download a GenBank file with the same sequence. See “To download a GenBank file with the same sequence” on page 244.
- Adjust the number of the first coding base or the sequence start. See “To adjust the number of the first coding base or the sequence start” on page 244.
- Add ROIs that are based on the CDSs. See “To add ROIs that are based on CDSs” on page 245.
- Reverse complement the currently loaded GenBank file. See “To reverse complement the currently loaded GenBank file” on page 245.

To search the loaded GenBank file for a specific sequence

1. On the Advanced GBK File Editor main menu, click Search > Search in Sequence.

   The Search in Sequence dialog box opens.

   Figure 8-23: Search in Sequence dialog box

2. Enter the sequence for which to search in this dialog box.

3. Optionally, to reverse complement the sequence before searching, click Complementary.

   If the sequence is found, the sequence text display in the middle section is moved to the first occurrence of the sequence and the text is displayed in pink on the tab.

   Figure 8-24: Located sequence in sequence text display

   164 gagcgagagt ttcgaagct gacagatgg tattctttga cgggggtatg gggcggaac 241
To download a GenBank file with the same sequence

1. On the Advanced GBK File Editor main menu, click Search > Search in Database.

   The Search in Database dialog box opens. This dialog box lists the entire nucleotide sequence of the currently loaded GenBank file.

   Figure 8-25: Search in Database dialog box

   ![Search in Database dialog box]

2. Click Submit to initiate the search.

   If a GenBank file is located that has the same genomic sequence as the currently loaded GenBank file, then Mutation Surveyor replaces the currently loaded GenBank file with the GenBank file from SoftGenetics’s database. If a GenBank file that matches the genomic sequence of the currently loaded file cannot be found, then a message opens indicating this and the currently loaded GenBank file is cleared from the editor.

To adjust the number of the first coding base or the sequence start

At times, you might want to adjust the number of the first base or the first coding base in a GenBank file. For example, if a promoter region is 500 bps, then the sequence start that typically is 1 is now 501, but you still want the sequence start to be 1.

1. On the Advanced GBK File Editor main menu, click Tools > Adjust.

   The Adjust File dialog box opens.

   Figure 8-26: Adjust File dialog box

   ![Adjust File dialog box]

2. Set your options as appropriate.
3. Click OK.
   The Advanced GBK File Editor display is updated accordingly.

To add ROIs that are based on CDSs

1. On the Advanced GBK File Editor main menu, click Tools > Auto Create ROI.
   The Create ROI for CDSs dialog box opens.

   ![Create ROI for CDSs dialog box](image)

2. Specify the number of base pairs that are to included before (left) and after (right) each CDS.
3. Click OK.
4. Click the Refresh icon to view these changes in the Region of Interest field on the Basic Information tab.

To reverse complement the currently loaded GenBank file

1. On the Advanced GBK File Editor main menu, click Tools > Complement.
   A message opens, asking you if you want to reverse complement the currently loaded GenBank file.
2. Click Yes.
   The Advanced GBK Editor display is updated accordingly, and a second message opens, asking you if you want to save the complement GenBank file.
3. Click Yes.
   By default, the file name is the name of the GenBank file that was complemented and appended with the word “complement” (for example, BRCA1_NC_RC_complement.gbk) and the file is saved in the same directory as the original GenBank file that was loaded. You can change either or both of these values as needed.
SEQ File Editor Tool

You use the SEQ File Editor tool to view, add, and edit CDS information in SEQ files.

You can use the SEQ File Editor tool to load and annotate FASTA (.fasta) and trace files (.scf, .ab1, and .abi) and text (.txt) files as well as .seq files.

To load a SEQ file into the SEQ File Editor tool

1. On the Mutation Surveyor main menu, click Tools > SEQ File Editor to open the SEQ File Editor window.

2. On the SEQ File Editor window main menu, click File > Open, and in the Open File dialog box, select the appropriate .seq file, and then click Open.

The .seq file is loaded into the SEQ File Editor.

Figure 8-28: SEQ File Editor window with loaded .seq file
SEQ File Editor tool layout

The SEQ File Editor window is divided into two sections—upper and lower. The upper section contains fields that are automatically populated with the information that Mutation Surveyor has pulled directly from the loaded SEQ file. You can edit much of this information to suit your working needs. The lower section is an editable textual representation of the full sequence for the single CDS. Black lowercase letters indicate nucleotides in a non-coding region. Red uppercase letters indicate nucleotides in a coding region. Blue letters indicate reported variations. (The letters are uppercase or lowercase depending on the region in which the variation occurs.) After you make a modification to the loaded SEQ file and click Refresh, Mutation Surveyor updates the display accordingly.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gene</td>
<td>The gene name.</td>
</tr>
</tbody>
</table>
| Exon and Note                  | The Exon number and any other additional information for the exon.  
Note: All Exon fields on all Mutation Surveyor reports are automatically populated with the value in this field, so edit this value carefully. |
| Reading Frame                  | Reading frame number for the first coding base.                                                                                              |
| Remainder Base(s) of Previous CDS | The number of bases from the previous CDS that are required to complete the first codon of the currently loaded CDS.  
• If the Reading Frame =1, then no bases are required. The coding sequence is complete.  
• If the Reading Frame =2, then a single base is required from the previous CDS.  
• If the Reading Frame =3, then two bases are required from the previous CDS. |
| Remainder Base(s) of Next CDS  | The number of bases from the next CDS that are required to complete the last codon of the currently loaded CDS.  
• If the Reading Frame of the next CDS=1, then no bases are required. The coding sequence is complete.  
• If the Reading Frame of the next CDS=2, then two bases are required from the next CDS.  
• If the Reading Frame of the next CDS=3, then one base is required from the next CDS. |
| The Number of the First Base   | The number assigned to the first nucleotide in the sequence text display. If you change this number, then numbering of all the nucleotides in the sequence text display is changed accordingly.  
Note: If you change the value for The Number of the First Base, the CDS numbers and the ROI numbers are not changed. To change these numbers, you must use the Adjust function. (See “SEQ File Editor tool functions” on page 250.). |
| mRNA Start Index               | The genome position of the mRNA start is related to the mRNA numbering through the mRNA Start Index. This value is needed to determine the offset in numbering between the CDS nomenclature and the mRNA nomenclature relative to the number of bases in the untranslated region that is upstream of the CDS start. |
### Chapter 8
GenBank File Editors

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mRNA</td>
<td>The starting and ending nucleotide numbers for the mRNA region. Note: If you modify these values, the selected sequence is read as cDNA.</td>
</tr>
<tr>
<td>CDS Index</td>
<td>The CDS number as pulled directly from the loaded SEQ file.</td>
</tr>
<tr>
<td>Coding Sequence</td>
<td>The starting and ending nucleotide numbers for the CDS. The CDS is indicated by red letters in the sequence text display.</td>
</tr>
<tr>
<td>Region of Interest</td>
<td>The starting and ending nucleotide numbers for the ROI defined in the CDS. Caution: You can renumber the positions in the SEQ file (The Number of the First Base, the mRNA Start and End values, the Coding Sequence Start and End values, and the Region of Interest Start and End values) so that the numbering is relative to the CDS and not to the genomic positions (which is the numbering scheme in the GAD); however, if you do renumber the positions, then the position at the end of one sequence file might overlap the position at the beginning of the next sequence file, which can cause difficulty in your data analysis.</td>
</tr>
<tr>
<td>Note:</td>
<td>Even if you modify the information for both the CDSs and the ROIs on this tab, your project's graphical output can be limited based on the options that you have selected for Output Limits. See &quot;Output Limits&quot; on page 63.</td>
</tr>
<tr>
<td>Amino Acid Sequence</td>
<td>The starting codon and ending codon numbers for the amino acid string for which the currently loaded CDS codes. If the starting and ending coding sequence positions are populated and you enter only the starting amino acid string number, and then click Refresh, Mutation Surveyor automatically calculates the ending number for the string. Note: To display the amino acid sequence in the standard mutation reports and the GAD, Amino Acid must be selected on the Output tab of the Project Options dialog box. See &quot;Output tab&quot; on page 62.</td>
</tr>
<tr>
<td>• Starting Vector Sequence</td>
<td>Trims a sample sequence according to a starting vector sequence and an ending vector sequence. To carry out a vector trim: • You must specify both the vector base sequence and the clone DNA base sequence in the Sequence field. • You must specify the starting vector sequence in the Starting Vector Sequence field. • You must specify the ending vector sequence in the Ending Vector Sequence field. Mutation Surveyor carries out a “loose match” between the vector base sequence and the starting and ending vector sequences to determine the regions of the SEQ reference file that contain the vector sequence. When a sample trace aligns to both the vector sequence and the cDNA sequence of the SEQ reference file, Mutation Surveyor adjusts the mutation detection region inward to avoid mutation detection in the vector sequence of the sample traces. Note: To carry out a vector trim, Vector Trimming must be selected on the Options tab of the Project Options dialog box. See “Contig tab” on page 55. Mutation Surveyor trims the data according to the specified values and indicates the boundaries with vertical blue bars in the GAD. Note: You can also use the Mask Vector Sequence tool to replace base calls in the vector sequence region. See “Mask Vector Sequence Tool” on page 291.</td>
</tr>
</tbody>
</table>
Variations If you modify or enter known sequence variations, the variations must adhere to a specific layout:

- **Substitution:**
  - `<position><variant>/<normal>(<dbSNP_Identifier>)`
  - **Example:** 30565C/T(dbSNP:8176209)

- **Insertion:**
  - `<position_before>..<position_after>-/<nucleotides>(<dbSNP_identifier>)`
  - **Example:** 30609..30610-/C(dbSNP:35466763)

- **Deletion:**
  - `<position_1>..<position_N><nucleotides>/-(<db_SNP_Identifier>)`
  - **Example:** 31549..31552GCAG/-(dbSNP:84678345)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variations</td>
<td>If you modify or enter known sequence variations, the variations must adhere to a specific layout:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Substitution:</strong></td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;position&gt;&lt;variant&gt;/&lt;normal&gt;(&lt;dbSNP_Identifier&gt;)</code></td>
</tr>
<tr>
<td></td>
<td>- <strong>Example:</strong> 30565C/T(dbSNP:8176209)</td>
</tr>
<tr>
<td></td>
<td>- <strong>Insertion:</strong></td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;position_before&gt;..&lt;position_after&gt;-/&lt;nucleotides&gt;(&lt;dbSNP_identifier&gt;)</code></td>
</tr>
<tr>
<td></td>
<td>- <strong>Example:</strong> 30609..30610-/C(dbSNP:35466763)</td>
</tr>
<tr>
<td></td>
<td>- <strong>Deletion:</strong></td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;position_1&gt;..&lt;position_N&gt;&lt;nucleotides&gt;/-(&lt;db_SNP_Identifier&gt;)</code></td>
</tr>
<tr>
<td></td>
<td>- <strong>Example:</strong> 31549..31552GCAG/-(dbSNP:84678345)</td>
</tr>
</tbody>
</table>

**Amino Acid Sequence**
The amino acid sequence that corresponds to the base sequence beginning one base after the Start base indicated for the Amino Acid Start. The string is shown using standard IUB/IUPAC amino acid codes.

**Amplicon ID**
Amplicon ID is always an optional value for the ROI; however, if your samples overlap and you are using amplicons to construct contigs, then to ensure proper alignment, the Amplicon ID should be the same as the Amplicon ID that is used in your sample filenames. (See “Use Amplicon to Construct Contig” on page 57.)

**Is Last mRNA**
Select this option if the SEQ file contains the last base of mRNA for the gene.  
**Note:** Mutation Surveyor does not automatically add a checkmark to the “Last mRNA” field for the SEQ file that contains the last base of mRNA when you create SEQ files from the Advanced GBK File Editor.  
**Note:** The Relative to mRNA nomenclature outputs IVS*5 for a position that is 5 bases after the mRNA, rather than IVS3123+5, indicating that the position is outside of the mRNA, and not within an intron.
SEQ File Editor tool functions

The SEQ File Editor tool contains several functions for working with the loaded SEQ file. In addition to being able to modify values directly in the editor, you can:

- Search the loaded SEQ file for a specific sequence. See “To search the loaded SEQ file for a specific sequence” below.
- Adjust the number of the first coding base or the sequence start. See “To adjust the number of the first coding base or the sequence start” on page 251.

To search the loaded SEQ file for a specific sequence

1. On the SEQ File Editor main menu, click Search > Search in Sequence.

   The Search in Sequence dialog box opens.

   Figure 8-29: Search in Sequence dialog box

2. Enter the sequence for which to search in this dialog box.

3. Optionally, to reverse complement the sequence before searching, click Complementary.

   If the sequence is found, the sequence text display in the middle section is moved to the first occurrence of the sequence and the text is displayed in pink on the tab.

   Figure 8-30: Located sequence in sequence text display

   For gagaagttggat ttcggaggtgt gacagatggq tattctttag ggggggtag ggggggac
To adjust the number of the first coding base or the sequence start

At times, you might want to adjust the number of the first base or the first coding base in a SEQ file. For example, if a promoter region is 500 bps, then the sequence start that typically is 1 is now 501, but you still want the sequence start to be 1.

1. On the Advanced GBK File Editor main menu, click Tools > Adjust.

   The Adjust File dialog box opens.

   *Figure 8-31: Adjust File dialog box*

   ![Adjust File dialog box]

2. Set your options as appropriate.

3. Click OK.

   The SEQ File Editor display is updated accordingly.
Chapter 9
Mutation Surveyor Tools

Mutation Surveyor provides many tools for optimizing input data and analyzing results, including tools for modifying filename information to ensure the correct grouping of sample files in a project, tools for converting files from one format to another, and tools for assembling sample files and project files for comparison.

This chapter covers the following topics:

- “Sample File Editing Tools” on page 255.
- “File Conversion Tools” on page 269.
- “Assembly Tools” on page 277.
- “Other Tools” on page 289.
Section 1
Sample File Editing Tools

Section Contents

- “Filename Editor Tool” on page 257.
- “2D Filename Match Editor tool” on page 261.
- “ND Filename Match Editor Tool” on page 264.
- “Print Header Editor Tool” on page 267.
Filename Editor Tool

You use the FileName Editor tool to modify your sample filenames to ensure that your sample files will be grouped correctly in a Mutation Surveyor project. You can use the tool to modify sample filenames programmatically, or you can manually change filenames using a tab-delimited text file.

To programmatically change filenames

1. On the Mutation Surveyor main menu, click Tools > Filename Editor.

   The Filename Editor window opens.

   Figure 9-1: Filename Editor window

2. Click the Browse button next to the From field, and browse to and select the directory that contains the sample files for which you are modifying the names.

   A list of all the sample files in the selected directory is displayed in the From (left) pane of the window.

3. Click the Browse button next to the To field, and browse to and select the directory that is to contain the renamed sample files.

   If you select the same directory for the From and To lists, then your original files are replaced with the edited files, so select the same directory only if you do not want to retain your original files.
4. Select the option by which to modify your existing sample filenames.

A placeholder in the form of *.* is displayed in the blank field below the From field and below the To field. The asterisk (*) in this placeholder is a wildcard character, which is a special character that represents one or more characters in a string of characters. For example, in searching, “run*” implies to search for any word that starts with “run” and that has any ending, such as running, runt, runs, rundown, and so on.

5. In the From field, enter the part of the filename that is to be replaced or removed between the asterisks.

The list of sample files temporarily disappears from the From list as you enter the part of the filename that you want to remove. The list is displayed again after Mutation Surveyor recognizes the part of the filename that you have entered.

6. In the To field, enter the characters that are to replace the filename or part of the filename between the asterisks. If you have selected Overwrite and you simply want to remove a selected part of the filename, enter **.

Whatever value that you enter in the From field is automatically entered in the To field as well, so you must make sure to edit the value in the To field correctly.

7. Click Refresh.

The list of edited sample names is displayed in the To (right) pane of the window.

**Figure 9-2: Overwrite example (characters replaced)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overwrite</td>
<td>Replaces all or part of the original filename. You can replace part or all the filename with different characters, or you can replace all or part of the filename with no characters, which essentially removes the specified part of the filename.</td>
</tr>
<tr>
<td>Use*_.1</td>
<td>Replaces all or part of the original filename and then sequentially numbers any identically named files.</td>
</tr>
<tr>
<td>Use *_.erase part</td>
<td>Removes specified characters from the filename. The remaining characters make up the new filename.</td>
</tr>
</tbody>
</table>
8. Do one of the following:
   - If you selected the same directory for the From and To lists, click Rename.
   - If you selected different directories for the From and To lists, click Copy.

To manually change filenames

1. Create a tab-delimited text file that has two columns. In the first column, enter the current filenames. In the second column, enter the target filenames.
2. Save the text file in the same directory as the sample files.
3. On the Mutation Surveyor main menu, click Tools > Filename Editor.
   The Filename Editor window opens.
4. Click Rename Text File.
Chapter 9
Mutation Surveyor Tools

5. Click the Browse button next to the From field, and browse to and select the text file.

   A list of all the sample files in the selected directory is displayed in the From (left) pane of the window.

6. Click the Browse button next to the To field, and browse to and select the directory that is to contain the renamed sample files.

   If you select the same directory for the From and To lists, then your original files are replaced with the edited files, so select the same directory only if you do not want to retain your original files.

7. Click Rename.

   The list of edited sample names is displayed in the To (right) pane of the window.
2D Filename Match Editor tool

If your sample files are named in such a way that neither Mutation Surveyor’s default project options nor Mutation Surveyor’s automatic file pairing options result in your sample files being paired correctly, you should use the 2D Filename Match Editor tool to create a Grouping File. A Grouping File is a text file that defines how your sample files should be paired in your Mutation Surveyor project. You can point to the Grouping File in your Mutation Surveyor project, and all the sample files that are defined in the file are added to the project.

To use the 2D Filename Match Editor tool

1. On the Mutation Surveyor main menu, click Tools > 2D Filename Match Editor.
   The 2D Filename Match Editor window opens.

Figure 9-6: 2D Filename Match Editor window
2. Click Add.
   The Open Files dialog box opens.

   **Figure 9-7: Open Files dialog box**

3. In the Sample Files (lower) pane, click Add, and then click Add Files or Add Directory to select the samples files that are to be grouped.

   If you are adding files, CTRL-click to select multiple non-contiguous files. 
   SHIFT-click to select multiple contiguous files. If you are adding a directory, then all the files in the directory are added in a single step.

4. Click OK.
   The samples files are added to the 2D Filename Match Editor window. Mutation Surveyor initially tries to correctly group the sample files based on information in the sample file names such as *_F and *_R.

   **Figure 9-8: 2D Filename Editor window with files paired by Mutation Surveyor**
5. If the automatic pairing is correct, then continue to Step 6; otherwise, continue to Step 7.

6. Click Save to open the Save Result dialog box in which you can specify a name for saving the Grouping File.

   By default, the Grouping File is saved as a text file in the same folder as all the sample files. You must not change this location, or the Grouping File function will not work.

7. If the automatic pairing is not correct, then do one or more of the following to correctly pair your sample files:

   • Add a GenBank file to assist Mutation Surveyor in aligning and pairing the sample files.
   • Select a file and use the Forward (F--> R) or Reverse (F <--R) buttons to move the sample file to the correct list. After you have moved all the necessary files, click Refresh to have Mutation Surveyor try to correctly group the sample files based on information in the sample file names such as *_F and *_R.
   • Select a file and use the Forward (F--> R) or Reverse (F <--R) buttons to move the sample file to the correct list. After you have moved all the necessary files, edit the order of the lists. (To edit the order, click a position number to select it, change the position number accordingly, and then click Refresh.)
   • Use model files to correctly pair sample files.
     • Identify two forward sample files and two reverse sample files that are appropriate to serve as “model” files.
     • Move the reverse sample files to the Reverse Files list.
     • Right-click each forward sample file and on the context menu that opens, click Copy to Model. Repeat this step for the reverse sample files.
   • Click Model Match to correctly pair the remaining sample files.

8. Click Save to open the Save As dialog box in which you can specify a name for saving the Grouping File.

   By default, the Grouping File is saved as a text file in the same folder as all the sample files. You must not change this location, or the Grouping File function will not work.
**ND Filename Match Editor Tool**

You use the ND Filename Match Editor tool to create a Grouping file that can assist in grouping sample files correctly in the Project report and in the SGP Comparison tool. The sample files can be .scf files or .abi/ab1 files.

---

**You do not have an option to load the ND Grouping file for the Project report after running a Mutation Surveyor project. To use the ND Grouping file for the Project report, when setting up your Mutation Surveyor project, you must select Load Grouping File on the Open files dialog box, and then click Add in the Sample Files pane to select the Grouping file. All the sample files that are listed in the Grouping file are added to the project. Although Mutation Surveyor attempts to use the information in the Grouping file to group the sample files in the project, the Grouping file’s primary purpose is for the grouping of sample files in the Project report, the Project Sample Assembly subreport, and the Comparison functions.**

---

**To use the ND Filename Match Editor**

1. On the Mutation Surveyor main menu, click Tools > ND Filename Match Editor.

*Figure 9-10: ND Filename Match Editor window*
2. Click Add to open the Open Sample Files dialog box and select the sample files that are to be grouped.

CTRL-click to select multiple non-contiguous files. SHIFT-click to select multiple contiguous files.

The sample files are displayed in the ND Filename Match Editor window. Each row in the window represents a group of sample files. By default, the sample files are first grouped by comparing the filenames from character one to character five.

Figure 9-11: ND Filename Match Editor window with grouped sample files

3. Optionally, to modify the sample file grouping, change the character values for Compare Filename, and then click Refresh.

4. When you are satisfied with the sample grouping, do one of the following to save the Grouping file as a text file:

   • If you are saving the Grouping file in the same location as the sample files, click Save As to open the Save As dialog box in which you can specify a name and a location for saving the Grouping file as a text file.

   By default, the Filename file is populated with _NDMatch.txt. You can change the name, but you cannot change the file type. The Grouping file lists each row from the display as a single line in the text file.

Figure 9-12: ND Grouping file saved in same location as the sample files
• If you are saving the Grouping file in a different location than all the sample files, then click Save Full Path of Sample Files, and then click Save As to open the Save As dialog box in which you can specify a name and a location for saving the Grouping file as a text file.

By default, the Filename file is populated with _NDMatch.txt. You can change the name, but you cannot change the file type. The Grouping file lists each row from the display as a single line in the text file with the full path to the file name included.

Figure 9-13: ND Grouping file saved in a different location than the sample files

5. Click Close.

Even if you close, and then reopen Mutation Surveyor, the ND Filename Match Editor tool “remembers” the last settings specified for it.
Print Header Editor Tool

You use the Print Header Editor tool to create a custom header that can be displayed at the top of designated output files.

To use the Print Header Editor tool

1. On the Mutation Surveyor main menu, click Tools > Print Header Editor.

   The Print Header Editor window opens.

   *Figure 9-14: Print Header Editor window*

2. Do one of the following:
   - Modify any of the default template information in either column.
   - Click Open to select an existing custom header file to modify.

   *When modifying an existing custom header, click Default at any time to reset all values in both columns to their original values.*

3. Optionally, add or delete rows of information as needed.
   - To delete a row from the header, right-click the row, and then click Delete a Row.
   - To insert a row into the header, right-click the row that is to be located below the inserted row, and then click Insert a Row.
   - To add a row as the last row in the header, right-click any row, and then click Add a Row.

4. Click Save to save the custom header as an .inf file.
Section 2
File Conversion Tools

Section Contents

- Create SCF Tool on page 271
- Convert to SCF tool on page 274
- Extract SGP Tool on page 275
Create SCF Tool

You use the Create SCF tool to create a synthetic or pseudo trace file from the sequence in a SEQ file or in a GBK file. Traces are created in both the forward and reverse direction whenever possible and are saved as .scf files.

Synthetic traces versus pseudo traces

At a minimum, you must load a GenBank file in the Create SCF tool to create SCF files. Loading sample traces is optional.

- If you do not load sample traces, then the output is one forward and one reverse trace for the first 2500 of the loaded GenBank file, or all the bases if the GenBank file contains less than 2500 bases. Each peak is 3000 RFU.

- If you load sample traces, and no match between the sample traces and the GenBank file is found, then a trace file is created for the first 2500 bases of the loaded GenBank file, or all the bases if the GenBank file contains less than 2500 bases. Each peak is 3000 RFU.

- If you load sample traces and a match between the sample traces and the GenBank file is found, then the trace option that is selected—Synthetic or Pseudo—determines the characteristics of the trace that is created.

  - If Synthetic is selected, then the resulting SCF file has a peak profile similar to that of the synthetic reference traces that Mutation Surveyor creates. The height of all four peaks at a given location are summed together and the base call and color is that of the nucleotide in the GenBank sequence at the given position.

Figure 9-15: Actual trace compared to a synthetic trace
• If Pseudo is selected, then the resulting SCF file has a peak profile similar to that of the original matched trace with one exception—positions where the base call differs between the loaded trace and the GenBank file are given the base call and color of the GenBank file. For example, in Figure 9-16, note how the actual 179N was replaced with a pseudo 160C.

Figure 9-16: Actual trace compared to pseudo trace

To use the Create SCF tool

1. On the Mutation Surveyor main menu, click Tools > Create SCF.

The Create SCF File window opens.

Figure 9-17: Create SCF File window
2. Leave the default selection of Synthetic as is, or click Pseudo.

3. In the GenBank files (upper) pane, click Add to open the Open Files dialog box, and select the .seq or GBK files that are to be used for creating the trace.

4. If you selected Synthetic, then continue to Step 6; otherwise, continue to Step 5.

5. In the *.SCF/AB1/ABI Files (lower) pane, click Add, and then click Add Files or Add Directory to select the samples files that are to be used for creating the pseudo trace.

   If you are adding files, CTRL-click to select multiple non-contiguous files. SHIFT-click to select multiple contiguous files. If you are adding a directory, then all the files in the directory are added in a single step.

6. Click the Browse button to open the Save As file dialog box in which you can specify a name and location for the saved trace file.

   • Forward and reverse synthetic trace files are saved as *_F_synthesis.scf and as *_R_synthesis.scf, respectively.

   • Forward and reverse pseudo trace files are saved as *_F_pseudo.scf and as *_R_pseudo.scf, respectively.
Chapter 9
Mutation Surveyor Tools

Convert to SCF tool

You use the Convert to SCF tool to convert an .abi/.ab1 file to an .scf file, which is a smaller file format. You can also use the Convert to SCF tool to convert a .fasta file to a .scf file; however, only the first 1200 bases in the .fasta file are converted.

To use the Convert to SCF tool

1. On the Mutation Surveyor main menu, click Tools > Convert to SCF.

   The Convert to SCF File window opens.

   Figure 9-18: Convert to SCF File window

2. Click Add to the right of the Open *.ab1/*.abi/*.fasta Files field. The Open Files dialog box opens.

   Select the files that are to be converted, and then click Open to add the files to the Convert to SCF tool.

3. In the Output Directory field, leave the default location and name for the .scf file as is, or click the Browse button to open the Browse for Folder dialog box in which you can select a different location for saving the .scf file.

4. Click Save.
Extract SGP Tool

You use the Extract SGP Tool to extract GenBank files, sample files, and reference files from an SGP file. The sample traces are not extracted as the originally loaded .abi/.ab1 files. Instead, they are extracted as .scf files, which is the portion of the originally loaded files that was used for analysis in the project. The reference trace is extracted whether it was a loaded trace or a generated trace. The project settings and any comments added to the project are not extracted.

To use the Extract SGP tool

1. On the Mutation Surveyor main menu, click Tools > Extract SGP.

   The Extract SGP window opens.

   Figure 9-19:  Extract SGP window

2. In the Input pane, click the Browse button to open the Open Mutation Project dialog box and select the mutation project files that are to be extracted.

3. In the Output pane, leave the default location and name for the extracted files as is, or click the Browse button to open the Browse for Folder dialog box in which you can select a different location for saving the extracted files.

4. Click OK.

   If you close, and then reopen Mutation Surveyor, the Extract SGP tool “remembers” the last settings specified for it.
Section 3
Assembly Tools

Section Contents

• SGP Comparison Tool on page 279
• Mutation Assembly Tool on page 284
• Sequence Assembly Tool on page 287
SGP Comparison Tool

You use the SGP Comparison tool to assemble multiple Mutation Surveyor projects and compare and contrast these projects. The SGP files to which other SGP files are being compared are the control files, or the standard. The SGP files that are being compared are the unknown files, or the sample. The report that is produced by the SGP Comparison tool is color-coded to assist in the identification of inconsistent mutations between the standard files and the unknown files. You can also use the report for somatic variant detection by comparing normal and tumor samples, comparing samples that are in the same project or multiple projects, and identifying the differences between analysts' reviews. The report is also ideal for auditing purposes.

Before you use the SGP Comparison tool, you might need to correctly group the SGP files that are being compared. See “ND Filename Match Editor Tool” on page 264.

To use the SGP Comparison tool

1. On the Mutation Surveyor main menu, click Tools > SGP Comparison tool.

   The SGP Comparison window opens.

   If a project is already loaded in Mutation Surveyor when you open the SGP Comparison tool, then this project is automatically loaded into the tool.

Figure 9-20: SGP Comparison window
2. On the SGP Comparison window toolbar, click the Add SGP Files button.

The Open SGP Files dialog box opens.

Figure 9-21: Open SGP Files dialog box

3. Click Add to open the Open Files dialog box opens, select the SGP files that are to be compared, and then click OK.

The Open Files dialog box closes. The SGP files are added and displayed in the Mutation Surveyor main window.

4. On the Mutation Surveyor main menu, click Tools > SGP Comparison to bring the SGP Comparison window to the front.

All the sample files in each of the SGP files are grouped together. The separate SGP projects are highlighted in different colors.

Figure 9-22: SGP Comparison window with loaded SGP files
5. To correctly group the sample files, click the Group Sample Files icon.

The Sample Grouping dialog box opens.

*Figure 9-23: Sample Grouping dialog box*

6. Specify the filename substring by which Mutation Surveyor is to group all the samples files within a mutation project, and then click OK.

   - n-Primer (n-D) Text Input—Use the ND Grouping file to group the sample files. See “ND Filename Match Editor Tool” on page 264.

   - Filename Match (based on one of the following):
     - From Character [ ] To Character [ ]—If all the filenames in your project contain the same characters/designator in the same positions, then select this option and enter the starting and ending character positions.
     - Typical Block—If all the filenames in your project contain the same characters/designator but in different positions, then select this option and enter the value for the character/designator block.

   The display in the SGP Comparison window is refreshed to reflect the groupings.

7. Click the Select Standard icon .

The Select Standard dialog box opens.

*Figure 9-24: Select Standard dialog box*
8. Select either an entire mutation project as the standard (the default option), or click Select standard from sample files and in the Typical Block field, enter a character string that is contained in the names of all the sample files that you want to use as a standard.

9. Click OK to close the Select standard dialog box and return to the SGP Comparison window.

10. Click the SGP Comparison icon.

The SGP Comparison report opens. By default, this report shows all the mutations in all the SGP projects. The mutations are color-coded for identification.

---

**Click Color Code link to open the Color Code dialog box which details the color coding legend used in the report.**

Figure 9-25: SGP Comparison report

The report is interactive:

- To open the Color Code dialog box and view the color legend that is used in the report, click Color Code.
- To freeze the Sample File column while scrolling, leave Lock sample File in View selected.
- To view only those mutations that are inconsistent between the standard and the unknown files, click Display Inconsistent Mutations Only.
- To save the entire report, click the Save Report icon to open the Save As dialog box in which you can specify a name and location for saving the report as well as its format (.txt, .xls/.xlsx, .xml, or .htm).
- To export only the sample files that contain inconsistent mutations as .scf files, click the Export Sample Files with Inconsistent Mutations icon to open the Browse for Folder dialog box in which you can specify a location to which to export the files.
- To copy selected text in a cell to your clipboard, right-click and select Copy. To copy text
in a range of cells, click and hold the left mouse button and drag the mouse to select the region that you want to copy. Use standard keyboard commands or menu commands to paste the copied text into an application.

- To copy the SGP Comparison report as an image, press and hold the [Shift] key and the [Ctrl] key and then click and hold the left mouse button and draw a box around the region of the image that you want to copy. The selected region is filled with black. Right-click and select Copy to copy the image to your clipboard. Use standard keyboard commands or menu commands to paste the copied image into an application.
Chapter 9
Mutation Surveyor Tools

Mutation Assembly Tool

The Mutation Assembly Tool is especially useful for cDNA projects. You can use the tool to upload mutation project files and identify mutations in the files using cDNA nomenclature. Also, you can use the Sample Grouping options to create a consensus of all mutation calls within a single row or column for a group of sample traces. This approach is useful for merging the results of several patients that were run over multiple projects.

To use the Mutation Assembly tool


   Figure 9-26: Mutation Assembly window

2. Click Add to open the Open Files dialog box and select the SGP files that are to be assembled.

   Figure 9-26: Mutation Assembly window
3. In the Sample Grouping pane, specify the filename substring by which Mutation Surveyor is to group all the samples files within the selected mutation projects, and then click OK.
   
   - n-Primer (n-D) Text Input—Use the ND Grouping file to group the sample files. See “ND Filename Match Editor Tool” on page 264.
   
   - Filename Match (based on one of the following):
     
     - From Character [ ] To Character [ ]—If all the filenames in your project contain the same characters/designator in the same positions, then select this option and enter the starting and ending character positions.
     
     - Typical Block—If all the filenames in your project contain the same characters/designator but in different positions, then select this option and enter the value for the character/designator block.

4. Click OK.

   The Mutation Assembly report opens. This report lists all the identified mutations in the loaded mutation project files using cDNA nomenclature.

   **Figure 9-27: Mutation Assembly report**

   If you close, and then reopen Mutation Surveyor, the Mutation Assembly tool “remembers” the last settings that specified for it.
Chapter 9
Mutation Surveyor Tools

The report is interactive:

- To save the entire report as a text file, click the Save Report icon to open the Save As dialog box in which you can specify a name and location for saving the .txt file.
- To change the information that is displayed in the report, click the Report Settings button to open the Mutation Assembly Report Settings dialog box which contains options for filtering the information that is to be displayed in the report.

Figure 9-28: Mutation Assembly Report Settings dialog box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Display                 | • Display Mutations in Rows—Mutations displayed as a matrix of samples versus reported mutations.  
                          | • Display Mutations in Columns—Mutations displayed as a matrix of reported mutations versus samples. |
| Mutation Parameters     | • Display Nucleotide Only—Display only the base number and the bases involved in the mutation in the mutation code.  
                          | • Display Nucleotide and Amino Acid—Display the base number, the bases involved in the mutation, and the amino acids (the normal amino acid that is affected by the mutation and the resulting amino acid) in the mutation code.  
                          | • Intelligent Output—The default selection. Shows nomenclature “Relative to CDS” when the mutation call is outside of the CDS and only the resultant amino acids when the mutation call is within the CDS. |
| Number Base Relative to cDNA | Selected by default. The base number that is used in the mutation code is numbered relative to the cDNA region, where the beginning base for the region is Base #1, the second base in the region is Base #2, and so on. Clear this option to use the genomic base position for the base number in the mutation code. |
Sequence Assembly Tool

You use the Sequence Assembly to carry out de novo assembly of overlapping contigs and then save the assembled information as a .seq file. You can then use this .seq file as a GenBank file in a Mutation Surveyor project.

To use the Sequence Assembly tool

1. On the Mutation Surveyor main menu, click Tools > Sequence Assembly.
   The Sequence Assembly window opens.

   *Figure 9-29: Sequence Assembly window*

2. Click Add to open the Open Files dialog box and select the files that are to be used for the assembly. (The files can be .scf or .abi/.ab1 files.)

3. In the Output Seq File field, leave the default location and name for the .seq file as is, or click the Browse button next to the field to open the Save As dialog box in which you can specify a name and location for saving the .seq file.
4. Click Save.

   The SEQ file is saved as one long unbroken string of nucleotides (.fasta format) in a single file.

   **Figure 9-30: Saved SEQ file**

   ![Saved SEQ file](image)

5. Load this file into the SEQ File Editor (see “SEQ File Editor Tool” on page 246) and save the file using the editor.

   By loading and saving the SEQ file in the SEQ File Editor, the file is saved in a GenBank format, so, you can now use the file directly in Mutation Surveyor, or you can first annotate the file to identify CDSs, variations, and so on before use.
Section 4
Other Tools

Section Contents

- Mask Vector Sequence Tool on page 291
- Output Trace Data Tool on page 293
- BasePatch Tool on page 295
- The HLA Tool on page 297
Mask Vector Sequence Tool

You use the Mask Vector Sequence tool to physically modify sample files and replace base calls in the vector sequence region with N calls. These N calls are displayed as such in the GAD. Two files are created with this tool—one file with the vector region masked and one file with the insert region masked.

You can use the Mask Vector Sequence tool to replace base calls in the vector sequence region, or you can select the Vector Trim option on the Mutation Surveyor Project Settings dialog box (see “Contig tab” on page 55) and trim the sample sequence according to a starting vector sequence and an ending vector sequence that you define using the SEQ File Editor tool. (See “SEQ File Editor Tool” on page 246.)

To use the Mask Vector Sequence tool

1. On the Mutation Surveyor main menu, click Tools > Mask Vector Sequence.

   The Mask Vector Sequence window opens.

   Figure 9-31:  Mask Vector Sequence window

2. Click Add in the Vector Sequence File pane to open the Open File dialog box and select the .seq or GBK file that contains the vector sequence.

3. Click Add in the Trace Files in the pane to open the Open File dialog box and select the trace (sample) files that are to be modified.

The tool works best when sample trace files are in the same orientation as the vector sequence.
4. In the Output Directory field, leave the default location as is, or click the Browse button to open the Browse for Folder dialog box in which you can select a different location for saving the sample files.

5. Click OK. The output directory will now contain two copies of each sample trace file that was loaded into the tool: one copy will have the vector sequence masked (*_NN.SCF) and one copy will have the sequence of the insert masked (*_AN.SCF).

6. Open a new Mutation Surveyor project. Use the *_NN.SCF files that you saved in Step 5 as the sample files and a GenBank file with the gene of interest as the GenBank file.
Output Trace Data Tool

You use the Output Trace Data tool to export information about selected traces such as frame number, base position and peak intensities to a tab-delimited text file. You can export information either by peak position or by frame.

To use the Output Trace Data tool

1. Open a Mutation Surveyor project.
2. On the Mutation Surveyor main menu, click Tools > Output Trace Data.
   
   The Output Trace Data window opens. This window lists all the sample traces for the Mutation Surveyor project, and by default, all the traces are selected for export.

   Figure 9-32:  Output Trace Data window

3. You can leave all sample traces selected, or you can clear the selections for the traces for which you do not want to export information.

   Click Select All to select all sample traces in a single step. Click Clear All to clear current selections in a single step.

4. Select the way by which you want to export the data (Peak Position or Frame-by-Frame) and then clear the selections for the information that you do not want to export for each peak or each frame.

By default, all information for a data type is selected for exporting. For information about Signal Factor intensity and Signal Factor Dev for Peak Position, see “Signal Factor Intensity and Signal Factor Dev” on page 294.
5. In the Output Directory field, leave the default location and name for the text file(s) as is, or click the Browse button to open the Browse for Folder dialog box in which you can select a different location for saving the text file(s).

6. Click Export.

The selected information is exported to a tab-delimited text file.

*Figure 9-33: Output Trace Data text file*

### Signal Factor Intensity and Signal Factor Dev

Each base call is derived from a peak of one dye color. Secondary peaks of other dye colors might be located under this major peak. For example, if the base call for nucleotide position 100 is A:

- **Signal Factor Intensity** = \( \frac{\text{Height}_A}{\text{Height}_A + \text{Height}_T + \text{Height}_C + \text{Height}_G} \)
- **Signal Factor Deviation** = \( \frac{\text{Dev}_A}{\text{Dev}_A + \text{Dev}_T + \text{Dev}_C + \text{Dev}_G} \)

where:

- \( \text{Dev}(i) = 2.0 \times \text{Height}(i) - \text{Height}(iL) - \text{Height}(iR) \)

and:

- \( \text{Height}(iL) \) is the peak height 4 bases to the left, or before, position 100: 100 - 4 = nucleotide position 96 for each peak height.
- \( \text{Height}(iR) \) is the peak height 4 bases to the right, or after, position 100: 100 + 4 = nucleotide position 104 for each peak height.
BasePatch Tool

You use the BasePatch Tool to narrow and sharpen broad peaks in previously run sample traces to make the peaks more discernible in the traces, and therefore, make it easier to identify variants in the traces. You can reprocess any type of sample trace file (AB1/ABI, SCF) with the BasePatch tool.

You would consider running the BasePatch tool on sample traces for which variant identification was inconclusive or difficult because of the shapes (broadness) of their peaks.

To use the BatchPatch tool

   
The BasePatch Tool window opens.

2. Click the Browse button next to the Input field, and browse to and select the folder that contains the sample traces that are to be reprocessed.
   
   By default, the Output directory is set to the same as that for the Input, and the Output folder is named Processed.

3. Optionally, click the Browse button next to the Output field, and browse to and select a different directory and/or folder in which to save the reprocessed sample traces.

4. Leave all the Options for the BasePatch tool selected.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baseline Subtraction</td>
<td>Has a minimal affect on the reprocessing because typically the Input sample traces already have had baseline subtraction carried out.</td>
</tr>
</tbody>
</table>
5. Click OK.

The BasePatch Tool window closes. The sample traces are reprocessed. You can now run these sample files in a Mutation Surveyor project to analyze the variants again. See “Setting up a Single Mutation Surveyor Project” on page 70.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak Sharpening</td>
<td>Applies the Mexican Hat Wavelet algorithm to narrow and sharpen the peaks in the sample traces. Leave the associated Peak Sharpening values (HalfPeak Width and Power) set to their default values. <strong>Note:</strong> For information about the algorithm and the Peak Sharpening values, contact <a href="mailto:tech_support@softgenetics.com">tech_support@softgenetics.com</a> for assistance.</td>
</tr>
<tr>
<td>IUPAC Base Calls</td>
<td>After reprocessing, the nucleotides in the sample traces are called again.</td>
</tr>
</tbody>
</table>
The HLA Tool

You use the HLA Tool to analyze Human Leukocyte Antigen (HLA) data. The output includes a .dat file that can be loaded into NextGENe for additional analysis.

To use the HLA tool

1. On the Mutation Surveyor main menu, click Tools > HLA.
   
The HLA Tool dialog box opens.

   *Figure 9-35: HLA Tool dialog box*

   ![HLA Tool dialog box]

2. In the Samples pane, click Add to open the Open Sample File dialog box, and browse to and select the data files for analysis.

3. In the GenBank Sequence File pane, click Add to open the Open Seq/Gbk files dialog box, and browse to and select the reference GenBank file for HLA genes.

   *You can load multiple reference GenBank files for HLA genes.*

4. In the Output field, you can leave the default value for the location of the output files as-is (the default value is the directory path for the input files), or you can click Set to select a different location.

5. Click OK.

   After processing, the Mutation report is automatically displayed in the Viewing and Reporting pane of the Mutation Surveyor main window. The output includes a .dat file that can be loaded into NextGENe for additional analysis.
Chapter 10
Mutation Surveyor Specialized Applications

In addition to the specific functions for which Mutation Surveyor is designed, you can use Mutation Surveyor for some specialized applications.

This chapter covers the following topics:

• “Methylation Detection” on page 301.
• “Mutation Quantifier Function” on page 303.
Methylation Detection

A variety of options are available for analyzing methylated DNA. Mutation Surveyor is designed specifically for analyzing methylated DNA that has undergone bisulfite treatment. When you use Mutation Surveyor to analyze methylated DNA that has undergone bisulfite treatment, the following caveats apply:

- You must use a GenBank or SEQ file as the reference file.
- The GenBank or SEQ file must be loaded in the forward strand orientation. If the file is not already in this orientation, you must use the Advanced GBK File Editor tool or SEQ File Editor tool to reverse complement the sequence. See “SEQ File Editor Tool” on page 246 and “Advanced GBK File Editor Tool” on page 231.
- You must select Methylation on the Others tab on the Mutation Surveyor Project Settings dialog box and you must specify whether the method of detection is to be Automethylation or Set by User. Additionally, the setting to Automatically Adjust GenBank Direction, located above the Methylation section of the Others tab, must be deselected. See “on page 66.

Bisulfite treatment of single-stranded DNA followed by PCR converts unmethylated cytosines that are outside of CpG islands to uracil. Unmethylated cytosines that are in CpG islands are also converted to uracil. Methylated cytosines are not converted. When evaluating bisulfite-treated DNA, Mutation Surveyor reads the cytosines that have been converted to uracils as thymines and methylated cytosines simply as cytosines.

Figure 10-1: Bisulfite treatment and PCR of methylated DNA

Because unmethylated sample positions in the comparison region are read as thymine, these
sample positions align to the reference file and Mutation Surveyor does not call mutations at these positions. Mutation Surveyor instead calls mutations in the comparison region only at positions where there is partial or complete methylation.

---

**How Mutation Surveyor calls mutations for methylated DNA assumes 100% conversion of the unmethylated cytosines to uracil during bisulfite treatment. To visually evaluate and confirm this assumption, a Methylation report is available. See “Methylation report” on page 203.**

---

**Figure 10-2 is an example of a GAD for a methylation detection analysis.** The top pane is the reference trace that was synthesized from the derivative GenBank file. The horizontal blue lines indicates positions where the reference file was originally a cytosine. The middle pane is the sample trace. The bottom pane is the mutation detection trace.

**Figure 10-2: GAD for methylation detection**

![GAD for methylation detection](image)
Mutation Quantifier Function

The Mutation Quantifier function quantifies the allele ratios (normal allele and mutant allele) of Sanger sequencing traces at specific locations in the genome. You can use software determined standards or set your own standards for calculating the mutant peak percentage according to the following formula:

\[ 100 \times \frac{\text{Mutant peak intensity}}{\text{Mutant peak intensity} + \text{Normal peak intensity}} \]

To run the Mutation Quantifier function

1. After running a Mutation Surveyor project, click on the Mutation Quantifier button from the main toolbar.

   The Mutation Quantifier dialog box opens. This dialog contains a tab for every contig in the Mutation Surveyor project.

   Figure 10-3: Mutation Quantifier dialog box

2. Select the method by which to run the quantification—Standardized Allele Ratio or Simplified Allele Ratio.

   The information that is displayed in the Mutation Quantifier report is completely different based on the method that you select. To see how two alleles vary with one sample trace, select Simplified Allele Ratio. To see how two alleles vary as compared to two Standard traces, select Standardized Allele Ratio.

3. If you selected Standardized Allele Ratio, continue to Step 4; otherwise, continue to Step 5.
4. For each contig in the project, do the following:

- Standard 1—The Standard 1 dropdown list is a list of all the sample files contained in the selected contig. Standard 1 serves as one of the control files for the mutation quantification calculation. Ideally, the sample file should show a mutation peak percentage of 0%, meaning that only the normal peak is present in the sample. You can select a sample file from the Standard 1 dropdown list, or leave the Standard 1 field blank to have Mutation Surveyor select the standard file.

- Standard 2—The Standard 2 dropdown list is a list of all the sample files contained in the selected contig. Standard 2 serves as one of the control files for the mutation quantification calculation. Ideally, the sample file should show a mutation peak percentage of 100%, meaning that the normal peak is not present in the sample. You can select a sample file from the Standard 2 dropdown list, or leave the Standard 2 field blank to have Mutation Surveyor select the standard file.

```
Ideally, the sample file should show a mutation peak percentage of 100% however, if necessary, you can select a heterozygous sample file that shows a mutation peak percentage of 50%.
```

5. Select the options for the quantification.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Mutations</td>
<td>Select this option to quantify substitution mutation peaks.</td>
</tr>
</tbody>
</table>
| Process 2D Small Peaks        | Select this option to quantify 2D small peaks that have been identified by Mutation Surveyor.  
  **Note:** You can select this option only if Check 2D Small Peaks (Mosaic) was selected for the project. See "Check 2D Small Peaks (Mosaic)" on page 65. |
| Points of Interest            | Select this option to enter specific loci for quantification of mutation peaks. |

6. Click OK.

The Mutation Quantifier report window opens. The information that is displayed in the report and the toolbar buttons that are available depend upon the option that you selected in Step 2—Standardized Allele Ratio or Simplified Allele Ratio. In addition, the buttons that are available on the toolbar are different. See:

- “Mutation Quantifier report, Standardized Allele Ratio selected” on page 305.
- “Mutation Quantifier report, Simplified Allele Ratio selected” on page 307.
Mutation Quantifier report, Standardized Allele Ratio selected

With Standardized Allele Ratio selected, the Mutation Quantifier report displays the percent decrease in intensity for the normal nucleotide peak and the percent increase in intensity for the mutant nucleotide peak for all identified mutations in the sample files. The report also contains a toolbar with buttons that are specific for working with the report and for changing the information that is displayed in the report.

**Figure 10-4: Mutation Quantifier report, Standardized Allele Ratio selected**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contig</td>
<td>Contig number for the sample file and the direction of the sample file.</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample filename.</td>
</tr>
<tr>
<td>GenBank</td>
<td>The SEQ/GBK reference file to which the sample file was compared.</td>
</tr>
<tr>
<td>Base Seq</td>
<td>The genomic position of the mutation in the sample file.</td>
</tr>
<tr>
<td>Standard1</td>
<td>The sample file used for Standard 1.</td>
</tr>
<tr>
<td>Standard2</td>
<td>The sample file used for Standard 2.</td>
</tr>
<tr>
<td>Mutation</td>
<td>The mutation shown as Normal Base &gt; Mutant Base. <strong>Note:</strong> If the mutation is heterozygous, for example, G &gt; GA, then only the mutant allele (in this example, A) is displayed in the Mutation Quantifier report.</td>
</tr>
<tr>
<td>SC Drop</td>
<td>Single Color Drop. Measures the drop in peak intensity at the normal position by normalizing the peak intensity between the reference peak from Standard 1 and the sample peak at the first four positions on both sides of the normal peak that are located greater than 1 bp away from the normal peak (referred to as the local area) and that have the same color as the normal peak.</td>
</tr>
<tr>
<td>SC Gain</td>
<td>Single Color Gain. Measures the increase in peak intensity at the mutant position by normalizing the peak intensity between the reference peak from Standard 2 and the sample peak at the first four positions on both sides of the variant that are located greater than 1 bp away from the mutant peak (referred to as the local area) and that have the same color as the mutant peak.</td>
</tr>
</tbody>
</table>

**Note:** Neighboring peaks at +/- 1 bps are not used for the measurement because their intensities are often affected by the mutation. Single color peaks that might contain mosaic or heterozygous mutations are also not used for the measurement. If such a peak is found in the local area, then drop or gain cannot be calculated.

**Note:** A question mark (?) indicates inconclusive data that was the result of poor standards or poor peaks in the local area, such as mosaic or heterozygous mutations.
The report is interactive:

- To sort the report results, click any column heading.
- To view the electropherogram for a mutation compared to the electropherograms for the standards, double-click the mutation. The mutation is marked with a red dot in the display.

In Figure 10-5, the horizontal red bars were manually added to assist you with visualization. They do not normally appear in the display. For the drop in “C,” compare the Cs between Standard 1 and the sample. For the increase in “T,” compare the Ts between Standard 2 and the sample. The sample drop displays a “?” because the Cs in the local area of the sample peak are heterozygous, and reliable determination of the drop is not possible.

Figure 10-5: Display for mutation quantification, Standardized Allele Ratio selected
Mutation Quantifier report, Simplified Allele Ratio selected

With Simplified Allele Ratio selected, the Mutation Quantifier report displays all peak values in RFUs rather than as percentages. The report also contains a toolbar with buttons that are specific for working with the report and for changing the information that is displayed in the report.

*Figure 10-6: Mutation Quantifier report, Simplified Allele Ratio selected*

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contig</td>
<td>Contig number for the sample file and the direction of the sample file.</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample filename.</td>
</tr>
<tr>
<td>Position</td>
<td>The genomic position of the mutation in the sample file.</td>
</tr>
<tr>
<td>Normal</td>
<td>The normal base as reported for the reference.</td>
</tr>
<tr>
<td>Mutation</td>
<td>The mutant base as reported in the GAD.</td>
</tr>
<tr>
<td>Note:</td>
<td>If the mutation is heterozygous, for example, G &gt; GA, then only the mutant allele (in this example, A) is displayed in the Mutation Quantifier report.</td>
</tr>
<tr>
<td>Norm_Height</td>
<td>The peak height (in RFUs) of the normal allele.</td>
</tr>
<tr>
<td>Mut_Height</td>
<td>The peak height (in RFUs) of the mutant allele.</td>
</tr>
<tr>
<td>Norm_Neighbors</td>
<td>Average peak height (in RFUs) for the first four base positions on both sides of the normal peak that are located greater than 1 bp away from the normal peak (referred to as the local area) and that have same color as the normal peak.</td>
</tr>
<tr>
<td>Mut_Neighbor</td>
<td>Average peak height (in RFUs) for the first four base positions on both sides of the mutant peak that are located greater than 1 bp away from the mutant peak (referred to as the local area) and that have same color as the mutant peak.</td>
</tr>
<tr>
<td>Norm_Percent</td>
<td>Normal peak percentage.</td>
</tr>
<tr>
<td>Mut_Percent</td>
<td>Mutant peak percentage.</td>
</tr>
</tbody>
</table>
Chapter 10
Mutation Surveyor Specialized Applications

The report is interactive:

- To sort the report results, click any column heading other than Mut_Height, Norm_Neighbor, Mut_Neighbor, or Mut_Percent.
- To view the electropherogram for a mutation, double-click the mutation. The mutation is marked with a red dot in the display.

Figure 10-7: Display for mutation quantification, Simplified Allele Ratio selected

Mutation Quantifier toolbar

The Mutation Quantifier report toolbar contains buttons that are specific for working with the report and for changing the information that is displayed in the report.

Figure 10-8: Mutation Quantifier report toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Quantify]</td>
<td>Quantify—Opens the Mutation Quantifier dialog box. See “To run the Mutation Quantifier function” on page 303.</td>
</tr>
<tr>
<td>![Edit Groups]</td>
<td>Edit Groups—Available only when Standardized Allele Ratio is selected. Opens the Quantification Group Editor dialog box You can use the functions on this dialog box to manually select the sample files for Standard 1 and Standard 2 and recalculate the mutation quantification based on the settings (Process Mutations, and so on) that you previously selected in the Mutation Quantifier dialog box. See “Quantification Group Editor dialog box” on page 309.</td>
</tr>
</tbody>
</table>
You can use the functions on the Quantification Group Editor dialog box to manually select the sample files for Standard 1 and Standard 2 and recalculate the mutation quantification based on the settings (Process Mutations, and so on) that you previously selected in the Mutation Quantifier dialog box.

**Quantification Group Editor dialog box**

You can use the functions on the Quantification Group Editor dialog box to manually select the sample files for Standard 1 and Standard 2 and recalculate the mutation quantification based on the settings (Process Mutations, and so on) that you previously selected in the Mutation Quantifier dialog box.

**Figure 10-9:  Quantification Group Editor dialog box**
Chapter 10
Mutation Surveyor Specialized Applications

1. In the Seq Index field, enter the contig position of a known mutation in the selected mutation project and press [Enter].

Mutation Surveyor automatically identifies the base change and in the Samples pane, displays and highlights all the sample files that contain the specific mutation. Mutation Surveyor also automatically identifies the GenBank file to which the sample files were compared and selects the sample files for Standard 1 and Standard 2.

2. Do one of the following:

| If you are satisfied with Mutation Surveyor’s automatic selections: | 1. Click Add to update the Mutation Quantifier table with these selections.  
2. Click OK to recalculate the mutation quantifications based on the settings that you previously selected in the Mutation Quantifier dialog box.  

If you are not satisfied with Mutation Surveyor’s automatic selections: | 1. Make any changes as needed (for example, select a different sample file for Standard 1).  
2. Click Update to update the Mutation Quantifier table with these selections.  
3. Click OK to recalculate the mutation quantifications based on the settings that you previously selected in the Mutation Quantifier dialog box. |

**Mutation Quantifier report settings dialog box**
The Quantifier Report Settings dialog box contains options for filtering the information that is to be displayed in the report.

**Figure 10-10: Quantifier report settings dialog box**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Report Filter tab</strong></td>
<td></td>
</tr>
<tr>
<td>Show Standards</td>
<td>Show the sample files used for Standard 1 and Standard 2 in the report.</td>
</tr>
</tbody>
</table>
Chapter 10
Mutation Surveyor Specialized Applications

Shown Sample Threshold

- SC Drop—Show only those samples with an SC Drop greater than or equal to the indicated value.
- SC Gain—Show only those samples with an SC Gain greater than or equal to the indicated value.

**Note:** A sample must meet both of the specified thresholds to be displayed in the report.

- For Each 2D Sample—Selected by default. The quality of the sample pair at the same position is checked. When the SC Drop and the SC Gain of both pairs is met, then both values are displayed; otherwise, both values are hidden.

**Columns tab**—Select which columns are to be displayed in the Mutation Quantifier report.
Chapter 11
Multiple Projects

Mutation Surveyor also provides the capabilities for modifying existing projects, and for working with multiple projects. For example, you might need to merge multiple projects into one project for comparison purposes, or you might need to carry out batch processing of multiple projects.

This chapter covers the following topics:

• “Modifying Mutation Surveyor Projects” on page 315.
• “The Log File Wizard in the Mutation AutoRun Tool” on page 317.
• “The Mutation AutoRun Tool” on page 324.
Modifying Mutation Surveyor Projects

The Modify Mutation Projects function is available on the Mutation Surveyor main menu (File > Modify Mutation Projects) and it is also available from a button on the Project Display subreport toolbar. (See “Project Display subreport toolbar” on page 113.) The Modify Mutation Projects function provides the capabilities for modifying single or multiple projects in Mutation Surveyor. For example, you can use the Modify Mutation Projects function for the following purposes:

- To open a single project with the GenBank file that was initially used, so that you can specify sample grouping options and rerun the project.

- To select a different isoform for a single project so that you can apply the gene annotations relative to the new isoform to all mutation calls. This allows you to complete the analysis of the same project with a different isoform without needing to review your mutation calls a second time.

- To merge multiple projects into one project for comparison purposes and view the project results in a single report.

Figure 11-1: Modifying Mutation Projects window
### Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>GenBank Sequence Files (Optional)</strong></td>
<td>Use the options in this pane to load a different GenBank file than what was loaded for the original project. The new GenBank file must have the same nucleotide sequence as the original GenBank file, but it can have different annotations.</td>
</tr>
</tbody>
</table>
| **SGP files** | Use the options in this pane to add one or more mutation projects that are being analyzed. Multiple projects are merged into a single project and the project results are contained in a single report.  
**Note:** If you load multiple projects and the total number of samples is \(< 2000\), then you can view the project results in the GAD and generate reports for the project. If the you load multiple projects and the total number of samples is \(> 2000\), then you cannot view the project results in the GAD. You can only generate reports for the project. |
| **Sample Grouping File (Optional)** | Use the options in this pane to load a Sample Grouping file which is a text file that defines how your sample files should be paired in your Mutation Surveyor project. See "2D Filename Match Editor tool" on page 261. |
The Log File Wizard in the Mutation AutoRun Tool

You use the Mutation AutoRun tool to carry out the batch analysis of multiple projects, where each project is referred to as a *job*. The tool scans for queued files at a user-set interval. The parameters for processing the projects are specified in a log file that you create using the Log File Wizard. You can create a job to process samples that have already been generated by your capillary electrophoresis instrument or you can create a job to process samples that have not yet been generated by your capillary electrophoresis instrument.

To open the Log File Wizard

1. On the Mutation Surveyor main menu, click Tools > Mutation AutoRun to open the Mutation AutoRun window.

*Figure 11-2: Mutation AutoRun window*

2. On the Mutation AutoRun menu, click Tool > Log File Wizard to open the Log File Wizard. The first page that opens is the Progress page. See *Figure 11-3 on page 318*. 
The Log File Wizard is a standard wizard consisting of multiple pages that are linked by Next and Back buttons. Each page contains instructions to guide you through the creation of a log file. After you complete the steps on a page, you click Next to move to the next page. At anytime, you can click Back as many times as needed and modify your selections for a previously completed step or steps. In addition to the standard Next and Back buttons, the Log File Wizard has page-specific links on the Progress Pane that you can double-click to open the indicated page. (These links are listed in the same order in which the pages open when you click Next.) To the right of the Progress Pane is a Jobs dropdown list of all the job files that are contained in a selected log file. Checkmarks are displayed next to the page links on the Progress Pane if the indicated information has been added for a selected job. For example, if report setting files have been added for a selected job, then a checkmark is displayed next to the Reports link.

You have two options for creating a log file to use with the Mutation AutoRun tool:

- You can set up a new log file. See “To set up a new log file” below.
- You can load a previously saved log file and modify it as needed. See “To modify a log file” on page 322.

To set up a new log file

1. On the Jobs dropdown list that is to the right of the Progress Pane, select New Job.
2. Click Modify.
3. At the prompt, enter the name for the new job.
4. Click Next.

You can now continue setting up the log file from scratch. You are prompted to enter files for a project in the following order—GenBank, Reference, and Sample. Sample files are always required for a project. GenBank files and reference files are both optional files for a job. You can add just a GenBank file, just a reference file, both files, or neither file. If you do not add either a GenBank file or a reference file, Mutation Surveyor connects to the GenBank database and searches for a GenBank file that has a sequence that matches the project’s sample files. Adding GenBank files, reference files or sample files, or any other type of file (for example, custom report settings files) involves the same general series of steps:

5. Click the Browse button on the Load Files page to open the Browse for Folder dialog box and browse to and select the folder that contains the files that are to be added to the job.

All the files that are in the selected folder are displayed in the Available Local Files pane. After you select the folder that contains the files that you want to add, the Local Path field is populated with the full directory path to the files. You can click Copy Path to copy this information to your clipboard and you can then paste it into the Local Path field in other windows if needed.

You can create a job to process samples that have not yet been generated by your capillary electrophoresis instrument. By specifying the path where the sample files are to be located followed by *.*, all files within the folder will be processed. Because you can configure the Mutation AutoRun function to process log files at different time intervals, you can set the interval to a time that occurs after the sample files are ready for processing. For more information about delaying the start of Mutation AutoRun, see the Time option detailed in “To use the Mutation AutoRun tool” on page 324.

6. Do one of the following to add the necessary files to the job:

- Double-click each file that you want to add.
- CTRL-click to select multiple non-contiguous files or SHIFT-click to select multiple contiguous files, and then click Add > Selected.
- Click Add > All to add all the files in a single step.

When Add > All is selected, the Selected Folders/Files field contains an entry that includes the path to the folder followed by “*.<extension>.” This indicates that all contents from this folder of the appropriate file type are to be used in the analysis. If you add new files to this folder prior to running the job, the new files are also processed.
7. After adding all the necessary files for the project, click Next. The Input Project Settings page opens.

*Figure 11-4: Input Project Settings page*

8. Click the Browse button page to open the Browse for Folder dialog box and browse to and select the folder that is to contain the processed SGP project file, and then click Add. Any automatically generated reports are also saved to this location.

9. Optionally, you can also do one or more of the following:
   - In the Project name field, enter a name for the project.
   - Click Advanced to open the Load Process Settings dialog box, and then click the Browse button page to open the Load Project Settings dialog box and browse to and select the settings file (.ini) file that specifies the settings that you want to use for the project.

*Figure 11-5: Load Project Settings dialog box*
11. Optionally, do one or more of the following:

- If you want to generate one or more custom reports for the project, add the appropriate custom report settings files (.ini) to the project.

If you want to create a custom report for the project, but want to use the default settings in the MutationSurveyor_Settings.ini file, then you do not need to add any settings files to the project. Instead, you can simply select the format (VCF, TXT, XLS, or XML) for the custom report.

- Click Export Custom Report Settings with Project.
- Select the format (TXT or XLS) for the other reports (Two Direction, Advanced Two Direction, or JHU) that you want to generate for the project.
12. Click Finished.
   You return to the Progress Page.

13. Click Save.
   The Save Log File dialog box opens.

14. Specify a name and location for the job’s log file.

---

To modify a log file

When you modify a log file, you can modify the information for an existing job in the log file, you can add a new job to the log file, and you can remove a job from the log file.

1. On the Log File Wizard main menu, click File > Open.
   The Open Log File dialog opens.

2. Select the log file that is to be modified, and then click Open.
   You return to the Progress page. By default, the first job in the log file is loaded into the Log File Wizard. Checkmarks are displayed next to the page links if the information has been added for the job. For example, if report setting files have been added for the first job, then a checkmark is displayed next to the Reports link.

3. Continue to one of the following:
   - “To modify an existing job in the log file.”
   - “To add a new job to a log file” on page 323.
   - “To remove a job from a log file” on page 323.

To modify an existing job in the log file

1. On the Jobs dropdown list that is to the right of the Progress Pane, select the job that is to be modified.
   The job is loaded into the Log File Wizard. A checkmark is displayed next to a page link if the information has been added for the job. For example, if report setting files have been added for the selected job, then a checkmark is displayed next to the Reports link.

2. Modify the information as needed for the loaded job.

---

To modify the name for the job, click Modify on the Progress page, and at the prompt, modify the name for the job. You can use the Next and Back buttons to move through the necessary pages for modifying the job, or you can double-click a page link in the Progress Pane to open the indicated page.
3. After you have modified the information for the job, click OK on any page in the Log File Wizard.

   You return to the Progress page.
4. Click Save on the Progress page to save the modifications to the job.

To add a new job to a log file

1. On the Jobs dropdown list that is to the right of the Progress Pane, select New Job.
2. Click Modify.
3. At the prompt, enter the name for the new job.
4. Click Next.
5. Add the information for the new job.
6. After you have added the information for the new job, click OK on any page in the Log File Wizard.

   You return to the Progress page.
7. Click Save on the Progress page to save the new job to the log file.

To remove a job from a log file

1. On the dropdown list that is to the right of the Progress Pane, select the job that is to be deleted.
2. Click Remove.
3. Click Yes at the prompt about removing the log file.

   You return to the Progress page.
4. Click Save on the Progress page to save the changes to the log file.
Chapter 11  
Multiple Projects

The Mutation AutoRun Tool

You **use** the Mutation AutoRun tool to carry out the batch analysis of multiple projects, where each project is referred to as a **job**. The function scans for queued files at a user-set interval. With this function, Mutation Surveyor can analyze up to 8 billion base pairs of data in eight hours.

---

Remember, you can also use the Mutation AutoRun tool to schedule the processing of a project where the sample files have not yet been created. See “The Log File Wizard in the Mutation AutoRun Tool” on page 317.

To use the Mutation AutoRun tool

1. On the Mutation Surveyor main menu, click Tools > Mutation AutoRun

   The Mutation AutoRun window opens.

   ![Mutation AutoRun window](image)

2. On the Mutation AutoRun toolbar, click the Settings icon:

   The Mutation AutoRun Settings dialog box opens.

   ![Mutation AutoRun Settings dialog box](image)
3. Specify the settings for the autorun.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log File Detecting</td>
<td>The directory in which you saved the log file. See Step 7 and Step 8 of “To set up a new log file” on page 318 in “The Log File Wizard in the Mutation AutoRun Tool” on page 317.</td>
</tr>
<tr>
<td>Directory</td>
<td></td>
</tr>
<tr>
<td>Local Work Folder</td>
<td>The temporary directory in which the analyzed data is being processed.</td>
</tr>
<tr>
<td>Time</td>
<td>• Detect Time Interval—The time interval between searches. (When Mutation Surveyor searches for log files to process.)</td>
</tr>
<tr>
<td></td>
<td>• Start Detecting Time—The starting date and time for the search.</td>
</tr>
<tr>
<td>Minimize to Taskbar</td>
<td>When the Mutation AutoRun function starts, it opens Mutation Surveyor. Select this option to automatically minimize the Mutation Surveyor window after it opens to the taskbar.</td>
</tr>
</tbody>
</table>

4. Click OK to close the Mutation AutoRun Settings dialog box.

5. Click File > Detect.

On the specified date and time, Mutation Surveyor begins looking for unprocessed log files. It looks for these log files according to the specified time intervals, for example, every 10 minutes. When an unprocessed log file is detected, Mutation Surveyor opens the file and processes the project data according to the instructions detailed in the log file. Mutation Surveyor saves the data to the designated output folder.
Chapter 11
Multiple Projects
Chapter 12
Reviewing and Editing Mutation Projects

Mutation Surveyor automatically identifies mutation calls at positions where the variation between the reference trace and the sample trace meet or exceed detection thresholds. Mutation Surveyor also sometimes deletes mutation calls at positions that do not meet specific criteria. As a user, however, you have the option of manually adding or editing mutation calls in your mutation project, and you also have the option of overriding Mutation Surveyor’s automatic actions. You can also create a custom database of known deletions that are based on the variants in a selected mutation project, and you can then use this database in other mutation projects.

This chapter covers the following topics:

• “Adding Mutation Calls” on page 329.
• “Editing Mutation Calls” on page 335.
• “Annotating Reported Variations” on page 341.
• “Creating a User Knowledge Database for Known Deletions” on page 342.
• “Viewing the Edit History (Audit Trail) for a Mutation” on page 344.
Adding Mutation Calls

Mutation Surveyor automatically identifies mutation calls at positions where the variation between the reference trace and the sample trace meet or exceed detection thresholds. Options are also available, however, for you to manually add mutation calls to a mutation trace. You can add substitution mutation calls, you can add homozygous indel mutation calls, and you can add heterozygous indel mutation calls.

To add a substitution

1. Open the mutation project in the GAD or in the Project Reviewer.
2. Right-click the mutation trace, and on the menu that opens, click Add Substitution.

   The Add Substitution dialog box opens.

   *Figure 12-1: Add Substitution dialog box*

3. In the Mutation field, enter the mutation, and optionally, add comments for the added mutation.

   *Mutation Surveyor automatically calculates the optimal values for the mutation parameters such as intensity, area, and so on for the mutation based on the position of the mutation and you should not modify these values. When you add a substitution, it can be heterozygous (for example, A > AT), or it can be homozygous (for example, A > T).*
4. Optionally, to add multiple tags for the substitution, right-click anywhere in the db_xref pane, and on the context menu that opens, click Add Line. A new blank line for a tag and identifier is added to the pane.

5. Click OK.

The mutation trace is updated with the substitution. The Mutation table in the GAD and in the Project Reviewer are also updated to show this new mutation.

To add a homozygous indel call

1. Open the mutation project in the GAD.

2. Press and hold the [Ctrl] key, and then click the mobility line at the position of the indel in the mutation trace.

   The Add Indel dialog box opens.

   Figure 12-2:  Add Indel dialog box

3. Add the Indel call as appropriate.

   • If you are adding a homozygous insertion, select Insertion on the Mutation Type dropdown list, and then in the Start of GenBank Index field, enter the positions that flank the insertion as two numbers delimited by an underscore. For example, 30746_30747 means that an insertion exists between base 30746 and base 30747. The length of the insertion is determined by the Mutation Letters parameter.

   • If you are adding a homozygous deletion, then in the Start of GenBank Index field, enter the actual positions of the deletion. For example, 30746_30748 means that three bases were deleted from the sample—the base at position 30746, the base at position 30747, and the base at 30748.

4. Optionally, to add multiple tags for the indel, right-click anywhere in the db_xref pane, and on the context menu that opens, click Add Line. A new blank line for a tag and identifier is added to the pane.
5. Click OK.

The mutation trace is updated with the homozygous indel. The Mutation table in the GAD is updated to show this new mutation.

---

If you add a homozygous insertion and the bases that are inserted are identical the bases that precede them, then the mutation code is corrected in the Mutation table to reflect this duplication. See “Insertion, duplication, and deletion mutation codes” on page 131.

---

To add or edit a heterozygous indel (The Het-Indel tool)

You use the Heterozygous Indel Detection tool (Het-Indel tool) to add or edit heterozygous mutation calls to a mutation trace. You can open the Het-Indel tool in one of two ways:

- Click the Detect Heterozygous Indels button on the GAD toolbar.
- Press and hold the [Ctrl] key, and then click the mobility line at the position of the indel in the mutation trace in the GAD to open the Add Indel dialog box, and then on the Add Indel dialog box, click Heterozygous Indel.

---

To add or edit a heterozygous indel (The Het-Indel tool)

You use the Heterozygous Indel Detection tool (Het-Indel tool) to add or edit heterozygous mutation calls to a mutation trace. You can open the Het-Indel tool in one of two ways:

- Click the Detect Heterozygous Indels button on the GAD toolbar.
- Press and hold the [Ctrl] key, and then click the mobility line at the position of the indel in the mutation trace in the GAD to open the Add Indel dialog box, and then on the Add Indel dialog box, click Heterozygous Indel.

---

Figure 12-3: Heterozygous Indel Detection window

The Heterozygous Indel Detection tool deconvolutes the mixed mutation trace into two clean traces. The Conserved trace shows the allele within the mixed trace that matches to the reference trace. The Mutant trace shows the allele within the mixed trace that does not match to the reference trace. The tool then estimates the percent contribution of conserved allele
and mutant allele. Mutation Surveyor uses several ideal peaks within the sample trace, determines the median height of the mutant allele at these locations and calculates the percent of mutant allele (M) as \[ \frac{M}{M+C} \] and the conserved allele (C) as \[ \frac{C}{M+C} \]. Finally, Mutation Surveyor repositions the mutant trace so that it aligns to the reference trace and then determines whether the mutation was a heterozygous insertion or a heterozygous deletion. The indel positions are numbered relative to the positions in the reference sequence, and not to the genomic positions in the GenBank file. You can use the functions that are available from the window's toolbar for adding and editing heterozygous indel calls to the mutation trace.

> When you add a heterozygous indel call to a trace or move the call upstream in the trace, the end of the comparison region is moved to the site of the heterozygous indel. As a result, all automatically added mutation calls that are downstream of the heterozygous indel are now outside of the comparison region and Mutation Surveyor deletes these calls. You can manually add mutation calls outside of the comparison region, but reliably automating these calls in these regions is not possible.

1. On the Heterozygous Indel Detection toolbar, click Mutation.
   
   The Add/Edit Het-Indel dialog box opens.

   For a complete description of all the buttons on the Heterozygous Indel Detection toolbar, see “Heterozygous Indel Detection window toolbar” on page 334.

   ![Add/Edit Het-Indel dialog box](image)

2. On the Mutation Type dropdown list, select the mutation type.

   ![Add/Edit Het-Indel dialog box](image)
3. Do one of the following:
   
   • If you are adding a heterozygous insertion, then in the Start Index of Reference field, enter the reference positions that flank the insertion as two numbers delimited by an underscore. For example, 135_136 means that an insertion exists between base 135 and 136 of the reference. The length of the insertion is determined by the Mutation Letters parameter.

   • If you are adding a heterozygous deletion, then in the Start Index of Reference field, enter the actual positions of the deletion. For example, 235_237 means that three bases were deleted from the sample—the base at reference position 235, the base at reference position 236, and the base at reference position 237.

4. Optionally, to add multiple tags for the het-indel, right-click anywhere in the db_xref pane, and on the context menu that opens, click Add Line. A new blank line for a tag and identifier is added to the pane.

5. Click OK.

Three results are possible:

   • The mutation trace is updated with the insertion or deletion. The Mutation table in the GAD and in the Project Reviewer are also updated to show this new mutation.

   If you add a heterozygous insertion and the bases that are inserted are identical to the bases that precede them, then the mutation code is corrected in the Mutation table to reflect this duplication. See “Insertion, duplication, and deletion mutation codes” on page 131.

   • If Mutation Surveyor cannot deconvolute the mixed trace after you have added an insertion or deletion call because of poor trace quality, or because of the complexity of the call, then a warning message opens, indicating that Mutation Surveyor cannot display the mutation call as you have specified and asking you if you want to keep it. Click Yes to save the mutation call to the trace. The Mutation table in the GAD and in the Project Reviewer are also updated to show this new mutation.

   • A message opens indicating that Mutation Surveyor was able to detect a different mutation call than the one specified and asking if you want to use Mutation Surveyor’s call. Click No to save the mutation call as you have specified it.
Heterozygous Indel Detection window toolbar

The Heterozygous Indel Detection window toolbar contains buttons that are specific for working with the display and for changing the information that is displayed.

*Figure 12-5: Heterozygous Indel Detection window toolbar*

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Zoom In**—Zooms in on a region of the report for viewing.  
**Note:** You can also manually zoom in on a region for viewing. Click and hold the left mouse button and draw a box from the upper left hand corner of the pane towards the lower right hand corner. A box is formed around the area that is being reduced for viewing. |
| **Zoom Out**—Zooms out from a region of the report for viewing.  
**Note:** You can also manually zoom out from a region for viewing. Click and hold the left mouse button and draw a box from the lower right hand corner of the pane towards the upper left hand corner. The magnification for zooming out is always 100%. |
| **Show Lines**—Provides options for showing all nucleotides in the traces and mutation traces, hiding all nucleotides in the traces and mutation traces, or showing only selected nucleotides in the traces and mutation traces. |
| **Settings**—Opens a menu that contains selections for the layout of the display and for navigating the display.  
• Y auto—Clear this option to turn off the Y-axis auto-scaling for each of the traces.  
• Mouse Zoom—Clear this option to turn off the mouse zooming functions. (You can use only the Zoom In and Zoom Out buttons to change the zoom level of the display.)  
• Show Grid—Clear this option to remove the grid from the traces. |
| **Print Preview**—Opens the Preview window, which displays a preview of what is to be printed for the Heterozygous Indel display. You can use the options on the Preview window’s toolbar to adjust variables such as the color scale and the page layout before you print the display.  
**Note:** Before you click the Print Preview button, make sure to adjust the zoom level so that the area of the display that you want to print is displayed in the Preview window. |
| **Auto Identify the Start**—Runs a more rigorous detection algorithm for deconvoluting the mixed trace and aligning the mutant trace to the reference trace.  
**Note:** Typically, you run this algorithm if you think that Mutation Surveyor made an incorrect het-indel call, or that het-indel call is missing. |
| **Mutation**—Opens the Add/Edit Het-Indel dialog box which contains options for adding or editing a het-indel call in a mutation trace. See “To add or edit a heterozygous indel (The Het-Indel tool)” on page 331 or “To edit heterozygous indels” on page 337. |
| **Forward/Reverse**—Indicates the sample trace that is currently displayed in the window. |
Editing Mutation Calls

When you edit a mutation call, you can keep the mutation call type the same at the position, or you can change the call type at the position. If a mutation call of one type was made at a given position and you want to have a call of another type at the position, then you should first delete the original mutation call at the position, and then add the different type of mutation call at the position. You can edit substitution calls, you can edit homozygous indels, you can edit heterozygous indels, and you can edit Del/Ins.

To edit substitutions

You can edit a substitution call from the GAD or from the Project Reviewer.

1. Right-click the call in the Mutation table in the GAD, or in the Project Reviewer, and on the context menu that opens, click Edit.

   The Edit Substitution dialog box opens.

   ![Edit Substitution dialog box](image)

2. In the Mutation field, enter the mutation, and optionally, add comments for the modified mutation.

   Mutation Surveyor automatically calculates the optimal values for the mutation parameters such as intensity, area, and so on for the mutation based on the position of the mutation and you should not modify these values. When you add a substitution, it can be heterozygous (for example, A > AT), or it can be homozygous (for example, A > T).
Chapter 12
Reviewing and Editing Mutation Projects

3. Optionally, to add multiple tags for the substitution, right-click anywhere in the db_xref pane, and on the context menu that opens, click Add Line. A new blank line for a tag and identifier is added to the pane.

4. Click OK.

The mutation trace is updated with the substitution. The Mutation table in the GAD and in the Project Reviewer are also updated to show this new mutation.

To edit homozygous indels

You can edit a homozygous indel call from the GAD or from the Project Reviewer.

1. Right-click the call in the Mutation table in the GAD or in the Project Reviewer, and on the context menu that opens, click Edit.

   The Edit Indel dialog box opens.

   Figure 12-7: Edit Indel dialog box

2. Edit the indel call as appropriate.

   • If you are editing a homozygous insertion, then in the Start of GenBank Index field, enter the positions that flank the insertion as two numbers delimited by an underscore. For example, 30746_30747 means that an insertion exists between base 30746 and base 30747. The length of the insertion is determined by the Mutation Letters parameter.

   • If you are editing a homozygous deletion, then in the Start of GenBank Index field, enter the actual positions of the deletion. For example, 30746_30748 means that three bases were deleted from the sample—the base at position 30746, the base at position 30747, and the base at 30748.

3. Optionally, to add multiple tags for the homozygous indel, right-click anywhere in the db_xref pane, and on the context menu that opens, click Add Line. A new blank line for a tag and identifier is added to the pane.
4. Click OK.

The mutation trace is updated with the homozygous indel. The Mutation table in the GAD and in the Project Reviewer are also updated to show this new mutation.

If you add a homozygous insertion and the bases that are inserted are identical to the bases that precede them, then the mutation code is corrected in the Mutation table to reflect this duplication. See “Insertion, duplication, and deletion mutation codes” on page 131.

To edit heterozygous indels

You use the Heterozygous Indel Detection tool (Het-Indel tool) to add or edit heterozygous mutation calls to a mutation trace.

1. Do one of the following to open the Het-Indel tool:
   - Double-click the het-indel call in the Mutation report to open the Heterozygous Indel Detection tool.
   - Click the Detect Heterozygous Indels button  on the GAD toolbar.
   - Press and hold the [Ctrl] key, and then click the mobility line at the position of the indel in the mutation trace in the GAD to open the Add Indel dialog box, and then on the Add Indel dialog box, click Heterozygous Indel.

Figure 12-8: Heterozygous Detection window
Chapter 12
Reviewing and Editing Mutation Projects

2. On the Heterozygous Indel Detection toolbar, click Mutation.

   The Add/Edit Het-Indel dialog box opens.

   Figure 12-9: Add/Edit Het-Indel dialog box

3. On the Mutation Type dropdown list, select the mutation type.

4. Do one of the following:

   • If you are adding a heterozygous insertion, then in the Start Index of Reference field,
     enter the positions of the reference that flank the insertion as two numbers delimited
     by an underscore. For example, 135_136 means that an insertion exists between base
     135 and 136 of the reference. The length of the insertion is determined by the
     Mutation Letters parameter.

   • If you are adding a heterozygous deletion, then in the Start Index of Reference field,
     enter the reference positions of the deletion. For example, 235_237 means that three
     bases were deleted from the sample—the base at reference position 235, the base at
     reference position 236, and the base at reference position 237.

5. Optionally, to add multiple tags for the heterozygous indel, right-click anywhere in the
   db_xref pane, and on the context menu that opens, click Add Line. A new blank line for
   a tag and identifier is added to the pane.

6. Click OK.

   Three results are possible:

   • The mutation trace is updated with the insertion or deletion. The Mutation table in
     the GAD and in the Project Reviewer are also updated to show this new mutation.

---

If you add a heterozygous insertion and the bases that are inserted are identical to
the bases that precede them, then the mutation code is corrected in the Mutation
table to reflect this duplication. See “Insertion, duplication, and deletion mutation
codes” on page 131.
• If Mutation Surveyor cannot deconvolute the mixed trace after you have added an insertion or deletion call because of poor trace quality, or because of the complexity of the call, then a warning message opens, indicating that Mutation Surveyor cannot display the mutation call as you have specified and asking you if you want to keep it. Click Yes to save the mutation call to the trace. The Mutation table in the GAD and in the Project Reviewer are also updated to show this new mutation.

• A message opens indicating that Mutation Surveyor was able to detect a different mutation call than the one specified and asking if you want to use Mutation Surveyor’s call. Click No to save the mutation call as you have specified it.

To edit Del/Ins

A Del/Ins is a combination of a deletion and an insertion at the same location. In many cases, you must edit such a mutation call to get the correct mutation call output. The following is a summary of the approaches that SoftGenetics recommends for adding and editing homozygous and heterozygous Del/Ins.

To edit a homozygous Del/Ins

1. You might initially need to delete substitutions that were falsely identified at these positions.
2. If no homozygous Indel was identified, then add the homozygous deletion as described in “To add a homozygous indel call” on page 330.
3. At the same starting position, add the homozygous insertion as described in “To add a homozygous indel call” on page 330.

To edit a heterozygous Del/Ins

1. Do one of the following to pen the Heterozygous Indel Detection tool.
   • Double-click the het-indel call in the Mutation report to open the Heterozygous Detection tool.
   • Click the Detect Heterozygous Indels button on the GAD toolbar.
   • Press and hold the [Ctrl] key, and then click the mobility line at the position of the indel in the mutation trace in the GAD to open the Add Indel dialog box, and then on the Add Indel dialog box, click Heterozygous Indel.
2. Edit Mutation1 to the heterozygous deletion relative to reference trace positions.
3. Add Mutation2 as the heterozygous insertion relative to reference trace positions.

Two results are possible:

- The mutation trace is updated with the insertion or deletion. The Mutation table in the GAD and in the Project Reviewer are also updated to show these modified mutations.

If you add a heterozygous insertion and the bases that are inserted are identical the bases that precede them, then the mutation code is corrected in the Mutation table to reflect this duplication. See “Insertion, duplication, and deletion mutation codes” on page 131.

- If Mutation Surveyor cannot deconvolute the mixed trace after you have edited an insertion or deletion call because of poor trace quality, or because of the complexity of the call, then one of two warning messages opens:
  
  - A warning message opens indicating that Mutation Surveyor cannot display the mutation call as you have specified and asking you if you want to keep it. Click Yes to save the mutation call to the trace. The Mutation table in the GAD and in the Project Reviewer are also updated to show these modified mutations.

  - A warning message opens asking you if you want to use the mutation call that is automatically detected at the position. Click No to the save the mutation calls as you have specified them. The Mutation table in the GAD and in the Project Reviewer are also updated to show these modified mutations.
Annotating Reported Variations

You can annotate reported variations in a sample trace from the GAD or from the Project Reviewer report. Mutation Surveyor automatically modifies the GenBank file that is stored for the selected project with these annotations.

To annotate a variation

1. Right-click the call in the Mutation table in the GAD, or in the Project Reviewer report, and on the context menu that opens, click Edit.

   Remember, a reported variant has a purple background in the Mutation table in the GAD and Project Reviewer report.

   An Edit (mutation type) dialog box opens. The type of dialog box that opens depends on the type of mutation call that was selected for annotation (Substitution or Indel) but both dialog boxes have the lower db_xref pane. The pane is automatically populated with all the reported annotations for the position.

   ![Figure 12-10: db_xref pane](image)

2. Optionally, to modify an existing annotation, select a new tag for it on the tag dropdown list.

3. To add a new annotation, right-click in the pane, and on the context menu that opens, click Add a Line.

   A new blank line is added for the annotation.

4. On the tag dropdown list, select a tag for the new annotation.

5. In the Identifier field, enter the identifier for the new annotation.

6. Click OK.

   Mutation Surveyor automatically adds the new annotations to the GenBank file that is stored for the selected project.

   If you add an annotation in error, or want to delete an existing annotation, right-click the annotation in the db_xref pane, and on the context menu that opens, click Delete a Line.

   You can use the Extract SGP tool to export the updated GenBank file. See “Extract SGP Tool” on page 275.
Creating a User Knowledge Database for Known Deletions

Mutation Surveyor automatically identifies mutation calls at positions where the variation between the reference trace and the sample trace meet or exceed detection thresholds. If, however, you know that a mutation is being called as the result of a false positive or a sequencing artifact, and the GenBank file that was used for the project contains chromosome information, then you can delete the called mutation and add this deletion to a User Knowledge database. For this User Knowledge database, a false positive and an artifact are defined as follows:

- A false positive is dependent on the chromosome position. As a result, this same variant is considered to be a false positive for all subsequent analyses.
- An artifact is dependent on not only the chromosome position, but also its relative location in the trace. For example, in one trace, a variant is located at the 5’ end of the trace, but in another trace, the same variant is located in the middle of the trace. As a result, if this variant is marked as an artifact in the trace where it was found at the 5’ end, the variant is not considered to be an artifact in the trace where it was located in the middle.

For an artifact, the User Knowledge Database stores a range of positions, relative to location within a trace. This is more ideal for mutation calls that routinely occur at the beginning or end of an amplicon as a mutation call that is centered in an amplicon is more than likely to be a real mutation.

You can use this custom database of known deletions in other projects. If a trace in a project has a mutation called at a position that has been identified as a false positive or artifact in the User Knowledge database, then Mutation Surveyor automatically flags the position, which streamlines the process of identifying variations of clinical significance for the project.

To create a custom variant database for known deletions

1. Right-click the call in the Mutation table in the GAD or in the Project Reviewer, and on the context menu that opens, click Delete Mutation and Add to Database.

   The Delete Mutation dialog box opens.

   Figure 12-11: Delete Mutation dialog box
2. Do one of the following:
   • To delete the mutation without adding it to the User Knowledge database, click OK.
   • To add the mutation to the User Knowledge database, select Add to User Knowledge Database, and then complete the remaining steps in this procedure.

3. Leave the reason for the deletion set to the default value of False Positive, or select Artifact.

4. Click OK.

The Delete Mutation dialog box closes. The deleted mutation (position and reason) are saved to the User Knowledge database. If a trace in another project has a mutation called at this exact position, then Mutation Surveyor automatically flags this position.

*The Delete Mutation and Add to Database option is available only if the requirements of an imported whole human genome reference and the inclusion of a GenBank file with chromosome coordinate in the project are met.*
Chapter 12  
Reviewing and Editing Mutation Projects

Viewing the Edit History (Audit Trail) for a Mutation

Analysis options are available for a mutation in a variety of locations in Mutation Surveyor, including various reports and displays and the context menus for the Mutation table and the GAD. Any edit action (addition, substitution, confirmation, or deletion) that you carry out for a mutation is displayed in the Actions column for the mutation in the Mutation table and this action is also automatically added to the audit trail for the mutation. An option is available from all these locations to view the edit history for a mutation. To view the edit history for a mutation, right-click the mutation (for example, in the Mutation table), and on the context menu that opens, click View Edit History to open the Edit History dialog box.

*Figure 12-12: Edit History dialog box*

The lower half of the Edit History dialog box displays all the edit operations that have been carried for the selected mutation. The date and time and the username for the user who carried out the edit is displayed for each edit. When you select an edit entry in the lower pane, a selected series of old and new values is displayed in the upper half of the dialog box. If the edit resulted in a change for a mutation value, then the old and new values are highlighted in red.

*Figure 12-12: Edit History dialog box*
Index

Numerics
2 Directions tab on the Mutation Project Settings dialog box ........ 65

A
activity log file viewing for your Mutation Surveyor users .................. 43
Advanced GBK File Editor tool ... 231 functions ....................... 243
GenBank Tree pane .......... 233 Tabs pane ...................... 235 toolbar .................................. 232
Advanced Two Direction report .... 140 context menu .............. 144 toolbar .............. 142
viewing and analysis options .... 144 allele ratios quantifying for Sanger sequencing traces ........................ 303
Amino Acid frame in the Graphical Analysis Display ................. 79
amino acid text comparison function in the Project Sample Assembly subreport .............. 154
assumptions for the manual .... 16 audit trail see edit history

B
BasePatch tool .................. 295 Bentley report .................. 196
context menu .................. 198 report settings .................. 198
toolbar .................. 197
viewing and analysis options .... 197
Browser pane Mutation Surveyor main window ... 27

C
CDS information adding and modifying for a SEQ file in the SEQ File Editor tool 246
Clinical report .................. 116
color codes for mutation codes in the Mutation report .................. 130
Color tab for a Custom report .... 176
Confidence mark for Custom report .... 173
for JHU report .................. 187
consensus sequence text function in the Project Sample Assembly subreport .................. 151
context menu Advanced Two Direction report .... 144
Bentley report .................. 198
Emory report .................. 194
Full Gene report .............. 220
HGVS report .................. 161
JHU report .................. 188
Methylation report ............ 206
MSM_Song report ............ 198
Mutation report .............. 132
PrettyBase report ............ 202
Project report .................. 155
Project Reviewer report .......... 101
Two Direction report .......... 137
Contig tab on the Mutation Project Settings dialog box ............. 55
copyright .................. 3
customer reports
Bentley report .................. 196
Emory report .................. 193
Full Gene report .............. 215
FullBase report .............. 222
JHU report .................. 185
Methylation report ............ 203
Graphic Display of Methylation report .................. 205
MSM_Song report ............ 196
PrettyBase report ............ 200
Tassel report .................. 190
Vertex report .................. 207
Vertex2 report .............. 209
Vertex3 report .............. 212
D
Database tab
  on the Mutation Project Settings
dialog box ............................69
Del/Ins
  defined ..................................339
  editing for a mutation trace .....339
Display tab for a Custom report ....172
Display tab on the Mutation Project
Settings dialog box ............64
E
edit history
  viewing for a mutation ..........344
Emory report ..................193
  context menu ....................194
  toolbar ..........................193
  viewing and analysis options ..194
Export GAD function
  defined ............................94
F
Filters tab for a Custom report ...170
Format tab for a Custom report ...166
Full Gene report ...............215
  context menu ...................220
Format report settings ..........216
Header report settings ..........217
Output report settings ..........217
  toolbar ..........................219
  viewing and analysis options ..220
FullBase report ...............222
  layout ...........................223
  report settings ..................222
  toolbar ..........................223
  viewing and analysis options...224
functions
  in the Advanced GBK File Editor
tool ............................243
  in the SEQ File Editor tool...250
G
GAD
  see Graphical Analysis Display
GAD report ...................114
  toolbar ..........................115
GenBank file
  adding and modifying variations
  for in the Advanced GBK File
  Editor tool ..........................241
  as a project file type in Mutation
  Surveyor ..........................50
  automatically downloading for a
  project ............................51
  downloading from NCBI  ..........227
  editing and annotating with the
  Advanced GBK File Editor tool 231
  overview of ........................227
GenBank Tree File pane
  Advanced GBK File Editor tool 233
genomic terms
  conventions used for in Mutation
  Surveyor ..........................24
Graphic Display of Methylations
report .............................205
Graphic Display report ........108
  layout ............................109
  toolbar ..........................110
Graphical Analysis Display
  annotating reported variations in
  its mutation traces ..........341
  defined ..........................77
  exporting information for ........94
  mutation peak identification ....82
  Mutation table ..................83
  mutation trace legend in ........80
  navigation and viewing options for
  90
  opening ..........................77
  toolbar ................................84
Graphical Analysis Display
  components
    Amino Acid frame ................79
    Nucleotide Sequence frame ......78
    Sample Traces frame ...........79
    Tracks frame ....................79
graphical output
  conventions used for in Mutation
  Surveyor ..........................25
Graphical reports
  Clinical report ...............116
  GAD report ....................114
  Graphic Display report ....108
  Project Display subreport ....111
  Nucleotide Text Display report 120
  Project Display subreport ....111
  Project Reviewer report .......99
group
  defined ..........................38
  adding ............................38
  deleting ..........................38
  editing ...........................38
Index

H

heterozygous indel
  adding to a mutation trace in the comparison region ............ 331
  adding to a mutation trace outside the comparison region .......... 331
  editing for a mutation trace ..... 337
Heterozygous Indel Detection tool... 331
HGVS report ......................... 157
  context menu ...................... 161
  report settings .................... 157
  toolbar .................................. 160
  viewing and analysis options .. 161
homozygous indel
  adding to a mutation trace ..... 330
  editing for a mutation trace ..... 336

I

Input tab on the Mutation Project Settings dialog box .................. 54
installing
  Mutation Surveyor................. 22

J

JHU report ......................... 185
  Confidence mark for .............. 187
  context menu ....................... 188
  report settings .................... 187
  toolbar .................................. 186
  viewing and analysis options .. 187

L

layout
  FullBase report...................... 223
  Graphic Display report ........... 109
  Nucleotide Text Display report 121
  Project Reviewer report .......... 99
  SEQ File Editor tool ............... 247
  Two Direction report .......... 134
  Vertex3 report ..................... 213

M

main menu
  Mutation Surveyor main window ... 26
main window for Mutation Surveyor. 26
methylated DNA
  analyzing .................................. 301
Methylation report .................. 203
  context menu ......................... 206
  report settings ...................... 204
  toolbar .................................. 204
mobility line
  defined .................................. 82
Modify Mutation Projects function
  defined .................................. 315
  using .................................... 315
MSM_Song report .................. 196
  context menu ......................... 198
  report settings ...................... 198
  toolbar .................................. 197
  viewing and analysis options .. 197
mutation
  adding to the User Knowledge Database when deleted ............. 342
  viewing the edit history for ......... 344
Mutation AutoRun tool
  Log File Wizard in .................... 317
  using to analyze multiple projects .. 324
mutation calls
  adding to a mutation trace ...... 329
  editing for a mutation trace ... 335
mutation code
  defined .................................. 129
mutation codes
  color codes for in the Mutation report ............................... 130
  Two Direction report ............. 136
mutation peak identification in the Graphical Analysis Display ... 82
Mutation Project Settings dialog box
  2 Directions tab ...................... 65
  Contig tab ............................. 55
  Database tab ......................... 69
  Display tab ............................ 64
  Input tab ............................. 54
  Mutation tab .......................... 59
  Others tab ............................ 67
  Output tab ............................ 62
Mutation Quantifier function
  defined .................................. 303
  running .................................. 303
Mutation report .................... 127
  context menu .......................... 132
  report codes ......................... 129
  report fields ......................... 128
  settings
Index

variation tracks................. 87
viewing and analysis options .. 132
Mutation Surveyor
   conventions
      genomic terms ............ 24
      mutation terms .......... 24
   reports and graphical output ... 25
   installing........................... 22
   main window ....................... 26
   Browser pane.......................... 27
   main menu ................................ 26
   title bar ................................... 26
   toolbar .................................... 27
   project file types ................... 50
   setting up a project in ........... 70
   starting .................................. 23
   system requirements for ........... 21
Mutation tab for a Custom report .... 173
Mutation tab on the Mutation Project Settings dialog box ............. 59
Mutation table in the Graphical Analysis Display ................. 83
mutation terms
   conventions used for in Mutation Surveyor............... 24
mutation trace
   adding a heterozygous indel to in the comparison region .......... 331
   adding a heterozygous indel to outside the comparison region 331
   adding a homoygous indel to 330
   adding a substitution to .......... 329
   adding mutation calls to ........... 329
   editing a Del/Ins for .............. 339
   editing a heterozygous indel for ... 337
   editing a homozygous indel for .... 336
   editing a substitution for ......... 335
   editing the annotations in ........... 341
   editing the mutation calls for ... 335
   reprocessing with the BasePatch tool ................................ 295
mutation trace legend in the Graphical Analysis Display .......... 80
mutation_server_project_settings 52
N
Nomenclature tab for a Custom report ........................................ 177
Nucleotide Sequence frame in the Graphical Analysis Display ........ 78
Nucleotide Text Display report... 120
   layout........................................ 120
   settings...................................... 120
   toolbar...................................... 122
O
organization of the manual........ 16
Other tab for a Custom report .... 179
Others tab
   on the Mutation Project Settings dialog box .................. 67
Output tab on the Mutation Project Settings dialog box ............ 62
overview
   GenBank file.................................... 227
PrettyBase report.................. 200
context menu.......................... 202
report settings...................... 201
toolbar ..................................... 200
viewing and analysis options.. 201
project
   analyzing multiple projects using the Mutation AutoRun tool...... 324
   automatically downloading a GenBank file for ...................... 51
   modifying single or multiple .................................. 315
   modifying the settings for ................................ 52
   setting up in Mutation Surveyor 70
Project Display subreport........ 111
   report settings......................... 111
   toolbar .................................... 113
project file types
   GenBank file............................ 50
   reference file........................... 50
   sample file............................ 50
Project report........................ 146
   context menu.......................... 155
   report settings....................... 146
   toolbar .................................... 148
viewing and analysis options.. 155
Project Reviewer report
   annotating reported variations in its mutation traces .......... 341
   context menu.......................... 101
   layout................................. 99
   report settings................... 104
   toolbar .................................... 102
Project Sample Assembly subreport 150
   amino acid text comparison function in .................. 154
Index

consensus sequence text function in ............................................. 151
sequence text comparison function in ....................................... 152
Project Viewer report ........................................... 99

R
reference file
as a project file type in Mutation Surveyor ........................................ 50
report codes
Mutation report .................................................. 129
report fields
Mutation report .................................................. 128
report settings
Bentley report .................................................. 198
Full Gene report ............................................. 216, 217
FullBase report ............................................... 222
HGVS report .................................................. 157
JHU report .................................................... 187
Methylation report ............................................. 204
MSM_Song report ............................................. 198
Nucleotide Text Display report ............................................. 120
PrettyBase report ............................................. 201
Project Display subreport ............................................. 111
Project report .................................................. 146
Project Reviewer report ............................................. 104
Two Direction report ............................................. 136
Vertex3 report .................................................. 212
Vertex2 report .................................................. 209
reports
see Graphical reports, Standard reports, Custom report, or Customer reports
conventions used for in Mutation Surveyor ........................................ 25

S
sample file
as a project file type in Mutation Surveyor ........................................ 50
Sample Traces frame in the Graphical Analysis Display ........... 79
legend for ......................................................... 80
mobility line in .................................................. 82
mutation peak detection in .................................................. 82
Sanger sequencing traces
quantifying the allele ratios for 303
SEQ file
adding and modifying CDS information for in the SEQ File Editor tool ............................................... 246
SEQ File Editor tool ............................................. 246
functions ......................................................... 250
layout ......................................................... 247
sequence text comparison function in the Project Sample Assembly subreport ............................................. 152
settings
Full Gene report ............................................. 217
special information about the manual ............................................. 15
Standard reports
Advanced Two Direction report ............................................... 140
HGVS report .................................................. 157
Mutation report .................................................. 127
Project report .................................................. 146
Project Sample Assembly subreport ............................................. 150
Two Direction report ............................................. 134
substitution
adding to a mutation trace ............................................. 329
editing for a mutation trace ............................................. 335
system requirements for Mutation Surveyor ............................................... 21
T
Tabs pane
Advanced GBK File Editor tool ............................................. 235
Tassel report ............................................... 190
toolbar .............................................................. 191
viewing and analysis options ............................................. 192
template
creating for a Custom report ............................................. 164
title bar
Mutation Surveyor main window ............................................. 26
toolbar
Advanced GBK File Editor tool ............................................. 232
Advanced Two Direction report ............................................... 142
Bentley report ............................................... 197
Emory report ............................................... 193
Full Gene report ............................................... 219
FullBase report ............................................. 223
GAD report .................................................. 115
Graphic Display report ............................................. 110
Graphical Analysis Display ............................................. 84
HGVS report .................................................. 160
JHU report .................................................... 186
Methylation report ............................................. 204
MSM_Song report ............................................. 197
Mutation Surveyor main window ............................................. 27
Nucleotide Text Display report ............................................. 122
PrettyBase report ............................................. 200
Project Display subreport ............................................. 113
Index

Project report .......................... 148
Project Reviewer report .......... 102
Tassel report.......................... 191
Two Direction report.............. 135
Vertex2 report........................ 211
Vertex3 report........................ 214

user
defined ..................................31
deleting ..................................31
turning off .............................36
turning on ..............................34
using the manual......................15

V

variations
adding and modifying in the
Advanced GBK File Editor tool241
annotating for a mutation trace in
the GAD or from the Project
Reviewer report.......................341

Vertex report .........................207
Vertex2 report .........................209
report settings .........................209
toolbar ....................................211
viewing and analysis options ...211
Vertex3 report .........................212
layout ......................................213
report settings .........................212
toolbar ....................................214
viewing and analysis options ...214
viewing and analysis options
Advanced Two Direction report .... 144

Emory report .........................194
Full Gene report .....................220
FullBase report ........................224
Graphical Analysis Display....... 90
HGVS report .........................161
JHU report .........................187
Mutation report .....................132
PrettyBase report ..................201

User Knowledge Database
creating for known mutation
deletions...............................342

Tassel report .........................192
Two Direction report .............. 136
Vertex2 report .......................211
Vertex3 report .......................214

U

user defined ..............................38
adding ..................................43
deleting ..................................43
editing ..................................43
viewing the activity for in a log file 43

tracks frame in the Graphical
Analysis Display......................79

Two Direction report ..............134
costext menu .........................137
layout .....................................134
mutation codes .......................136
report settings .......................136
toolbar ....................................135
viewing and analysis options ..136

V

variations
adding and modifying in the
Advanced GBK File Editor tool241
annotating for a mutation trace in
the GAD or from the Project
Reviewer report.......................341

Vertex report .........................207
Vertex2 report .........................209
report settings .........................209
toolbar ....................................211
viewing and analysis options ...211
Vertex3 report .........................212
layout ......................................213
report settings .........................212
toolbar ....................................214
viewing and analysis options ...214
viewing and analysis options
Advanced Two Direction report .... 144

Emory report .........................194
Full Gene report .....................220
FullBase report ........................224
Graphical Analysis Display....... 90
HGVS report .........................161
JHU report .........................187
Mutation report .....................132
PrettyBase report ..................201

350
Mutation Surveyor User’s Manual
**Glossary**

**comparison region**
A region where the sample traces align to the reference traces, and all the mutation project *analysis* settings have been met, and therefore, mutations, with the exception of heterozygous indels, can be called in this region. The comparison region is marked by two vertical blue bars in the mutation trace.